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What is Huygens Professional?
CHAPTER 1 Introduction

This guide is intended for the beginner and expert in deconvolution that start with the 
Huygens Professional toolkit.

In this introductory chapter we explain the structure of the guide and provide general 
information: installation instructions, license details, system requirements, contact 
addresses, conventions used throughout the manual and the status of the current release 
of Huygens Professional.

What is Huygens 
Professional?

Huygens Professional is an image processing software package tailored for deconvolu-
tion of microscopic images. It enables you to deconvolve and analyze a wide variety of 
images ranging from 2D widefield (WF), to 4D multi-channel two-photon confocal, and 
Stimulated Emission Depletion (STED) microscope systems. Also people who use 
experimental set-ups like 4pi-microscopes may benefit from the software.

The Huygens Professional toolbox contains the following features:

Image Deconvolution Functions
• Accelerated Maximum Likelihood Estimation restoration algorithm optimized for 

low light level images.
• Iterative Constrained Tikhonov-Miller restoration algorithm.
• Quick Tikhonov-Miller and Quick MLE restoration algorithms.
• Good’s roughness Maximum Likelihood Estimation algorithm.
• PSF Distiller and Point Spread Function (PSF) measurement tool box to derive a 

microscopic PSF from finite sized micro bead images, containing:
· Automatic alignment and averaging procedure to combine the signal from differ-

ent micro beads in one or more images.
· PSF reconstruction tool to correct for the finite size of micro beads.

• Generates a theoretical Point Spread Function for widefield, confocal and two-pho-
ton microscopes based on electromagnetic diffraction theory.

• Automatic bleaching correction of 3D and 4D widefield images and 4D confocal and 
multi-photon images.
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• z-drift corrector tool for time series that enables you to correct for movement in the z 
(axial) direction that could have occurred for instance by thermal drift of the micro-
scope table.

Basic Image Processing
• Capability to handle multiple images.
• Time series support.
• Multi parameter (multi channel) image elements (stacked or packed).
• Basic data types: unsigned byte, 16 bit signed integer, 32 bit float, 2x32 bit complex.
• Per image undo/redo capabilities.
• An Image History that keeps track of all operations. This history can be saved along 

with the files or as a Huygens script to automate tasks.
• Scripting and batch processing environment based on Tcl (Tool Command Lan-

guage).

Core Image Processing Functions
• Create, delete, copy, copy block, convert, split, join, zoom, rotate, iso-sample, shift, 

replicate image.
• Add/remove border, shift to sub-pixel accuracy, mirror image, swap image octants.
• Arithmetic operations on two image operands, one image operand and a scalar, 

mathematical functions on one image operand, soft clipping & thresholding.
• 4D Gaussian filter of arbitrary widths, 4D Laplacian filter.
• Generate solid and hollow bandlimited spheres, generate Poisson and Gaussian 

noise.
• Real and complex 4D Fast Fourier transforms.

Reporting & Display Operations
• Image statistics.
• Report sampling density with respect to Nyquist rate.
• Image histograms of images with up to two channels.
• Plots of energy flux as function of time and axial position.
• Plots of intensity profiles along lines in any orientation.

Image File I/O
• Reads HDF5, ICS, Imaris classic, TIFF (file series with arbitrary numbering), Meta-

morph STK, Biorad PIC, Olympus TIFF (Fluoview and SIS), Delta Vision IMSubs 
(r3d), MRC files, IPLab IPL, Image-Pro SEQ, OME XML, and plain text (TXT and 
CSV).

• Optionally reads Zeiss ZVI, LSM and CZI, Leica LIF and LAS AF format version 2 
and 3. Olympus OIF, Olympus VSI, BioVision IPM and IPM Tiff, Nikon ND2.

• Writes HDF5, ICS, Imaris classic, Biorad PIC, TIFF (Leica style and classic numbered 
TIFF), OME XML, Delta Vision IMSubs (r3d), plain text (TXT and CSV), and AVI 
(MJpeg). For Huygens Professional only: plain text (csv, txt). For Huygens Core only: 
JPEG (for web applications).
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Customizing Huygens Professional
Analysis Functions
• Threshold and label 3D image.
• Analyze labeled objects: compute center of mass, volume and integrated intensity.
• Estimate background.
• Measure distance.
• Plot line profiles.
• Compute image ratio.
• Compute colocalization coefficients.
• Compute the co-occurrence matrix of an image.

Visualization Capabilities
• Thumbnail images.
• Multiple Slicers on one or more images. Each Slicer is able to;

· show x-y, x-z or y-z slices for selectable points in time while optimizing contrast 
on a global or per-plane basis;

· besides x-y, x-z and y-z slices, show slices in any arbitrary orientation;
· display multi channel images in spectral or false color;
· report individual pixel/voxel positions and values;
· swing through planes or time;
· dynamically link the position, orientation, time, and zoom.

• View your data from three sides simultaneously using the Orthogonal Slicer.
• Maximum intensity projections (MIP) of multi channel images in any orientation.
• Volume rendering using the SFP renderer. The Simulated Fluorescence Process (SFP) 

algorithm computes high quality 3D images based on the physics of light.
• Iso-surface rendering.
• Export of sophisticated 3D animations:

· combine high quality MIP, SFP, and surface renderings;
· use predefined animation presets;
· animate the viewpoint, zoom, and any other visualization parameter;
· use linear or smooth interpolation in transitions;
· export to AVI and Tiff series.

Customizing 
Huygens 
Professional

Huygens Professional has a button bar to quickly  run commands or tools. This button 
bar can be personalized by pressing the grey arrow at the end of the button bar ( ). For 
each item in the menus there is a corresponding button/icon in the icon selector. In 
Figure 1.1 the icon selector window is shown with all its functionality highlighted.
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The top-bar in the icon 
selector represents the but-
ton bar of the main window 
of Huygens Professional. 
This top-bar can be scrolled 
from left to right. Below the 
top-bar is the icon field 
showing all icons not placed 
in the top-bar. Simply click 
and move icons to place 
them in or out the top-bar. If 
an icon already exists at the 
location where you release 
the mouse button, the icons 
will be switched.

In case you like to insert an 
icon between two adjacent 
icons in the top-bar, you first 
need to create an empty 
space. This is done by a right click in the space between the two icons and select e.g., 
“Move icons right”. This will create a space at the right of the mouse position and you can 
insert any icon that you want. More options are available under right click on the top-
bar:

• Add separator: a separator may be inserted in between two icons to distinguish 
groups. A separator is a thin gray line between icons.

• Delete separator: added separators can also be deleted.
• Delete all separators: deletes all separators at once.
• Move icons right: moves all icons right from the cursor to the right. If icons would fall 

off at end of the top-bar, they are placed back in the icon field.
• Move icons left: moves all icons left from the cursor to the left. If icons would fall off 

at the beginning of the top-bar, they are put back in the icon field.
• Delete empty space: removes an empty space. This is not really necessary. Empty 

spaces will be ignored, so all icons will be placed side by side in the main window.

Below the icon field there is a search field. The entered key is matched with the icon 
names and tool tips. Matching icons are highlighted with a green border and the number 
of matches is printed beside the search entry. Since the top-bar can be scrolled you may 
have found an icon that is out of the view. Below the search entry, there are the following 
buttons:

• Cancel: cancels all changes made and closes the window.
• Clear: clears the top-bar and places all icons in the icon field.
• Set to default: sets the default button bar back in the top-bar.
• Revert: reverts all changes made in this instance of the icon selector.
• Accept: updates the button bar in the main window of Huygens Professional and 

closes the window.

FIGURE 1.1. The icon selector showing all its 
functionalities.
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Microsoft Windows
CHAPTER 2 Installation

Huygens Professional can be downloaded from the SVI website1.

Microsoft Windows Double click on the Huygens installer executable, e.g. huygens-
1505p1_i386.exe. Double click its icon to start the installation. During installation 
the directory C:\Program files\SVI\ will be created by default. After comple-
tion the four Huygens icons appear on the desktop. Double clicking on the Huygens Pro-
fessional icon starts the program.

Mac OS X Double click the package file, for instance huygens-15.05-p1-Lion-i386-
x86_64.pkg. The archive manager expands it to a .pkg file, which will be placed in 
the same directory. Double click this file, and follow the installation wizard.

Linux (Debian) Debian packages are natively used by Ubuntu and other Debian-based Linux distribu-
tions. Double click the package file, e.g. huygens_15.05-p1_amd64_older-
GLIBC.deb, and follow the steps in the package manager. To install the package 
through the command line:

dpkg -i huygens_15.05-p1_amd64_olderGLIBC.deb

Linux (RPM) RPM (RedHat Package Manager) packages are natively used by RedHat, Fedora, SUSE, 
and other RPM-based Linux distributions. Double click the package file, e.g. huygens-
15.05-p1.x86_64.rpm, and follow the steps in the package manager, or install the 
package through the command line:

rpm -ivh --force huygens-15.05-p1.x86_64.rpm

1. http://www.svi.nl/Download
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After the Installation After a first-time installation there is not yet a license available. However, the software 
can still be started. Without a license it will run in Freeware mode  (See Figure 2.1). The 
System ID, necessary for generating a license, is obtained by pressing the REQUEST TEST 
LICENSE button  when opening Huygens Professional. It can also be found in the 
HELP→LICENSE OVERVIEW menu. The next section explains how to obtain and install a 
license string. 

The License String The license key used by all SVI software is a single string per licensed package. It may 
look as follows:

HuPro-15.05-wcnp-d-tvAC-emnps-eom2015Dec31-
e7b7c623393d708e-{user@domain.com}-4fce0dbe86e8ca4344dd

At startup Huygens Professional searches for a license file huygensLicense, which 
may contain a license. A license string can be is provided by SVI via e-mail. Installing a 
license string is the same for all platforms.

Obtaining a License String
If upgrading is not handled from a previous installation it is likely that a license is not yet 
available. To enable us to generate a license string, we need the fingerprint of the com-
puter used, the so-called system ID number.

If Huygens Professional is not already running, 
please start it. The system ID pops up as long as 
no valid license is available and is displayed in 
the HELP→ABOUT dialog (Figure 2.1). Send it to 
sales@svi.nl, and a license string will be 
provided.

To prevent any typing error use the COPY button 
to save the ID to the clipboard. It can be printed 
into the license mail message with the 
EDIT→PASTE menu item of the mail program.

This dialog box also contains a button to Check 
for updates on the SVI company server.

Installing the License String
Select the license string in the e-mail message 
and copy it to the clipboard using EDIT→COPY in 
the mailing program. Start Huygens Professional 
and go to HELP→LICENSE: a dialog box pops up. 
Then press the ADD NEW LICENSE button and 
paste the string into the text field (Figure 2.2). 
Complete the procedure by pressing ADD 
LICENSE; this will add the string to the huygen-
sLicense file. Please try to avoid typing the 
license string by hand: any typing error will 

invalidate the license. With an invalid license, the software will remain in Freeware 
mode. When the license is correct the message “Added license successfully” will appear.

FIGURE 2.1. The HELP→ABOUT 
window. The system ID is 
shown at the bottom.
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The License String
Restart Huygens Professional to activate the new license!

Location of the License File
The license string is added to the file huygensLicense in the SVI directory (Table 2.1 on 
page 7). 

On Irix and Linux and Mac OS X an alternative location is the user's home directory. On 
OS X this is especially convenient when updating frequently.

TABLE 2.1. The default installation paths per platform. 

Platform Installation path
Windows C:\Program files\SVI\

Windows 64 bit Edition C:\Program files (x86)\SVI\

Mac OS X /Applications/SVI/a

a. The path name on Mac OS X depends on where the software is installed. 
This is a typical example.

Linux /usr/local/svi/

FIGURE 2.2. The license window allows to add, delete and 
troubleshoot licenses.
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Troubleshooting License Strings
The license string as used by 
SVI has the same appearance 
on all supported platforms. 
For each product it is 
required to have a license 
string installed. Select a 
license string in the license 
window (HELP→LICENSE) 
and press the EXPLAIN 
LICENSE button. All details 
for the current license will be 
listed (Figure 2.3). If run-
ning into licensing problems 
this information can be used 
to analyze the problem.

Updating the 
Software

When the system is attached to the internet a pop-up window will appear when a newer 
version is available. The website can also be consulted for updates. Twice a year around 
April and October new releases will become available. Download the new version from 
the SVI website2. Proceed with the installation as explained above.

Do not uninstall the old version as this will delete the license string. The new version will 
(by default) automatically replace the old Huygens verion. However, for the MAC OS X, 
we advise to first uninstall the software and then reinstall a newer version. Please read 
the next subsection “Removing the Software” carefully for more information.

Removing the 
Software

Removing the software will also cause the license string to be removed. If it is preferred 
to uninstall the current version prior to installing a newer one, take care to store the 
license string in a safe place. See “Location of the License File” on page 7 to read where to 

FIGURE 2.3. The Explain License window lists all 
license details.

2. http://www.svi.nl/Download
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System Requirements for Huygens Professional
license string is stored. Table 2.2 on page 9 shows the uninstall procedure for each plat-
form.

System 
Requirements for 
Huygens 
Professional

Tables Table 2.3, Table 2.4, and Table 2.5 list the requirements for Windows, Mac OS X, 
and Linux.

Support on 
Installation

If any problem is encountered in installing the program or the licenses which could not 
be solved with the guidelines here included, please search the SVI Wiki3 or contact SVI 
(See “Contact Information” on page 201).

TABLE 2.2. The uninstallation procedure per platform.

Platform Procedure
Windows Open the start menu and select: 

PROGRAMS→HUYGENS SUITE→UNINSTALL→REMOVE
THE HUYGENS SUITE. 

Linux Open the package manager, search for huygens and unin-
stall it. This could also be handled with the command 
line; type dpkg -r huygens to install a Debian 
package or rpm -e huygens to install an RPM 
package.

Mac OS X Drag the installed version to the waste basket.

TABLE 2.3. System requirements for Microsoft Windows.
Operating system Huygens runs on Microsoft Windows Vista, Windows 7, 

and Windows 8 (64 bit)
Processor AMD Athlon 64 or Intel Pentium 4 and higher.
Memory 2 Gb or more.
Graphics card Any fairly modern card will do.

TABLE 2.4. System requirements for Mac OS X
Operating system Huygens runs on Mac OS X Mountain Lion, Mavericks, 

Yosemite (X11, XQuartz)a.

a. OS X 10.7 or higher with X11 is required for full 64 bit capabilities.

Processor G5 PowerPC or Intel.
Memory 2 Gb or more.
Graphics card Any fairly modern card will do.

TABLE 2.5. System requirements for Linux
Operating system Most popular distributions like Ubuntu, RedHat, Fedora, 

and SuSE are supported. Linux (64 bit)
Processor AMD Athlon 64 or Intel Pentium 4 and higher.
Memory 2 Gb or more.
Graphics card Any fairly modern card will do.
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Measuring the 
software usage

The usage of the Huygens basics (e.g. 
Essential, Professional) software is logged 
everytime the software is launched. In 
addition, the usage of those tools that 
require a license-flag in your license 
string is saved. This usage can be viewed 
with the Usage Report window, see 
Figure 2.4. 

Go to HELP → USAGE REPORT and wait for 
the software to analyze the data. Once the 
analysis is done the General information 
tab shows the total usage of the software. 
The Detailed information tab shows the 
usage per tool.

The usage can be filtered by product, user, version and time. Simply select one of the 
options in the menu-buttons and the data is re-analyzed. This usage report can be saved 
through FILE → SAVE USAGE as a .csv file.

The usage is written to a log file located in the installation directory in the directory 
UsageLogs and all users are able to write to it. Each year a new log-file will be created 
and the Usage Report tool analyzes all usage logs in this directory. When the software is 
updated and/or uninstalled, the usage logs are kept.

3.http://www.svi.nl/FAQ#Installation_questions

FIGURE 2.4. The usage report window.
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Step 1: Start Huygens Professional
CHAPTER 3 Getting Started

This chapter will help you to get through the basic procedures in deconvolving an image 
and to become familiar with the user interface components of Huygens Professional. 
Note that several steps described below are automated in the deconvolution run (step 7).

Step 1: Start 
Huygens 
Professional

You can start the software by clicking on its desktop icon or, in case you are using a Unix 
shell in Linux, by typing huygenspro. If Huygens is used remotely, you need to use a 
client software1. If Huygens Professional is started from a Unix shell, it is a good idea to 
navigate to your image directory first. After starting up the software, a graphical user 
interface (GUI) appears with four empty thumbnail images (Figure 3.1).

1.http://ww.svi.nl/RemoteDisplay

FIGURE 3.1. The main window on Microsoft Windows. Four empty thumbnails 
are shown by default.
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Huygens Professional initially loads four empty images, named a, b, c, and psf. These 
images are tagged with default microscopy parameters, but the image data consists of 
just zero-es. The fourth image, psf, will be used in the following steps as a container for 
the point spread function. 
From the  Leica LAS AF/X software you can directly start Huygens and open an image in   
Professional. To do this, right-click with your cursor in the left column within LAS AF/X  
on the complete LIF project or a sub-image and select Export→HUYGENS  PROFESSIONAL.

Huygens  Professional can also be directly opened with selected images from Huygens 
Titan. For more information see chapter “Titan” on page 23. 

Step 2: Load an 
Image

If you like to open a new or another image in Professional, select FILE→OPEN from the 
menu in the main window and find the image. As mentioned above, you can also use 
Huygens Titan (again) for this purpose.

In the distribution you will find the demo image `faba128'. The image consists of the file 
pair faba128.ids and faba128.ics. The IDS file contains the image data and the ICS file 
the meta data, including the microscope parameters. You may click on one of these files 
to open the image.

In a Unix shell, steps 1 and 2 can be combined in a single command that loads the images 
automatically after starting Huygens Professional:

huygenspro faba128.ics dama.ids&

This command loads the files `faba128' and `dama' and shows their thumbnail images in 
the main window. The ampersand symbol (&) makes sure that the command prompt 
will return.

If you would like to open a series of Tiff slices, please read “Numbered Tiff Series” on 
page 194 for the naming convention in order to be able to read a multi-dimensional 
image as a whole.

Step 3: Inspect your 
Image

The slicer
Select the `faba128' image and open the Slicer via the menu VISUALIZATION→SLICER in 
the main window, or by right-clicking the thumbnail and choosing VIEW SLICER. The 
Slicer enables the user to show a single 2D plane extracted from a 3D volume. There are 
controls to select any plane orientation in space, zoom, and scroll through the available 
planes. For time series, a separate control is available to scroll through the available time 
frames. Furthermore, controls are available to set the contrast, brightness and color 
scheme for the different channels. Color schemes include `spectral' colors, i.e. the dis-
played color of a channel matches the true color of the emission wavelength in so far this 
is possible.

You can open as many Slicers as you like, on the same image or on different images 
(Figure 3.2). Multiple Slicers can be linked and `listen' to other Slicer windows. When 
linking is active, right clicking on the main Slicer will change the other view's center to 
the clicked coordinate, regardless of its orientation. Note that the option ‘other’ from the 
‘linking’ panel has to be selected in order listen to Slicer windows of other images.
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Step 3: Inspect your Image
More information on the Slicer and other Huygens visualization tools can be read start-
ing from “The Slicer” on page 61 onwards.

FIGURE 3.2. Two slicers opened with different views of the same image.
Huygens Professional User Guide for version 15.05 13



Microscopy Parameters
Verify the microscopic parameters (needed for the generation of a PSF) like NA, micro-
scope type, sample size, etc. by selecting EDIT→EDIT MICROSCOPIC PARAMETERS from the 
main menu (Figure 3.3).

Did you use the correct sampling size during the image acquisition? To find out select 
ANALYSIS→NYQUIST RATE from the main menu, which displays an information window 
as shown in Figure 3.4. You can also look under the tab NYQUIST in the main window. 
Read more about this important topic at the SVI-wiki2. It is also important to make sure 
that the sample sizes reported by the microscope during acquisition are correct3.

The `faba128' image is fairly good sampled in 
the x and y directions with a Nyquist rate of 
0.93, which is close to the value of one. How-
ever, the z direction has a Nyquist rate of 0.82, 
which indicates undersampling (the sampling 
was too coarse). It is advised to sample in the z 
direction using a sample distance of 166 nm or 
less. If the Nyquist tool leaves you with values 
smaller then one, the image is undersampled. 
Your future recordings may benefit from this 
information. Note that supersampling is not a 
problem, although your dataset becomes 
unnecessarily large without providing extra 
information. For now we continue with the z 
undersampled demo image.

2.http://support.svi.nl/wiki/NyquistCalculator

3.http://support.svi.nl/wikiCalibrateAxialDistances

FIGURE 3.3. The parameter editor. The values in this window should be checked 
carefully before deconvolution. 

FIGURE 3.4. The Nyquist 
information window. Values 
smaller than one indicate 
undersampling
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Step 3: Inspect your Image
The Intelligent Cropper
The time needed to deconvolve an image increases more than proportional with its vol-
ume. Therefore, deconvolution can be accelerated considerably by cropping the image. 
Huygens Professional is equipped with an intelligent cropper that automatically surveys 
the image to find a reasonable proposal for the crop region. In computing this initial pro-
posal the microscopic parameters are taken into account, making sure that cropping will 
not have a negative impact on the deconvolution result.

To start the cropper, select TOOLS → CROP from the menu in the main window. Initially, 
the cropper suggests that the bottom planes from `faba128' can be removed without sig-
nificant loss of information that will decrease the deconvolution quality (Figure 3.5).

To adjust this crop region manually, drag the corners or sides of the cropbox to the 
desired position or use the entries in the Specifications panel. Accept the new borders by 
pressing the CROP or EXTRACT button. The latter one will create a new image instead of 
adjusting the original. Do not crop the object too tightly, because you would remove blur 
information relevant for deconvolution. See “The Intelligent Cropper” on page 34. for-
more details about its options.

The Image Histogram
Select image `faba128' in the main window and display its histogram via ANALY-
SIS→IMAGE HISTOGRAM in the main menu. The histogram enables you to visually inspect 
the intensity distribution of the image. The distribution of `faba128', as seen in the left 
window in Figure 3.6, is of reasonable quality, i.e. there are no sharp peaks at both sides 
of the histogram that suggest clipping. The right window in Figure 3.6 shows an example 
of the histogram of a clipped image.

Clipping occurs when input signals that are too high, are mapped to the highest value 
available, or when `negative' input signals are mapped to zeroes by the CCD camera. 

FIGURE 3.5. The cropper window.
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Clipping at the right hand side of the histogram indicates saturation, as is the case in the 
right histogram in Figure 3.6. Saturation is caused by overexposure, e.g. by raising the 
laser intensity above the maximum pixel value the image file can accept.

Usually, all values above the maximum value are replaced by the maximum value. On 
rare occasions they are replaced by zeroes. Clipping will have a negative effect on the 
results of deconvolution, especially with widefield images. See “Clipping” on page 190. 
for more information.

A histogram may also show an offset at the left hand side, which indicates a positive 
blacklevel. A large positive blacklevel value reduces the effective dynamic range of your 
microscope, but will do no harm to the deconvolution with Huygens Professional. For 
more information, see “Black Level” on page 183 or the SVI wiki page4.

The Operations Window
In the former steps all operations were performed without any `operation parameters', 
i.e. variables or options applicable to a particular function. For example, if one wants to 
know the image statistics no extra information is needed but the name of the image. All 
these types of operations are accessible from the main window. However, most opera-
tions, like adding some constant value to an image, need extra input data. This can be 
done in the `operations window', which can be accessed via TOOLS → OPERATIONS WIN-
DOW in the main menu (Figure 3.7).

In the operations window, an operation can be selected from the menu bar or from the 
quick access buttons. Note that the left side of the operation window is similar to the 
Slicer. Each function can be controlled by editing the parameters in the `operations' 
panel. To execute the operation, press the RUN button. Note that the corresponding Tcl 
command is displayed at the bottom of the panel and, after execution, also in the Tcl 
shell of the main window.

Using the operations window, it is also possible to change or convert the dimensions of 
an image. By selecting a menu item under CONVERT, you can e.g. change xyz into xyt or 
convert a 3D stack into a 4D time series.

4.http://support.svi.nl/wiki/BlackLevel

FIGURE 3.6. Two image histogram windows. In the right image, the spike at the 
right hand side indicates clipping (saturation).
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Step 3: Inspect your Image
Most used conversion tools are also available using the Convert tool in the main window 
through TOOLS  → CONVERT... . 

Intermezzo: Bleaching Correction.

This extra check is given here for the sake 
of completeness for those using this sche-
matic approach for widefield images or 
confocal time series.

From the menu in the operations win-
dow, select ANALYSIS→PLOT FLUX. A typi-
cal example is shown in Figure 3.8. Note 
that the demo image `faba128' is a regu-
lar confocal image; a bleaching correc-
tion test makes no sense here.

FIGURE 3.7. The operations window where a Theoretical PSF is selected. Various 
operations can be selected from the menu bar or the quick access buttons.

FIGURE 3.8. A flux plot generated by 
the ‘Plot flux’ tool. The plot shows a 
typical example of the intensity 
distribution along the z axis of a 
bleached widefield image.
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Step 4: Generate a 
Point Spread 
Function (PSF)

The point spread function (PSF) is the way in which an imaginary, infinitesimal small 
light source would be sampled by your microscope. Often this object is no longer a point 
but blurred and spread out. The aim of the PSF generation is to estimate the amount of 
blurring along the x, y, and z axes. In the final step of deconvolution the PSF is used to 
come to a measured deconvolution, in contradiction to the so-called `blind deconvolu-
tion'.

A PSF can be obtained either by 
recording small beads with known 
bead diameter --180 nm beads work 
fine for e.g. confocal and widefield 
images-- and reconstructing a mea-
sured PSF from the bead image, or 
by calculating a theoretical PSF from 
the information about your micro-
scope settings. Huygens Professional 
has many tools to handle experi-
mental PSF's, but these are beyond 
the scope of this user guide.

A theoretical PSF can be generated 
by clicking the button Theor. PSF 
from the `operations' panel in the 
operations window. This function 
computes a PSF from the micro-
scopic parameters. By default, the 
result will be displayed in the image 
named `psf ', but any available image 
can be selected as destination. Press-
ing the RUN button will execute the 
function. The Slicer can be used to 
examine the generated PSF in more 
detail (Figure 3.9).

Note that although this step gives 
you insight in the PSF, it is actually better letting the deconvolution run generate the PSF 
on the fly. Especially while using large images that are processed brick-wise (see “Brick-
Wise Processing” on page 181), the PSF is prevented from being unnecessary large, it 
adapts its size to the brick size. In case of a multi channel image, the PSF is generated for 
one channel at a time instead for all at once.

All images can be cleared using the command EDIT→CLEAR IMAGE in the main window. 
You can do this for the image `psf ' as it will not be used in the next steps.

Step 5: Estimate the 
Average Background 
Value

Huygens estimates the average background in a volume image. The average background 
is thought to correspond with the noise free equivalent of the measured (noisy) image. It 
is important for the search strategy that the microscopic parameters of the image are cor-
rect, especially the sampling distance and the microscope type are of importance.

The average background estimation is invoked by selecting ANALYSIS→ 
ESTIMATE BACKGROUND from the menu in the operations window. The following choices 
are possible:

FIGURE 3.9. The PSF in x-z view. False 
coloring and a compressed contrast 
highlight the low intensity values showing 
the typical ‘diabolo shape’ in lateral view.
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Step 6: Estimate the Signal to Noise Ratio (SNR)
• Lowest value (Default)
The image is searched for a 3D region with the lowest average value. The axial size of 
the region is about 0.3 um, the lateral size is controlled by the `radius' parameter 
which is set to 0.7 um by default.

• In/near object
The neighborhood around the voxel with the highest value is searched for a planar 
region with the lowest average value. The size of the region is controlled by the 
`radius' parameter.

• Widefield
First the image is searched for a 3D region with the lowest values to ensure that the 
region with the least amount of blur contributions is found. Subsequently the back-
ground is determined by searching this region for a planar region with the lowest 
average value. Again, the size of the region is controlled by the `radius' parameter.

In case of the image `faba128', the best choice is `Lowest value', because we are looking 
for the background outside the object in a confocal image. After pressing the RUN button 
the calculated value is displayed in the `Task reports' panel of the main window. It is one 
of the values that should be known in the next steps.

Note that like PSF generation, this step is automated in the deconvolution run (step 7) 
too.

Step 6: Estimate the 
Signal to Noise Ratio 
(SNR)

The signal to noise ratio (SNR, or S/N) is used as a parameter that controls the sharpness 
of the deconvolution result. It is advised to estimate these values manually, because auto-
matic SNR estimation is tricky. The easiest way to obtain some SNR is to look at the tex-
tures of bright areas in your object image. Figure 28.1 on page 182 shows examples of an 
image having different noise levels. Inspect your image and decide if your image is noisy 
(SNR wiki, which is accessible in a fast way by typing the command help SNR in the 
Tcl shell).

Step 7: Perform a 
Deconvolution Run

In the `operations' panel, there are different deconvolution methods to choose from. 
These choices are `Classic Maximum Likelihood Estimation' (CMLE), `Quick Maxi-
mum Likelihood Estimation' (QMLE), Good’s roughness Maximum Likelihood Estima-
tion (GMLE), and `Quick Tikhonov-Miller restoration' (Quick-TM). Quick-TM is 
intended for very special circumstances only. CMLE is the most general restoration 
method available and should be used in most circumstances. For more information on 
these restoration methods, visit the SVI wiki5.

After clicking the CMLE button, the following parameter values can be adapted 
(Figure 3.10).

• PSF (if available)
From the list of all opened images, an image can be selected that is used as the PSF. 
This can be either a measured PSF or an earlier generated PSF (using the PSF button 
from the operations window). If you do not use a measured PSF, it is recommended 
to select an empty image. In this case, a PSF is `not available' and the software uses 
the microscopic parameters to generate PSF's on the fly.

5.http://www.svi.nl/RestorationMethod
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• Destination
The destination image in which the result will be stored.

• Signal/Noise per channel
This is the value that was estimated in step 6.

• Max. iterations
The deconvolution process will stop when the maximum number of iterations is 
reached or when the increase of quality drops below the `Quality change threshold'. 
Depending on initial quality of your image, a higher number of iterations will result 
in a better restoration result.

• Search for background
The option `Auto' will choose the best estimation mode for you and calculates the 
background value. In `Manual' mode the background value should be specified in 
the field below. This value was calculated in step 5.

• Backgr. per ch. (absolute or %)
Multi channel images may have different background values per channel. If the previ-
ous parameter was set to ̀ Manual', this list of values holds the background for each of 
the channels. Since the backgrounds established by the survey are conservative values 
(unless `In/near object' is selected) they can be increased by a percentage. For 
instance, 10% means all background estimates are increased by 10%. Negative per-
centages are also valid.

• Bleaching correction
If this parameter is set to `If possible', bleaching correction will be performed for 
widefield images or confocal time series showing exponential behavior.

FIGURE 3.10. The operations window where CMLE is selected. The right panel 
shows the parameters for the CMLE deconvolution run.
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Step 8: Saving your Image
• Quality change threshold
This number gives the minimum quality increase between subsequent iterations. If 
the increase of quality drops below the `Quality change threshold', the deconvolution 
process will stop. The lower the threshold value and the larger the number of itera-
tions, the higher is the quality of deconvolution.

• Other parameters like `Brick mode'6, `Iteration mode'7, and `Padding mode'8 are 
best kept in their default modes. More information on these modes can be found in 
the SVI wiki pages.

Pressing the RUN COMMAND button will end up with a restored result in the destination 
image (Figure 3.11). 

You may compare this result with the original image using two linked Slicers (see step 3 
on page 12).

Step 8: Saving your 
Image

If you are done and wish to save the result, select the thumbnail of the restored image 
and save the file by selecting FILE→SAVE AS from the menu in the main window. There 
are different formats to choose from.

Saving your deconvolution template

In the Operations Window, you can find next to the RUN COMMAND button the button 
EXPORT TO TEMPLATE. This button opens an Edit Deconvolution Template window. Here, 
you can change the deconvolution settings. More information on these settings can be 

6. http://support.svi.nl/wiki/BrickSplitting
7. http://support.svi.nl/wiki/IterationMode
8. http://support.svi.nl/wiki/PaddingMode

FIGURE 3.11. The main window with a deconvolved image ‘c’. Note that the ‘Task 
reports’ panel shows information on the deconvolution process.
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found under “Deconvolution Templates: Configuring the Restoration Process” on 
page 52. Upon clicking on ACCEPT the settings are saved to a template file. Template files 
are saved in the directory as defined under the directories tab in the Preferences window, 
which can be found under EDIT→PREFERENCES.

Why automatic deconvolution?
If the procedure is not automated, what should you do to deconvolve an n-channel 
image? You will have to split your parent image into n single-channel images and then 
generate a PSF, estimate the background and the signal to noise ratio for each of them. 
Next, you have to run the deconvolution algorithm channel by channel which ends you 
up with n restored one-channel images. Finally you have to `join' the separate images to 
a restored n-channel image. Although all tools are available in Huygens Professional, it is 
a time consuming task. Not to speak about multi channel time series!
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Titan as Freeware
CHAPTER 4  Titan

How to deal with my growing amount of image data and how to find my images fast 
without too much effort. These are questions that most microscopists will face at some 
point. 

Related questions like: How can I add keywords and experimental information to images 
without modifying them; How to get a quick overview of the acquisition parameters; 
Can I group images into projects without actually editing or moving the raw data; I am 
not looking forward to re-organize my data and use a database approach, what alterna-
tive do I have. 

If you recognize yourself in these questions, you may find Huygens Titan useful. 

Titan as Freeware Titan is not modifying or moving your valuable microscopy data. It indexes your files 
and gives you a quick overview of all your images with thumbnails, metadata, histo-
grams, statistics, and annotations (Figure 4.1).  Titan reads the common microscope file 

FIGURE 4.1. Huygens Titan shows microscopy data in Freeware mode.
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formats, and shows embedded images from container formats such as Leica LIF and 
Zeiss CZI. Titan has no problem with the location of the images. Microscopy data may 
have been saved centrally, located on external hard disks or USB drives, and spread over 
multiple file storage locations. The Freeware version of Titan has a capacity of 200 Giga-
byte image data. If you need more than that, you can contact us for a test license (see 
“Contact Information” on page 201).

Titan does not edit 
or move your 
valuable image data

There is no need to go through all your existing data if you want to organize your images 
with Titan. Titan simply does that for you! Just start by specifying in Titan the location of 
your images. This can be even multiple locations. Titan just visits the images and indexes 
them automatically, smartly focusing on images that you want to see first. You can 
quickly search for specific images across all indexed storage locations with search terms 
including file or folder names, Nyquist values, and/or metadata properties such as chan-
nel number, excitation/emission wavelength values, and microscope type (like for exam-
ple Confocal, STED, Widefield). Keywords and comments can be added to the images, 
and it is possible to group images into projects. Again, this can all be done without edit-
ing the raw images and their location. Selected images can be opened in the Light Box, 
which is a viewer that allows you to inspect multi-dimensional image data (2D-5D). 
Exporting images to Essential and Professional for further processing is easily done with 
their corresponding launch buttons.

Starting Titan Click on the Huygens Titan desktop icon to get started. Titan can run in FreeWare mode 
up to 200 Gigabyte of data, and will immediately start indexing the demo images 
included with the Huygens Suite. You will see a window appearing for requesting free 
test license, with such a license you can index more files (Terabytes of data). See 
Figure 4.2. We will be happy to reply to your request and send you a test license.

FIGURE 4.2. Titan starts up in Freeware mode and can already index up to 200 
Gigabyte of data. You will receive a test license with terabytes of index 
capacity if you send the systemID to us. 
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Searching images
Define the location of your images
Use within the main window the green ADD WATCH DIRECTORY button at the bottom-
left, or look under FILE, to open the Preferences window for adding image storage loca-
tions (directories) to be indexed. Library name and indexing priority can be adjusted by 
clicking on these fields. You can also define here at what times Titan should leave enough 
computer resources available for other activities, and what should be the maximum file 
size to be indexed. The number of CPU’s available for Titan an be set, as well as the stor-
age location of where Titan should store the image thumbnails it generates. 

Upon hitting the Apply button, Titan will immediately start indexing, as can be seen in 
the Titan Activity window (bottom-right). The Library name with the number of images 
is displayed in the left main window. If a location, such as for example a USB stick or 
external hard disk, is no longer available, a red cross will appears on a library name. Re-
connecting the file storage location will remove this cross again.

Display options for colors and how the thumbnails should be sorted can be set with the 
settings (wheel) button located on the right above the thumbnail window. The slider next 
to it enables you to adjust the size of the thumbnails. If the number of images exceed one 
hundred they will be listed over multiple pages. Scrolling through these pages can be 
done with the arrow buttons. 

At the right side within the main Titan window there are several tabs located with more 
image information of the selected thumbnail, and for annotations concerning the 
selected image (see “Annotations and Projects” on page 26).

Thumbnail messages

There are several messages that can appear on the thumbnails. They show the indexing 
status of this specific image. An overview of these messages can be seen on this wiki 
page1. 

Scheduling index activity 
Indexing can be a computational and time-consuming process, so if you have many data 
to be indexed you may need to leave Titan active for some time. However, once your 
images are indexed you may appreciate how fast Titan shows their thumbnails and meta-
data. By default, Titan runs in background mode between 7:00 and 19:00 hours on work-
ing days. Under the INDEXER tab within the Preferences window, you can manage these 
settings to save computer resources.

Searching images Titan allows you to easily search through your images using keywords and multiple 
metadata properties. Quick searches are available to select for images that have been 
acquired with correct Nyquist sampling, and for those that are multichannel (suitable for 
for colocalization analysis), and have multiple frames (stabilization). Images can also be 
searched on file type, and with what microscope type they were acquired. Combinations 
of search terms can also be applied, and search parameters can be cleared with cross but-
ton above the thumbnail window (Figure 4.3 on page 26) 

1. http://www.svi.nl/TitanHelp
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Annotations and 
Projects

You can tag images with text, and group images into projects using the ANNOTATIONS 
tab (top-right). Upon selecting a thumbnail and writing a project name into the Project 
field under this tab, a new project will be made. This project will not be shown immedi-
ately. For that, you first need to manage the projects, which can be done in the left col-
umn “ Library”  by right-clicking on Project or on one of the existing project names. A 
new window Manage Projects will open where your new project name is shown. Other 
new projects can also be added or removed here, and project names can be selected for 
display under Library. You can assign multiple images to one project by specifying their 
project name. 

Viewing and 
forwarding images

At any stage, you can double-click on a thumbnail to add the image to the Light-box in 
which another double-click allows detailed multi-dimensional viewing (Figure 4.4 on 
page 27). Thumbnails can be selected with the left mouse button (hold the Shift or 
CTRL-key to select more) and send with the right-mouse button for further processing 
to the File Manager, or Huygens Essential or Professional. You can also use the HUYGENS 
ESSENTIAL and HUYGENS PROFESSIONAL icons in the Titan for this purpose. Please note 
that the display of channel colors may change if the image is opened in Essential or Pro-
fessional. This is due to a different color setting in the software which can be changed 
easily (see “Adjusting the Global Color Scheme” on page 195).

For more information and a tutorial video we like to refer you to the wiki on Huygens 
Titan2.

FIGURE 4.3. Titan offers several parameters that can be set to narrow down 
your search for images.

2. http://www.svi.nl/HuygensTitan
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Viewing and forwarding images
FIGURE 4.4. Slicing through 2D-3D time series and multichannel images is 
images in Titan Light box.
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The Processing Stages in the Wizard
CHAPTER 5 Deconvolution Wizard

The Processing 
Stages in the Wizard

The deconvolution wizard guides you through the process of microscopic image decon-
volution in several stages. 

Each stage is composed of one or more tasks. While proceeding, each stage is briefly 
described in the bottom-left Help window tab. The stage progress is indicated in the Wiz-
ard status pane, below the Help tab. Additional information can be found in the online 
help (HELP→ONLINE HELP) as well as by clicking on the highlighted help questions.

The following steps and stages are to be followed:

• Loading an image.
• Verifying microscopy parameters.
• Start Stage: here, an overview is given of the most important parameters for ensuring 

optimal deconvolution. You can continue with using the wizard or applying a decon-
volution template.

•  Loading a measured PSF that has been distilled from bead images. 
• Preprocessing Stage: this stage goes through all preprocessing steps.

· Cropping stage
· Stabilization (STED data)
· Select channel
· Inspecting the image histogram.
· Background Estimation

• Deconvolution Stage: 
· Setting the final deconvolution parameters.
· Run the deconvolution.
· Select final result

• Post-processing Stage: correct for Z-drift if any and accept the result.
• End Stage: Option to Restart, Save deconvolution template and Finish.

The next sections of this chapter will explain the wizard stages in detail.
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Loading an Image Select FILE→OPEN or the OPEN icon in the Huygens main window to open the file dialog, 
browse to the directory where the images are stored, and select the image, for example 
faba128.h5. A demo image (faba128.h5) is placed in the Images subdirectory of the 
installation path (see Table 2.1 on page 7). For searching your image, you may find Huy-
gens Titan a very useful option as it shows your images as thumbnails and offers 
advanced search tools (see “Huygens Titan” on page 12).

Most file formats from microscope vendors are supported, but some of them require a 
special option in the license to be read. See the SVI support Wiki1 for updated informa-
tion.

If the file is opened successfully, select its corresponding thumbnail and check whether 
the image dimensions are correct by looking under the tab STATISTICS located at the top-
right of the main window. Some tools, such as those to convert the image dimensions, 
are described in more detail in the next subsections.

Converting a Dataset

Before applying deconvolution, it is important that the image dimensions are correctly 
defined. Dimensions can be changed with the conversion tools listed under the TOOL 
menu. For example, a 3D stack can be converted here into a 3D time series () or vice 
versa, or a 3D stack can be converted into a time series of 2D  images () or vice versa. In 
case of a refractive index mismatch, it is important to set the orientation of the image 
correctly with respect to the imaging direction and also to the coverslip position (). The 
MIRROR tab in the converter tool can also be used for that purpose. Read more at “Set-
ting the Coverslip Position” on page 196.

Time Series
A time series is a sequence of images recorded at uniform time intervals. Each recorded 
image is a time frame. Huygens Professional is capable of deconvolving 2D-time or 3D-
time data automatically with the Time option (see Table 31.2 on page 203). There are 
some tools that are intended only for time series, such as the widefield bleaching corrector 
or the z-drift corrector.

Adapting the image

In the  menu, you can find under a contrast converter () which is required for the pro-
cessing of brightfield images (See “Brightfield Images” on page 198.). A Crop tool is also 
available, but its use is recommended only after properly tuning the image parameters. 
This tool will be explained at a later stage in this manual.

1.http://www.svi.nl/FileFormats
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Verifying Microscopy Parameters
Verifying 
Microscopy 
Parameters

TABLE 5.1. Optical parameters explained.

Parameter Explanation
Microscope type Select from widefield, confocal, spinning disk, 4Pi or 

STED, SPIM, or unspecified. For a multiphoton micro-
scope insert an excitation photon count higher than 1. 
Select widefield if a nondescanned detector was used, and 
confocal in case a pinhole of less than a few Airy disc 
units was used.

Numerical aperture The NA of the objective lens.
Objective quality Select from perfect, poor, or something in between.
Coverslip position The position of the glass interface relative to the nearest 

slice of the stack. See also page 196
Imaging direction Select from upward or downward. Upward means that the 

objective lens is closest to the bottom slice in the stack. 
Upward stands for an inverted microscope where the 
objective points upward.

Backprojected pinhole radius The radius (in nm) of the pinholes in the spinning disk as 
it appears in the specimen plane. This is the physical pin-
hole radius divided by the total magnification of the 
detection system.

Backprojected pinhole spac-
ing

The distance (in μm) between the pinholes in the spin-
ning disk as it appears in the specimen plane. This is the 
physical pinhole distance divided by the total magnifica-
tion of the detection system.

Lens refractive index The RI of the immersion medium for the objective lens.
Medium refractive index The RI of the specimen embedding medium.
Excitation wavelength The wavelength (in nm) of the excitation light (usually a 

laser line).
Emission wavelength The wavelength (in nm) of the emitted light.
Excitation photon count Number of photons used in multi-photon microscopy.
Excitation fill factor The width of the beam relative to the aperture. The 

default value is 2, meaning that the aperture has a diame-
ter of 2σ, where σ is the standard deviation of the Gauss-
ian distribution in the beam.

STED depletion mode This mode determines the type of STED depletion that is 
being used. You can set this to Pulsed, CW non-gated 
detection, or CW gated detection.

STED saturation factor Factor describing how much the fluorescence is sup-
pressed by the STED beam.a

a. Chapter 8 on page 55

STED wavelength Wavelength of STED depletion laser beam (nm)
STED immunity fraction Fraction of fluorophore immune (photoresistant) to the 

depletion beam.
STED 3X Percentage of laser power used for the Z depletion beam, 

The remaing part is used for the vortex beam
Deviating microscope type The deviating microscope type for the current channel.
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By using the parameter wizard or the parameter editor, one can modify the parameters 
that are explained in Table 5.1. If values are displayed in a red background, they are 
highly suspicious. An orange background indicates a non-optimal situation (See 
Figure 5.1). Oversampling is also indicated with a cyan background, that becomes violet 
when it is significant. 

The editor and wizard can be found by right-clicking on the image thumbnail and select-
ing  or PARAMETER WIZARD. The wizard is also in the DECONVOLUTION menu. Figure 5.1 
shows the Parameter Wizard. The Parameter Editor is shown inFigure 5.2.). 

FIGURE 5.1. Parameter wizard: check sampling density. Red coloring 
indicates a suspicious value, and orange a non-optimal value.

FIGURE 5.2. The microscopy parameter editor. This window can be opened 
by right-clicking on the thumbnail and selecting .
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Starting the Deconvolution Wizard
Microscopic Template Files
Once the proper parameters have been set and verified, they can be saved to a Huygens 
microscopy template file (.hgsm).Templates can be applied at the start of the parame-
ter wizard or in the parameter editor.

The LOAD button allows the selection of a template from a list of template files. The Huy-
gens common templates directory is named Templates, and resides in the Huygens 
installation directory (See Table 2.1 on page 7). The user's personal templates directory is 
called SVI/Templates and can be found in the user's home directory2.

Starting the 
Deconvolution 
Wizard

Once all microscopy parameters have been verified, you can start the Deconvolution 
Wizard by pressing the deconvolution wizard icon in the main task bar, by selecting the 
wizard from the DECONVOLUTION menu, or by using the right mouse button on a 
thumbnail and selecting the DECONVOLUTION WIZARD option from the menu that 
appears.

If you prefer to generate a point spread function from measured beads first, select PSF 
DISTILLER in the DECONVOLUTION menu (See Chapter 6 “The PSF Distiller” on page 43). 
A special license is needed for activating the PSF Distiller option.

The first window of the Deconvolution Wizard shows a summary of the most important 
parameters for ensuring optimal deconvolution. Review them carefully before proceed-
ing if you have not done so already (see Figure 5.3). You can continue with using the 
deconvolution wizard or you can execute a deconvolution template..

2. User home directories are usually located in C:\Users on Windows 7 and Vista and in 
C:\Documents and Settings on Windows XP and lower. On Mac OS X they are 
usually in /Users and on Linux in /home.

FIGURE 5.3. Starting window of the Deconvolution Wizard with a summary 
of the most essential parameters.
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The latter option will shown a list of available templates and a button to load a template 
file. Below the list of files is shown whether the template considers an experimental or a 
theoretical PSF (Figure 5.4). You can overrule this by using the button OVERRIDE PSF 
FROM TEMPLATE. A next screen, will give you the option to select an experimental PSF.

Using a Measured 
PSF

Measured PSF's improve the deconvolution results and may also serve as a quality test 
for the microscope. If the measured PSF contains less channels than the image, a theoret-
ical PSF will be generated for the channels that have no available PSF. See Chapter 6 “The 
PSF Distiller” on page 43 and “The Point Spread Function” on page 193 for more infor-
mation.

A previously created measured Point Spread Function (PSF) can be loaded from a file or 
directly loaded from the main Professional window. A measured PSF should only be 
used for deconvolution if the image and the bead(s) were recorded with the same micro-
scope at the same parameter settings. The remaining steps in the wizard will be skipped 
when selecting the button EXECUTE TEMPLATE.

The Intelligent 
Cropper

The time needed to deconvolve an image increases more than proportionally with its 
volume. Therefore, the deconvolution can be accelerated considerably by cropping the 
image.

Huygens Essential and Professional are equipped with an intelligent cropper which auto-
matically surveys the image to find a reasonable proposal for the crop region (See 
Figure 5.5). In computing this initial proposal, the microscopical parameters are taken 

FIGURE 5.4. Deconvolution templates can be selected from the list or can be 
loaded. A template specifies if an experimental or theoretical PSF is used, 
but this can be overruled with the button OVERRIDE PSF FROM TEMPLATE. 
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The Intelligent Cropper
into account, making sure that cropping will not have a negative impact on the deconvo-
lution result. Because the survey depends on accurate microscopical parameters it is rec-
ommended to use the cropper as final step in the preprocessing stage (press YES when 
the wizard asks to launch the cropper), but it can also be launched from outside the wiz-
ard through the menu .

Cropping in X, Y, and Z.
The borders of the proposed cropping region are indicated by a colored contour. The ini-
tial position is computed from the image content and the microscopic parameters at 
launch time of the cropper.

The three views shown are maximum intensity projections (MIPs) along the main axes. 
For more information about these projections read Chapter 12 “The MIP Renderer” on 
page 75. By default the entire volume (including all time frames) is projected. The red, 
yellow, and blue triangles can be dragged to restrict the projected volume.

The cropper allows manual adjustment of the proposed crop region. To adjust the crop 
region, drag the corners or sides of the cropbox to the desired position or use the entries 
in the Specifications panel. To crop the original image press the CROP button. To create a 
new cropped image, press the EXTRACT button. The EXTRACT button is not visible if the 
the cropper is used within the deconvolution wizard. Do not crop the object too tightly, 
because that would remove blur information relevant for deconvolution, and back-
ground area for the efficient estimation of the background level.

Cropping in Time and removing channels
Select the from and to frame under Specifications to crop time series. There are entries 
for the time-selection, if the image is a time series. Only a continuous range can be 
selected to crop in time series.

All available channels are listed under CHANNELS in the Operation Window and can be 
removed individually. By using the right-click on a channel check box, all channels can 

FIGURE 5.5. The crop tool.
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be turned on or off, except for the selected channel. In the main window you can sepa-
rate the image into individual channels using SPLIT, which can be found under the TOOLS 
menu or as a taskbar icon.

Cropper Customizations and Options
The cropper is extended with extra visualization options available under OPTIONS. LOCK 
RATIO fixes the aspect ratio of the cropping box for each projection separately. PIXEL 
PROPERTIES shows the pixel intensities and position of the mouse if you hover over the 
image. The intensities, however, are only shown when one time frame and one channel is 
selected. If the PREVIEW box is checked, a small renderer shows the image after cropping. 

Stabilizing STED 
data

STED image acquisition is often subjective to drift. Thus, it is strongly recommended to 
stabilize the STED images before deconvolving them. This can be easily done within the 
Deconvolution Wizard, after the cropping stage.

The option to stabilize the data along the z direction is present in the Deconvolution 
Wizard with STED data. Whether stabilization will actually be applied depends on the 
percentage level of STED 3X. Stabilization will automatically correct the raw data for 
drifts and misalignments along the z direction. Deconvolution will be performed on the 
corrected, stabilized dataset. Once run, the stabilization cannot be undone.

This stage can be skipped at the Deconvolution Wizard if the image has already been sta-
bilized by other means like for example, the Huygens Object Stabilizer.

To stabilize the image in the Deconvolution Wizard just click on the “AUTO STABILIZE” 
button at the “STABILIZATION” stage (See Figure 5.6).

FIGURE 5.6. Stabilization stage for STED data in the Deconvolution 
Wizard.
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The Image Histogram
The Image 
Histogram

The histogram is an important statistical tool for inspecting the image. It is included in 
the deconvolution wizard to be able to spot problems that might have occurred during 
the acquisition. 

The histogram shows the number of pixels as a function of the intensity (gray value) or 
groups of intensities. If the image is an 8 bit image, gray values vary between 0 and 255. 
The x-axis is the gray value and the y-axis is the number of pixels in the image with that 
gray value. If the image is more than 8 bit, then gray values are collected to form a bin. 
For example, gray values in the range 0-9 are collected in bin 0, values in the range 10-19 
in bin 1, etc. The histogram plot now shows the number of pixels in every bin.

The histogram in Figure 5.7 shows that the 
intensity distribution in the demo image is of 
reasonable quality. The narrow peak shown at 
the left represents the background pixels, all 
with similar values. The height of the peak 
represents the amount of background pixels 
(note that the vertical axes uses logarithmic 
scaling). 

In this case there is also a small black gap at 
the left of the histogram. This indicates an 
electronic offset, often referred to as black 
level, in the signal recording chain of the 
microscope.

If a peak is visible at the extreme right hand 
side of the histogram it indicates saturation or clipping. Clipping is caused by intensities 
above the maximum allowed digital value. Usually, all values above the maximum value 
are replaced by the maximum value. On rare occasions they are replaced by zeros. Clip-
ping will have a negative effect on the results of deconvolution, especially with widefield 
images.

The histogram stage is included in the deconvolution wizard for examining purposes 
only. It does not affect the deconvolution process that follows3.

Estimating the 
Average Background

In this stage the average background in a volume image is estimated. The average back-
ground corresponds with the noise-free equivalent of the background in the measured 
(noisy) image. It is important for the search strategy that the microscopic parameters of 
the image are correct, especially the sampling distance and the microscope type.

In this stage the background value of the image (channel) can be automatically estimated 
or manually entered. For the automatic estimation you can choose the estimation mode 
and the area radius. The following estimation strategies are available:

• Lowest value (default): The image is searched for a 3D region with the lowest average 
value. The axial size of the region is about 0.3 μm; the lateral size is controlled by the 
radius parameter which is by default set to 0.7 μm. 

3. Learn more about histograms at http://www.svi.nl/ImageHistogram

FIGURE 5.7. The image 
histogram. The vertical 
mapping mode can be selected 
from linear, logarithmic or 
sigmoid.
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• In/near object: The neighborhood around the voxel with the highest value is searched 
for a planar region with the lowest average value. The size of the region is controlled 
by the radius parameter. 

• Widefield: First the image is searched for a 3D region with the lowest values to 
ensure that the region with the least amount of blur contributions is found. Subse-
quently the background is determined by searching this region for the planar region 
with radius r that has the lowest value. 

Press the AUTO button in the wizard to continue with the automatic estimation with the 
options entered in this stage. Press the MANUAL button, if you want to skip the automatic 
estimation step and estimate it yourself.

In the next step the estimated value can be adapted either by altering the value in the 
Absolute background field or in the Relative background field. Setting the latter to -10, for 
example, lowers the estimated background by 10%. You can also choose how the back-
ground is stored in the template. By default the relative background is stored. If you plan 
to use this template also for other images that have been acquired with the same settings, 
you may want to use the absolute background instead.

In case you choose the manual setting, the absolute value is automatically stored in the 
template.

The last option determines the deconvolution algorithm. The default is Classical Maxi-
mum Likelihood Estimation (CMLE). In case of widefield images, it can also be set to 
Quick Maximum Likelihood Estimation (QMLE), as the QMLE can typically be applied 
to images with a high signal-to-noise level. For STED images you have the option to use 
either the CMLE or the Good’s roughness Maximum Likelyhood Estimation (GMLE) algo-
rithm. So, the wizard offers a different set of algorithms depending on what microscope 
type is used. Within the Operation window in Huygens Professional, you can choose 
either one of these algorithms or the  Quick-MLE-time, Quick-Tikhonov-Miller, and Iter-
ative Constrained Tikhonov-Miller algorithms.4

If done press ACCEPT to proceed to the deconvolution stage.

The Deconvolution 
Stage

Figure 5.8 shows the deconvolution stage where the deconvolution parameters can be 
set. The following parameters are available for the CMLE algorithm. The options for 
QMLE are almost the same,  except that the Quality threshold and the Iteration mode are 
not available.

1. Number of iterations. MLE is an iterative process that never stops if no stopping cri-
terion is given. This stopping criterion can simply be the maximum number of itera-
tions. This value can be adjusted, depending on the desired final quality of the image. 
For an initial run the value can be left at its default. To achieve the best result this 
value can be increased to e.g. 100. Another stopping criterion is the Quality threshold 
of the process (See Item 3).

2. Signal to noise ratio. The SNR is a parameter than controls the sharpness of the res-
toration result. Using a too large SNR value might be risky when restoring noisy orig-
inals, because the noise could just be enhanced. A noise-free widefield image usually 
has SNR values higher than 50. A noisy confocal image can have values lower 
than 20. See also “Signal to Noise Ratio” on page 181

4.http://www.svi.nl/RestorationMethod
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The Deconvolution Stage
3. Quality threshold. Beyond a certain amount of iterations, typically below 100, the 
difference between successive iterations becomes insignificant and the progress 
grinds to a halt. Therefore it is a good idea to monitor the progress with a quality 
measure, and to stop the iterations when the change in quality drops below a thresh-
old. At a high setting of this quality threshold, e.g. 0.01, the quality difference 
between subsequent iterations may drop below the threshold before the indicated 
maximum number of iterations has been reached. The smaller the threshold the 
larger the number of iterations that will be reached; the higher the quality of the res-
toration. Still, the extra quality gain becomes very small at higher iteration counts. 
The absolute value of the final quality factor much depends on the data, the micro-
scope type, and the background. It is a global value computed over the entire image, 
so the contribution of a local resolution increase can be small, as such it can only be 
used in a relative way to compare iterations and should not be seen as a value to com-
pare the quality of different images.

4. Iteration mode. In optimized mode (highly recommended) the iteration steps are 
bigger than in classical mode. The advantage of classical mode is that the direction of 
its smaller steps is sure to be in the right direction; this is not always the case in opti-
mized mode. Fortunately, the algorithm detects if the optimized mode hits upon a 
sub optimal result. If so, it switches back to the classical mode to search for the opti-
mum.

5. Bleaching correction. If this option is set to if possible, then the data is inspected for 
bleaching. 3D stacks and time series of widefield images will always be corrected. 
Confocal images can only be corrected if they are part of a time series, and when the 
bleaching over time shows exponential behavior.

6. Brick layout. When this option is set to auto, then Huygens Professional splits the 
image into bricks in two situations:
a. The system’s memory is not sufficiently large to allow an image to be deconvolved 

as a whole.

FIGURE 5.8. The Deconvolution Stage in the wizard.
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b. Spherical aberration is present, for which the point spread function needs to be 
adapted to the depth.

Press DECONVOLVE to start the restoration process. Pressing STOP DECONVOLUTION halts 
the iterations and retrieves the result from the previous iteration. If the first iteration is 
not yet complete an empty image will be shown.

Finishing or 
Restarting a 
Deconvolution Run

When a deconvolution run is finished, the result is shown in the right viewer, and you 
can choose to RESTART ALL, RESTART CHANNEL, RESUME or ACCEPT/ALL DONE the resto-
ration:

• Restart all will return to the start stage and all results of all channels are discarded.
• Restart (channel) keeps the result so far and will return to the background stage 

where you can change the background setting and rerun the process with different 
deconvolution parameters. A new result will be generated to compare with previous 
results. This can be repeated several times.

• Resume keeps the result and returns to the stage where the deconvolution parame-
ters can be entered. The software will ask to continue where it left off, or to start from 
the raw image again. A new result will be generated to compare with previous results. 
This can be repeated several times.

• Accept, to next channel proceeds to the first channel that has not yet been decon-
volved. In case of All done, all channels have at least one deconvolution result or it 
was not a multi-channel image and it will proceed to the final stage. 

The Final Stage The last deconvolution result of each channel is automatically selected for the final 
image. By moving image names from the Available to the Selected list, you can combine a 
channels as desired. You can use the mouse-scroll to scroll the lists. Also, when clicking 
on a thumbnail in the left Images pane, the corresponding name is highlighted in the 
Available list, if it was not already moved to the Selected list. Not only the deconvolved 
results are available, but also you can include an original image in the final result. Con-
tinue to the next stage if you are satisfied with the selection. Please note, pressing Restart 
will discard all the results and will immediately return to the start stage.

What now follows is the possibility to RESTART all again (which discards the results), 
SAVE TEMPLATE for deconvolution, or press DONE to export the result to the main win-
dow of Huygens Professional.

The Comparison 
View

Detailed image comparisons of all the thumbnails in the left panel of the Wizard can be 
done using the Comparison View displays with loading images via a right-click on their 
corresponding thumbnails and select “Show left” or “Show right” (See Figure 5.9).
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Multi-channel Images
In order to plot the image intensities along a specific path click on the image and draw a 
line without releasing the mouse. A plot will be shown on the Comparison View display 
(left or right) opposite to where the line is drawn. To hide the plot, click a point of the 
Comparison View off the drawn line. To show the same plot again, click on the drawn 
line. This operation can be performed on both sides of the Comparison View. The plot 
will show the intensities of the two images loaded on the displays, for comparing pur-
poses, see Figure 5.10 on page 42. If one of the displays is empty the plot will only show 
the intensities the image shown.

Multi-channel 
Images

Multi channel images can be deconvolved in a semi-automatic fashion. Still, the results 
can be fine-tuned for each individual channel. After the preprocessing stage the multi-
channel image is split into single channel images named <imagename>:Ch0, <ima-
gename>:Ch1, etc. The first is automatically selected for deconvolution.

The procedure to deconvolve a multi channel data set is exactly the same as for a single 
channel image. Therefore multiple reruns on the channel can be done manually, just as 
with single channel data. Press ACCEPT, TO NEXT CHANNEL in the last stage, to select the 
following channels for deconvolution. There is the possibility to skip one or more chan-
nels.

FIGURE 5.9. Showing an image on the Comparison View: right-click on the 
thumbnail and select “Show left” or “Show right”. 
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When the last channel has been processed, the wizard offers the option to specify what 
channels and in what order they should be combined for the final deconvolved image..

Z-drift Correcting 
for Time Series

For 3D time series the wizard shows an additional step to enable the correction for 
movement in the z direction (axial) that could have been occurred, for instance, by ther-
mal drift of the microscope table. In case of a multi channel image, the corrector can sur-
vey All channels and determine the mean z position of the channels, or it can take One 
channel as set by the Reference channel parameter.

After determining the z positions per frame, the z positions (not the image) can be fil-
tered using a median, Gaussian or Kuwahara filter of variable width. If the drift is grad-
ual, a Gaussian filter is probably best. In case of a drift with sudden reversals or outliers a 
median filter is best. In case the z positions show sudden jumps, we recommend the 
Kuwahara filter.

Saving the Result After exporting the deconvolution result to the main window, the result can be saved. 
Select the image to be saved and select FILE→SAVE AS... in the menu bar. The HDF5 file 
format preserves all microscopic parameters and applies a lossless compression. To see 
which other file formats the Huygens software supports, see http://www.svi.nl/
FileFormats.

Select FILE→SAVE STAGE REPORT to store the information as displayed in the Report tab.

FIGURE 5.10. Comparing intensity profiles of two images in the 
Deconvolution Wizard. Notice that the plot prompts at the display opposite 
to where the line is drawn. 
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Beads suited for PSF Distillation
CHAPTER 6 The PSF Distiller

Huygens Professional is optionally equipped with the PSF Distiller. This wizard driven 
tool guides the user through the process of distilling a Point Spread Function (PSF) from 
3D bead images. It helps in selecting bead images, and in creating and saving the PSF for 
further deconvolution runs. The wizard is able to measure a PSF from one or multiple 
images, each containing one or more fluorescent beads. It is also possible to distill multi-
channel PSF's from multi-color bead images, or to assemble a multi-channel PSF from 
separate single channel bead images PSF's.

Measured PSF's improve deconvolution results and 
may also serve as a quality test for the microscope1. 
The measured PSF acts as a calibration of the 
microscope in the sense of relating a physical 
known object (bead) with what the microscope 
actually measures (bead image). Figure 6.1 shows 
an example of a theoretical, and a measured PSF.

Beads suited for PSF 
Distillation

The PSF distiller works by inspecting average images from small beads that are almost 
sub resolution in size, so they contain much of the PSF information. In order to measure 
a PSF from beads, the diameter of the beads should be in the order of the half intensity 
width2 (HIW; also referred to as full width at half maximum, FWHM) of the expected 
PSF. Larger beads will reduce the accuracy of the Distiller, while smaller beads yield 

1. We advise to measure the PSF after a change in the recording setup and certainly after each 
maintenance job in which the optics or scanning device was serviced.

FIGURE 6.1. An xz cross section of 
a theoretical PSF (left) versus a 
measured PSF (right) for the 
same confocal setup.

2.http://www.svi.nl/HalfIntensityWidth
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insufficient signal for accurate averaging, resulting also in reduced accuracy. Beads rang-
ing from 120 to 250 nm can be used. Typically beads with a diameter of 160 nm perform 
very well for many types of microscopy.

Confocal and two photon bead images of 60 nm beads should look like smooth fuzzy 
blobs with a relatively low level of noise. Use the default SNR settings. If possible, it is 
recommended to average 2 to 5 beads. Two photon bead images may look slightly noisy. 
If so, set the SNR to 20 and average 4 to 10 beads.

Widefield images taken from 160 nm beads should look like smooth fuzzy blobs with no 
visible noise. The default SNR settings can be used. It is not necessary to average any 
more beads.

Beads should be recorded with the same microscopic parameters that you will use later 
to image your specimens. Please find more practical information about beads for PSF 
measurements on the SVI Wiki3.

The PSF Distiller 
Window

If your license includes the PSF Distiller option, select DECONVOLUTION→PSF DISTILLER 
to start the Distiller. In the opening window (Figure 6.2) different panes show the input 
beads field, the Help field, the report field, the wizard fields and the PSFs & Accus field:

• The Input beads pane
Shows the selected file with the bead images for the PSF distiller process. You can 
import and use multiple files with beads for the distillation of a PSF. With the cursor 
you can hover over the thumbnail and with a right mouse click you can roll down a 
menu to open the image in one of the slicers. The edit parameters function is greyed 
out here, you can only modify the microscopic parameters in the main microscopic 
parameter window or the PSF wizard.

• The Help pane
Explains the different steps and displays links to relevant wiki pages.

3.http://www.svi.nl/RecordingBeads

FIGURE 6.2. The PSF Distiller window. Different panes show the input beads 
field, the Help field, the report field, the wizard fields and the PSF and Accus 
field.
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The Processing Stages in the Wizard
• The Distiller status pane
Keeps track of all the steps during the distiller run and reports the progress.

• The Reports pane
Displays the progress report of the distiller process and the status of the distilling 
process.

• The PSFs & Accus pane
Displays the intermediate results of the distilling process. The thumbnails can be 
inspected with the Sliders. The slider on the right side can be used to scroll down if 
many files are displayed.

• The Wizard pane
Shows the steps that will take you from checking image parameters to distilling and 
averaging the beads from your images.

The Processing 
Stages in the Wizard

The following steps and stages are to be followed:

• Loading an image.
• Start Stage: here the possibility exists to load a microscopic parameter template and 

check the microscopic parameters.
• Averaging Stage: in this stage (all channels of) the image are searched for beads that 

meet the selection criteria. After each successful or unsuccessful search there is the 
possibility to load in additional bead images, or go to the next stage.

• Distillation Stage: in this stage the PSF is measured from the averaged beads, for all 
available channels.

• Finalizing the result: in case it is desired to combine results from earlier distillations 
with the current result to obtain a multi channel PSF, an earlier result can be added 
here. It is also possible to add single or multi channel previous results to a current 
multi channel result.

• Save the result.

The next sections of this chapter will explain the wizard stages in detail. See “Loading an 
Image” on page 30 and “Saving the Result” on page 42 for more information on handling 
image files.

Starting the Distiller
After launching Huygens Professional, open the first bead image via FILE→OPEN. If the 
license includes the PSF Distiller option, start the PSF Distiller via the menu DECONVO-
LUTION -> PSF DISTILLER. When the window is opened, one or more accumulator images 
will be created into which later on the averaged beads will be kept. Now the start stage 
will be entered.

Verifying Microscopic Parameters
See “Verifying Microscopy Parameters” on page 31 for more information on the micro-
scopic parameters. Next to the optical parameters listed in Table 5.1 on page 31, it is in 
particular important to check the sampling densities.

Do not use undersampled bead images. If any of the entry fields for the sampling density 
turns orange or red, the data is unusable for distilling PSF’s.
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If there are multiple bead images, then the parameters of bead images loaded at a later 
stage should match the ones to establish in this stage; a warning of any mismatch will be 
given.

Averaging Stage After setting the bead diameter and estimating the Signal to Noise Ratio (SNR), the image 
is searched for beads that meet the following selection criteria:

• A bead should not be too close to another bead. If a bead is too close to another bead, 
their signals will interfere. In widefield bead images this is quite problematic due to 
the large size of the blur cone. Fortunately, widefield PSF’s can be derived from a sin-
gle bead within an image. 

• A bead should not be too close to an image edge. After all, another bead might be 
located just over the image edge. 

• The intensity of a bead should not deviate too much from the median intensity of all 
beads. If it is brighter then it may be a cluster of two or more beads. If it is dimmer 
then it is not likely to be a bead. In both cases the object geometry is unknown so 
they are unusable. 

If for some reason no usable beads are found, an explanation and some advice will be 
displayed in a pop up window. First, the software will try to find beads with ideal selec-
tion criteria. If this does not yield a single bead, it will automatically retry with reduced 
inter-bead distance criteria.

After having added the last bead recording press DISTILL to enter the distillation stage 
(See Figure 6.3).

Confocal and Two Photon Bead Images
Images from 160 nm beads should look like smooth fuzzy blobs with hardly visible 
noise. Use the default SNR settings. If available, it is a good idea to average 2 to 5 beads. 
Two photon bead images may look slightly noisy. If so, set the SNR to 20 and average 4 to 
10 beads. To load more bead images press LOAD ANOTHER BEAD in the averaging stage 
and either select an image from the main window or open a new one.

FIGURE 6.3. The averaging stage in the PSF Distiller wizard.
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Distillation Stage
Widefield Bead Images
Images from 160 nm beads should look like smooth fuzzy blobs with no visible noise. 
Use the default SNR settings. Averaging beads is not necessary for widefield images.

Distillation Stage The distillation stage usually requires no user intervention, though in some cases a pop 
up window will be displayed with a question or a warning. All channels will be processed 
automatically.

Finalizing the result At this stage, a previously obtained PSF image can be added as a channel before or after 
the current result. Press ADD CHANNELS if this is desirable. The Distiller will compare the 
microscopic image parameters of the selected PSF image and check its content. In case 
there are differences, the software will ask to decide between ignoring these and discard-
ing the selected file. Press DONE, if you are finished adding channels to the distilled PSF.

Full-width at half-
maximum estimator

This stage also offers the possibilty to measure the quality of the PSF using the PSF full-
width at half-maximum (FWHM) Estimator tool. If you have the PSF distiller option in 
your license, you can also find this tool in the task bar menu of Professional under 
ANALYSIS.

The PSF FWHM Estimator creates a line intensity profile through the center of the PSF 
in all dimensions, and measures the X value of the peak maximum and the width of each 
peak at approximately half of the maximum value using a curve fitting procedure. Curve 
fitters such as Gaussian, Lorentzian, Voight and Pearson, are available for this. This is 
done for all channels. For further background information on the FWHM4, PSFs and the 
PSF Distiller5, please refer to the SVI Wiki.

4.http://www.svi.nl/HalfIntensityWidth

5.http://www.svi.nl/PsfDistiller

FIGURE 6.4. The PSF-FWHM overview. No curve fitting was selected.
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Finally, press EXPORT & CLOSE. This will export the distilled PSF to the main window, 
where the result can be saved or used immediately in a subsequent deconvolution run.
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The Batch Processor Window
CHAPTER 7 The Batch Processor

Once you are familiar with a particular kind of dataset and the restoration parameters 
are determined, more similar datasets can be restored automatically. This is called batch 
processing.

A batch process consists of a number of image restoration tasks (one per image), which 
are executed one by one until all are finished. Depending on the multi-threading capabil-
ities of the computer, multiple tasks can be executed in parallel.

For example, batch scripts can be programmed with Huygens Scripting, which makes it 
possible to run scripts written in Tcl, using the extensive set of Tcl-Huygens image pro-
cessing commands.

Batch processes can also be configured easily with the interactive Huygens Batch Proces-
sor. The Batch Processor is the tool to do large scale deconvolution of multiple images 
within Huygens Professional.

The Batch Processor 
Window

To launch the Batch Processor first open Huygens Professional, then click on the menu 
DECONVOLUTION→BATCH PROCESSOR.

The main Batch Processor window an be separated into five different elements from the 
top to the bottom. It shows initially no tasks (see Figure 7.1 on page 50) . The elements 
are:

• Save Location. This is the directory where the resulting images will be placed during 
the batch run. With the two folder buttons a location can be respectively selected or a 
new location can be created in the currently selected folder. 

• The Tasks area shows a list of tasks (empty at start). Tasks are jobs that will be pro-
cessed by the Batch Processor one by one. Each task line consists of an image, a 
microscopic template and a deconvolution template. These templates can be updated 
after a task line is added to the list to tune the values in each particular case. In the 
Usage section this is explained in more detail.

• The button bar has a clock at the left side to delay the beginning of the processing, 
and buttons at the right side to delete, duplicate, stop, start, and add tasks to the list 
(one by one or many at the same time).
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• The Processing overview in the detailed information is given about the whole pro-
cess in its different stages.

• The status bar at the bottom-end of the batch processor window supplies some status 
information about Huygens Professional. The leftmost tab shows the state of Huy-
gens Professional, and the tab to the right of it shows information of the batch sched-
uler. The rightmost of these tabs gives information about the button the mouse is 
currently pointing at (now empty).

Usage Before starting a batch processing job, the save location of the results should be defined 
(Save location field) and a file format should be selected in which the results should be 
stored (OPTIONS→OUTPUT FORMAT).

Selecting Input Files
The Batch Processor has a wizard to guide in creating new tasks with only a few clicks. 
By clicking the green ADD TASK button below the task field a new menu entitled Selected 
images is expanded at the right (see Figure 7.2).

Either a complete folder containing images can be selected or folders can be browsed to 
select a single file. If a file is selected containing multiple sub-images (for example a 
Leica LIF file), a secondary menu will pop up to select which sub-image to deconvolve. 
Each selected sub-image will be added as a new task in the queue. Upon checking the 
Auto load series box (on), the Batch processor will try to interpret each listed file as a 
start of a file series. 

If the box is unchecked (off), only the listed files will be deconvolved. If a complete file 
series is selected and you'd like to deconvolve that series as one image, you can click Fil-
ter series to prune all members of a file series except the first from the list. 

FIGURE 7.1. The Batch Processor main window.
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Usage
If you select an entire folder containing one or more file series and the Auto load series 
box is checked (on), only the first file in a series will be listed. Leave Auto load series to 
unchecked (off) if you do not want this; you can always prune the list with Filter series.

After selecting the images to restore, the NEXT button ( ) can be clicked to select or cre-
ate a microscopic template.

Microscopic Templates: Describing the Images
To guarantee the quality of the deconvolution, 
it is very important that the image acquisition 
conditions are properly described. Luckily, the 
parameters that the Huygens algorithms need 
are just a few.

The microscopic parameters can be edited and 
saved to a template so that they can be reused 
in the future. In addition to editing the micro-
scopic parameters, Huygens also offers the 
possibility to deconvolve the image with the 
microscopic parameters stored in the image 

metadata. Because different manufacturers save the microscopic data with different con-
fidence levels1 the Batch Processor allows you to choose whether only reliable metadata 
should be taken into account for the deconvolution (see Figure 7.3).

It is therefore important to understand what the different microscopic parameters refer 
to and know how to establish them. A typically conflictive one is the backprojected pin-
hole radius. This parameter is not difficult to calculate2, especially with the assistance of 
the online backprojected pinhole calculator3.

1.http://www.svi.nl/ConfidenceLevels

FIGURE 7.2. The Batch Processor with the Selected images field expanded.

FIGURE 7.3. The Batch Processor 
metadata selector.
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As mentioned above, the entered parameters can be stored in templates for convenience’s 
sake, so the same template can be applied to a series of images acquired with the same 
settings.

Click the NEXT button ( ) again when finished with the microscopic template.

Deconvolution Templates: Configuring the Restoration Process
Like the microscopic parameters, the deconvolution parameters can be saved in a tem-
plate. Again, it is important that it is understood what the role of these parameters is (see 
“The Deconvolution Stage” on page 38 and the Restoration Parameters article4). 

At this stage, you can load one of the existing deconvolution templates from the list or 
create a NEW TEMPLATE. If you select NEW TEMPLATE, the first tab allows you to LOAD a 
previously made template or SAVE a new template.

You can adjust the settings for your deconvolution procedure and select the deconvolu-
tion ALGORITHM you like to apply. Here, you can also choose to use a Theoretical PSF or 
to load and use an Experimental PSF. 

With the Pre and Post taps, you will be able to select Autocrop, perform Stabilize along z 
for 3D images, Pre-adjust baseline and correct the z-drift with time series images. Fur-
thermore, Chromatic Aberration correction is possible by loading a pre-made template 
(see “Working with templates” on page 117).

Once all settings are done, click the Done button at the bottom of the screen. You can 
also have a look at our detailed Batch Processor Tutorial on our support wiki5.

A typically conflictive point is setting the signal-to-noise ratio. Mind that this is not a 
number describing the image, but something that can be tuned to achieve different 
deconvolution results. Please see “The Deconvolution Stage” on page 38 and the Set the 
Signal to Noise Ratio article in the SVI Wiki6.

Location of the Saved Templates
The microscopic and deconvolution templates are by default saved in the SVI/Tem-
plates folder in the user’s home directory7. The next time the Batch Processor is used, 
the saved templates will be found in the wizard to set up the batch task.

There are some sample templates in a global location, where the system administrator 
can also store templates for everybody to use. This global location is a subdirectory 
Templates of the Huygens installation directory (See Table 2.1 on page 7).

2.http://www.svi.nl/BackProjectedPinholeRadius

3.http://www.svi.nl/BackprojectedPinholeCalculator

4.http://www.svi.nl/RestorationParameters

5.http://www.svi.nl/BatchProcessor

6.http://www.svi.nl/SetTheSignalToNoiseRatio

7. The user home directories are usually located in C:\Users on Microsoft Windows Vista, 
Windows 7, and Windows 8 (64 bit). On Mac OS X Mountain Lion, Mavericks, Yosemite (X11, 
XQuartz) they are usually in /Users, and on Linux in /home.
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Menus
Adding the Task
After selecting the deconvolution template the DONE button appears. By clicking it the 
task is created and shown in the Tasks field. The task can be deactivated by clicking the 
READY TO RUN button in the status column, setting the status to DEACTIVATED. Marked 
tasks can be deleted by clicking the DELETE button ( ) or selecting EDIT→DELETE TASK 
from the menu.

New tasks can still be added to the queue before starting the computations, or start com-
puting right away and add new tasks afterward.

Duplicating Tasks
The DUPLICATE TASKS button ( ) is very convenient to prepare series of tasks for the 
same image. Just push the button and the copy of the selected line will be ready for mod-
ification. For example, it might be required to vary one deconvolution parameter to find 
the optimal value. 

Running the Batch Job 
When the batch process is configured, its configuration can be saved for future reference 
by selecting FILE→SAVE in the menu.

Add as many tasks as required, single files of complete folders, the Huygens Batch Pro-
cessor will run them all. By pushing the start button ( ) the Batch Processor will start 
and go over the task list.

The progress of the Batch Processor and the report for each individual task are shown on 
the tabs in the Processing overview area. The status of each task in the task list changes 
accordingly to the progress of the process. 

The restored and deconvolved images are saved in the selected destination directory as 
soon as they are ready, along with the image history and an independent task description 
that can be loaded later in the Batch Processor to re-execute it.

If the computations are very demanding for the system and should not block other activ-
ities, the beginning of the queue processing can be delayed by using the timer ( ). Just 
adjust the delay in days (zero for today) and set the time of the day when the processing 
should start. The timer checkbox is then selected automatically; deselect it to disable the 
timer.

Exiting the Batch Processor
If the Batch Processor is closed while running tasks, it will stop all running tasks. The 
Batch Processor window can be scrolled down while running tasks. Just exit the Batch 
Processor after all the jobs have been finished. 

Menus The FILE menu can be used to save the tasks list for future reference. In this menu also 
the information reported during the batch processing can be saved.

The EDIT menu can be used to duplicate or delete tasks in the list.

The OPTIONS menu has three sub menus:
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• OUTPUT FORMAT: this sub-menu shows several options for the file format to select for 
saving the restoration result. 

• THREADS PER TASK: this sub-menu allows to set the number of processors per job. 
Typically, in a run where tasks are processed sequentially, the computational work 
will still be distributed over the available processors, depending on license limita-
tions. 
The number of threads Huygens can use in parallel is by default set to AUTO, but in 
cases where it is required to restrict the computing resources, set a different value as 
threads.

• CONCURRENT TASKS: if the system has multiple processors it can be chosen to run 
multiple jobs at the same time. However, it is not necessarily true that concurrent 
execution of tasks is faster than sequential execution, because in the former case mul-
tiple tasks will compete for the available memory (deconvolution demands a lot of 
memory). If the available memory is insufficient, a slowdown will occur.
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Introduction
CHAPTER 8 Huygens STED Deconvolution

Introduction Stimulated-Emission Depletion (STED) microscopy is a fluorescence microscopy tech-
nique which overcomes and improves the diffraction-limited resolution of regular con-
focal microscopy techniques up to 4-5 times1, leading to the so-called sub-diffraction 
resolution or super resolution in the lateral and, in case of STED 3D, also the axial direc-
tion .

The Huygens STED optical option offers support for deconvolving STED images, yield-
ing stunning results in XY and in Z. Several other Huygens Professional tools offer an 
additional STED mode for STED-specific image processing. For example, the PSF dis-
tiller (see Chapter 6 on page 43) can generate Point Spread Functions and can estimate 
the STED microscopic parameters out of STED bead images, and the Object Stabilizer 
(see Chapter 21 on page 119) is equipped with a special STED stabilization mode. The 
Deconvolution Wizard (see Chapter 5 on page 29) and Batch Processor (see 
Chapter 7 on page 49) can automatically stabilize STED raw images, which often con-
tain drifts along the z direction.

This chapter describes the STED parameters and the restoration procedure to achieve 
optimal results with STED images. A short introduction to the STED principle is also 
included. A step-by-step summary of the restoration process for STED images is listed at 
the end of the chapter.

STED principle The STED microscope overcomes the diffraction-limited resolution of the conventional 
fluorescence and confocal microscopes, by exploiting a strong non-linear effect in the 
depletion of excited fluorophores. In the STED microscope two laser beams are focussed 
on the same location. The first laser beam excites the fluorophore molecules located in 
the imaged volume, in the same way as the confocal microscope. The second laser, also 
referred to as depletion beam or STED beam, goes through a shape changing phase filter 
resulting in a doughnut-shaped focus. In the outer ring of this focus, where the intensity 
is high, excited fluorophore molecules are forced out of the excited state. This depletion 
effect is very non-linear, so that in effect above a certain intensity depletion rises quickly. 

1. “Two-photon excitation STED microscopy”. Gael Moneron and Stefan W.Hell. Optics Express 
17 ; 17 (2009).
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This results in a narrow region around the optical axis being hardly depleted, whereas 
beyond this region depletion increases steeply. The diameter of the depletion-free region 
can be as small as 25-50m, easily resulting in a four fold increase in resolution over good 
quality confocal resolution.

STED parameters To achieve optimum results with the Huygens STED deconvolution it is recommended 
to verify the microscopic parameters of the STED image. 

If the image metadata contains information about the STED parameters Huygens Pro-
fessional will incorporate them into the image. Otherwise, parameter defaults will be 
loaded instead. Therefore, it is advisable to review the parameter values of the STED 
datasets.

To edit the microscopic parameters of an image right-click on the image and select 
“PARAMETER EDITOR” or “PARAMETER WIZARD”, as explained in Chapter 5 on page 29. If 
“PARAMETER EDITOR” has been selected, the specific STED parameters will be presented 
as in Figure 8.1:

• STED depletion mode: this mode determines the type of STED depletion that is being used. 
You can set this to Pulsed, CW (continuous wave) non-gated detection, or CW gated detection.

• STED saturation factor: this parameter describes how much the fluorescence is suppressed by 
the STED beam. The higher this factor the more fluorescence suppression off the optical axis, 
the more resolution. At values below 1, hardly any resolution is gained. Typical values are in 
the range of 10 to 501. A very large value of the saturation factor usually also implies a large 
resolution improvement. Because this parameter can be difficult to quantify it is recom-
mended to use the Huygens PSF distiller (see below) to get an automatic estimation. Also, 
please notice that in practice the fluorescence is never completely suppressed in the whole 
depletion region as the fluorophore molecules can be partly ‘immune’ to depletion.

• STED wavelength: the wavelength of the STED depletion laser beam (nm). The STED wave-
length must be a value within the range of the fluorophore emission spectrum. 

1. “Resolution scaling in STED microscopy”. Harke B, Keller J, Ullal CK, Westphal V, Schönle A, 
Hell SW. Optics Express 16 ; 6 (2008).

FIGURE 8.1. The specific STED parameters can be entered in the 
Parameter Editor.
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Example settings
• STED immunity fraction: the fraction of fluorophore molecules not susceptible, ‘immune’, to 
the depletion beam. This parameter is specified as a percentage; 100% meaning that all the flu-
orophore molecules are immune to the depletion beam, 0% meaning that no fluorophore mol-
ecules are immune to the depletion beam. The value that should be entered here is usually 
between 0% and 10%. Because this parameter can be difficult to quantify it is advised to use 
the Huygens PSF distiller (see below) to get an automatic estimation.

• STED 3X: the percentage of power used in the Z depletion beam. The remaining power is used 
for the vortex beam path. This value is read from the image metadata 

• Deviating microscope type: this parameter can only be edited when working with multichan-
nel images. The parameter entry is hidden for single-channel images. If not all channels are 
STED, this parameter should be set to the other microscope type used for that channel.

The STED saturation factor can in principle be determined experimentally, see the foot-
note on page 56. An alternative is to use the Huygens PSF distiller which can estimate 
these parameters automatically from a suitable bead image. 

Example settings In Table 8.1 you find the (ranges of) normal values for the STED microscopic parameters 
for some STED systems.

* measured on 40nm beads; ** not determined yet

Estimating STED 
parameters

Estimating the STED parameters is an automated process guided by the PSF distiller. 
Open an image of  STED beads in the PSF distiller and proceed to distill a PSF as 
explained in Chapter 6 “The PSF Distiller” on page 43.

The PSF distiller will recognize that the image has been recorded with a STED micro-
scope and will offer the possibility to estimate the STED parameters after distilling the 
PSF (see Figure 8.2).

The possibility to generate a theoretical PSF with the estimated STED parameters is 
offered in the PSF distiller. This can be of interest to compare the distilled PSF with the 
theoretical PSF.

Figure 8.3 shows the PSF distiller after estimating the STED parameters of a beads 
image. In this example, the estimated STED saturation factor is 6 and the (very high) 
immunity factor of 29%.

TABLE 8.1. 

Parameter Microscope types
TCS STED TCS STED CW/TCS SP8 STED (3X)

pulsed STED STED CW gSTED STED 3X
specified resolution (FWHM)* 70 80 50 n.d.**
typical resolution (FWHM) 60 70 40 n.d.**
excitation fill factor 0.5-1.0 (0.8) 1.2 1.2 1.2
STED saturation factor < 60 (40) < 40 (25) < 40 (25) < 40 (25)
STED wavelength (nm) 750-780 592 592 592/660/775
STED immunity fraction <25% (10) <25% (10) <10% (5) <10% (5)
Imaging direction downward downward downward downward
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Estimated STED parameters will be attached to the new distilled PSF, which will be 
shown as a thumbnail in the main window of Huygens Professional. The parameters are 
reported by the PSF distiller (see Figure 8.3) and can be reviewed by, for example, open-
ing the Parameter Editor by right-clicking on the PSF thumbnail (see Figure 8.4).

The microscopic parameters of the PSF can be exported as a template file within the 
Parameter Wizard or the Parameter Editor (see Figure 8.4). The microscopic parameter 
template file can, later-onwards, be applied to other STED images that have been 
recorded under the exact same conditions. This makes future parameter editing much 
easier and reliable.

FIGURE 8.2. Estimating the STED microscopic parameters of a beads image 
automatically with the Huygens PSF distiller.

FIGURE 8.3. The PSF distiller showing the STED microscopic parameters 
automatically estimated from a beads image.
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STED Deconvolution
STED 
Deconvolution

To deconvolve a STED image, open first the Parameter Editor or Parameter Wizard. 
Verify the microscopic parameters or load the microscopic parameter template file that 
was saved earlier. The latter option will import the PSF microscopic parameters to the 
STED raw dataset. Both the PSF and the raw image will now have the same estimates of 
the STED parameters. Next, open the data set in the Deconvolution Wizard (select the 
image → DECONVOLUTION → DECONVOLUTION WIZARD). Select the PSF at the first stage 
of the Deconvolution Wizard. If no PSF is provided, the Deconvolution Wizard will cre-
ate a theoretical PSF from the microscopic parameters of the image.

Continue to the next Wizard stage and proceed step by step as explained in Chapter 5 
“Deconvolution Wizard” on page 29. The Deconvolution Wizard will recognize a STED 
dataset and can offer a stabilization option because STED image acquisition is often sub-
jective to drift. The severity of drift in STED image data depends on how much of the 
STED power is used for vortex and for Z depletion. Stabilization is recommended for 
pure vortex-based STED images. With increased Z depletion in STED 3X data, drift will 
be more difficult to estimate but also less of an issue with respect to image quality. Huy-
gens automatically decides whether the option to stabilize the image is needed, by taking 
the aspect ratio of the STED PSF into account. 

To stabilize the image in the Deconvolution Wizard just click on the “AUTO STABILIZE” 
button at the “STABILIZATION” stage (See Figure 8.5). If Huygens applies stabilization a 
remark will be shown in the REPORT window. Note that the same level of stabilization 
will also be applied to the confocal channel, if present.  

The stabilization stage can be skipped at the Deconvolution Wizard if the image has 
already been stabilized by the Huygens Object Stabilizer (See Chapter 21 on page 119.) 

After this stage, complete the remaining Deconvolution Wizard stages as usual.

FIGURE 8.4. The Microscopic Parameters of the distilled PSF now contain the 
values automatically estimated by Huygens Professional.
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Summary: 
deconvolution 
procedure

The STED deconvolution procedure can be summed up in the following steps:

• Load a STED beads image.
• Distill a PSF from the beads image with the PSF distiller. Allow it to estimate the 

STED parameters automatically.
• Export the microscopic parameters of the new PSF to a template file (via Parameter 

Editor or Parameter Wizard).
• Load the STED raw dataset.
• Import the PSF microscopic parameters template file to the STED raw data (via 

Parameter Editor or Parameter Wizard).
• Open the raw dataset in the Deconvolution Wizard.
• Specify the PSF image in the Deconvolution Wizard and continue to the subsequent 

Wizard steps.
• At the “Stabilization” stage select “Auto Stabilize” if the STED raw data has not yet 

been stabilized.
• Complete the remaining stages of the Deconvolution Wizard as for any other image.

FIGURE 8.5. Stabilization stage for STED data in the Deconvolution 
Wizard.
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Color
CHAPTER 9 The Slicer

The Slicer (see Figure 3.2 on page 13) allows you to quickly inspect an image. Even mul-
tiple Slicer windows can be opened simultaneously for comparing several images (e.g. a 
deconvolution result with the original) and/or multiple orientations of the same image.

To start the Slicer, select VISUALIZATION→SLICER from the menu in the main window, or 
double click the image's thumbnail. You can open as many Slicers as you like, on the 
same image or on different images, and multiple Slicers can be linked and `listen' to 
other Slicer windows.

The Slicer enables the user to show a single 2D plane extracted from a 3D volume. There 
are controls to select any plane orientation in space, zoom, and scroll through the avail-
able planes. For time series, a separate control is available to scroll through the available 
time frames. Pixel intensity values for the cursor position on the image are displayed in 
the `Voxel data' panel. You can move the image by clicking the middle mouse button and 
keeping it pressed while moving the image to the desired position.

Color For each channel, one out of five color schemes can be chosen:

• Grey
Pixel values are assigned different shades of grey ranging from black for the lowest 
values to white for the highest values.

• Emission
The displayed color of a channel matches the true color of the emission wavelength in 
so far this is possible.

• False
Pixels values are assigned different colors ranging from black/dark purple for the 
lowest values to bright red for the highest value.

• Global
In a multi-channel image, colors can be assigned to the different channels by using 
the ‘global color palette’.

• Custom
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A custom color can be chosen for each of the channels. As with RGB, pixel values are 
assigned different shades of a particular color ranging from black for the lowest val-
ues to the brightest possible shade for the highest values.

Contrast For the complete view, three basic gamma contrast settings can be chosen:

• Linear
In this mode the pixel values are mapped to screen buffer color intensities in a linear 
fashion. Note that the actual translation of the screen buffer values to the actual 
brightness of a screen pixel is usually quite non-linear, for which the following 
gamma contrast settings are offered.

• Compress
When an image contains a few very bright spots and some larger darker structures, 
using the Linear mode will result in poor visibility of the darker structures. Resto-
ration of such images is likely to further increase the dynamic range resulting in the 
large structures becoming even dimmer. In such cases use, the compress display 
mode to increase the contrast of the low valued regions and reduce the contrast of the 
high-valued regions. Another way to improve the visibility of dark structures is the 
usage of false colors, as mentioned before.

• Strong compression
Same as above, with stronger effect.

• Widefield
In restoring widefield images it sometimes happens that blur removal is not perfect, 
for instance when one is forced to use a theoretical point spread function in sub opti-
mal optical conditions. In such cases the visibility of blur remnants can be effectively 
suppressed.

• Strong Widefield
Same as above, with stronger effect.

Time Slices of a time series can be selected by entering a frame number or using the slider.

Linking When you open two ore more Slicers on the same image, then the Slicers are automati-
cally linked. This means the position and orientation of both views are linked by default. 
A right-click on one of the images will change the center in the other Slicers.

Besides centering and orientation, the `Time', `Zoom', and `Twist' and `Tilt' sliders can 
be linked by setting the appropriate option in the `Linking' panel.

If you would like to link the Slicers of two different images, e.g. a deconvolved image and 
its original, select `Other' in order to let the current Slicer listen to other Slicers.
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CHAPTER 10 The Twin Slicer

The Twin Slicer allows to synchronize views of two images, measure distances, plot line 
profiles, etc. In basic mode, which is also available without a license, image comparison is 
intuitive and easy, while the advanced mode gives the user the freedom to rotate the cut-
ting plane to any arbitrary orientation, link (synchronize) or unlink viewing parameters 
between the two images, and more.

To launch the Huygens Twin Slicer, select an image and select 
VISUALIZATION→TWIN SLICER from the main menu. To view another image in an existing 
slicer, click the image name in the drop-down menu above the left or right view port (See 
Figure 10.1).

FIGURE 10.1. The twin slicer in basic mode, showing an original and 
deconvolved image side-by-side.
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The View Menu
Use the VIEW menu to show or hide image properties and guides. These are listed in 
Table 10.1:

Panning
Click and hold the middle mouse button on the slice to move it around. If the middle 
mouse button is missing, click and hold the left mouse button while holding the Ctrl 
button. Clicking the center button ( ) or pressing the ‘c’ key centers the slice.

Slicing
Drag the slider below the view ports to move the cutting plane back and forth. This can 
also be achieved using the buttons adjacent to the slider (  and ), the up/down arrow 
keys on the keyboard, or by placing the mouse pointer over the slider and using the 
scroll wheel. The play button ( ) moves the cutting plane through the data volume. The 
pointer coordinates can be displayed through the VIEW menu. Note that it is possible to 
move the cutting plane out of the volume. Pressing the center button ( ) or pressing the 
‘c’ key centers the plane again.

Using the Slicer in 
Basic Mode

The button centered at the top of the window enables switching between basic and 
advanced mode. In basic mode, all controls are visible in the panels below the view ports 
(See Figure 10.1). In contrast to the advanced mode, which allows independent control 
of the left and right slicer (See “Using the Slicer in Advanced Mode” on page 66), the 
basic mode shows a single set of controls that apply to both slicers. 

TABLE 10.1. The options in the Twin Slicer’s VIEW menu.

Option Description
POINTER COORDINATES Display the position of the mouse pointer in μm or in voxel 

coordinates.
TIME Display the time for the current slice in seconds or frame num-

bers.
INTENSITY VALUES Display the intensity values for all channels on the current 

pointer location.
ZOOM Display the zoom value in screen-pixels per micron. A magnifi-

cation factor is displayed as well; using the pixel density for the 
monitor, this value gives an estimation for the absolute magnifi-
cation.

ROTATION ANGLES Display the tilt and twist angles in degrees.
DROP SHADOWS Enhance the contrast for the overlayed lines and text by show-

ing drop shadows.
SLICE BOUNDARIES Draws the slice boundaries for the left image in the right one 

and vice versa. This is helpful when both slicers are used.
WIREFRAME BOX Show or hide the wireframe box, which gives visual feedback on 

the position and orientation of the cutting plane (green), and 
the displayed slice (gray) in the data volume (red).

SCALE BAR show or hide the scale bar.
SVI LOGO Show or hide the SVI logo in the lower right of the view port.
RESET TO DEFAULT Sets all viewing settings to default. 
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Using the Slicer in Basic Mode
Changing Time Frames
Drag the slider in the lower Time frame panel to change the time frame or press the play 
button ( ) to animate the time series. The time frame can be displayed through the 
VIEW menu.

Orientation
Make a selection in the most left Orientation panel to change the plane used to display 
the image.

Zooming
Click the buttons in the Zoom panel or use the scroll wheel to zoom in or out on the loca-
tion of the mouse pointer.

Changing Display Colors
Click an option in the Color panel to select a color scheme:

• Greyscale: the image is displayed in gray tints. For single-channel images, this gives a 
higher contrast than the emission or global colors.

• Emission colors: if the emission wavelengths are set correctly, this gives the most intu-
itive view.

• Global colors: the colors as defined in the global color scheme. The global color 
scheme applies to all visualization tools and can be modified via the Huygens Profes-
sional main menu: .

• False colors: a false color is given to each intensity value. This view gives a high con-
trast and makes it easy to spot areas of homogeneous intensity.

Tuning the Brightness and Contrast
The brightness can be adjusted in the most right Brightness panel using the buttons (  
and ), dragging the slider, or putting the mouse pointer over the slider and using the 
scroll wheel. The Gamma panel provides a linear and some nonlinear ways of mapping 
data values to pixel intensities. These are:

• Linear (default): pixel values are mapped to screen buffer color intensities in a linear 
fashion. Note that the actual translation of the screen buffer values to the actual 
brightness of a screen pixel is usually quite nonlinear.

• Compress or Strong compression: where an image contains a few very bright spots and 
some larger darker structures using linear mode will result in poor visibility of the 
darker structures. Restoration of such images is likely to further increase the dynamic 
range resulting in the large structures becoming even dimmer. In such cases use the 
compress display mode to increase the contrast of the low valued regions and reduce 
the contrast of the high-valued regions. Another way to improve the visibility of dark 
structures is the usage of false colors (See “Changing Display Colors” on page 65).

• Widefield or Strong widefield: in restoring widefield images it sometimes happens that 
blur removal is not perfect, for instance when one is forced to use a theoretical point 
spread function in sub optimal optical conditions. In such cases the visibility of blur 
remnants can be effectively suppressed.
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Automatic Panning, Slicing and Zooming
When the right mouse button is clicked, the Twin Slicer shows a context menu. The 
option “ZOOM IN ON BRIGHTEST SPOT” will automatically center and zoom in on the 
brightest spot in a 3D neighborhood around the cursor.

Using the Slicer in 
Advanced Mode

The button centered at the top of the window offers switching between basic and 
advanced mode. The advanced mode allows independent control of the left and right 
slicer. All controls are available in twofold and accessible through the tabs at the bottom 
of the window.

Changing Time Frames
Drag the slider in the Time frame tab to change the time frame or press the play button 
( ) to animate the time series. The time frame can be displayed through the VIEW 
menu.

Zooming
Use the scroll wheel to zoom in or out on the location of the mouse pointer, or access the 
Zoom tab. The four buttons in this tab respectively zoom out ( ), zoom in ( ), zoom 1:1 
( ) (the x-sample distance matches 1 pixel), and view all ( ).

Setting the animation speed.
Both the time slider and the slice sliders below each view port have a play mode to ani-
mate the slicing. With the slider between the slicers one can control the speed of this ani-
mation. For slow animation, move the slider towards the snail ( ). This will add delays 
between the rendering of the scenes. When the slider is set all the way to the humming-
bird icon ( ) there is no delay between the renderings and the limitation of the visual-
ization is simply how fast your computer can render the scenes. When decreasing the 
sizes of the view port, the rendering can go even faster, since small scenes are rendered 
more quickly than large scenes.

Rotation
The three radio buttons in the Orientation tab can be used to switch between axial (xy), 
frontal (xz), and transverse (yz) orientations. The Twist slider rotates the cutting plane 
around a z-axis, while the Tilt button rotates the cutting plane around an axis in the xy 
plane. The tilt and twist angles can be displayed through the VIEW menu. Note that the 
wireframe box in the bottom left of each view port gives visual feedback about the posi-
tion and orientation of the slice.

Changing Display Colors
Click the Channels & Colors tab key to view the color settings panel. The Active channels 
buttons (or drop down menu, if the image contains more than ten channels) can be used 
to enable or disable channels. The buttons colors correspond to the channel colors.

In addition to the color schemes that are available in basic mode (“Changing Display Col-
ors” on page 65), the advanced mode allows the use of custom colors. Use the color picker 
( ) to manually select a color for each channel.
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Using the Slicer in Advanced Mode
Tuning the Brightness and Contrast
The brightness and contrast controls are accessible in the Contrast panel. The brightness 
can be changed per channel, or for all channels at once (master). The Gamma drop down 
menu provides a linear and some non-linear ways of mapping data values to pixel inten-
sities (See “Tuning the Brightness and Contrast” on page 65 for an overview).

If the Link box is checked, the way of mapping data values to pixel intensities is the same 
for all channels; if not, the range is automatically adjusted according to the minimum 
and maximum intensity in each channel.

The contrast stretch can be either set globally (the complete dataset will be taken into 
account), or for each screen view.

Linking, View & Plot

In the Linking, View & Plot panel are the most used options which you can also find in 
the menus. In one view you can easily see and set the links, view - and plot properties. 
More options are available in the menus. For more information about the linking 
options, see the Linking Controls below.

Shortcut Information
In the Shortcut Info panel all the available shortcuts are listed which are explained in the 
previous section. If your mouse or laptop lacks a middle mouse button, one can use the 
left mouse button while holding the Ctrl key to simulate the middle mouse button 
press.

Animate
The Animate tab allows you to set the frame rate in frames per second making it possible 
to create animations through time or through the z-stack.

Linking Controls
The LINKING menu can be used to change the way in which both slicers communicate. 
The options in this menu are listed in Table 10.2. Note that settings get synchronized 
once the controls are being used.

TABLE 10.2. The options in the Twin Slicer’s LINKING menu (accessible in advanced 
mode). 

Option Description
POINTER LOCATION Shows the position of the mouse pointer in the other slicer.
SLICE POSITION Makes sure that the cutting plane for the right slicer crosses the 

center of the left slice, and vice versa.
TIME FRAME Synchronize the time.
ZOOM LEVEL Synchronize the level of magnification.
PANNING This does not affect position of the cutting plane, but it shifts the 

right slice such that the projection of the center of the left slice is 
in the center of the right slice, and vice versa.

ROTATION Makes sure that the rotation angles for both cutting planes are the 
same.
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Some useful ways of linking the controls are:

• Comparison mode: to configure the Huygens Twin Slicer to compare two images, e.g. 
original and deconvolved, it is best to link all orientation parameters, i.e., slice posi-
tion, time frame, zoom level, panning and rotation. This ensures that the same piece 
of data is displayed for comparison.

• Orthogonal mode: to view a part of an image in two orthogonal directions, for 
instance axial (xy) and frontal (xz), do the following:
· Select the same image for both the left and right slicer.
· Go to LINKING and link the slice position, time frame, zoom level, and panning. 

Unlink the rotation.
· Select the Orientation tab at the bottom of the window and select the xz and xy 

orientation.
Now it is possible to zoom, pan, and slice while the centers of the left and right slice 
are always aligned. Note that when the cutting planes are not the same, the projected 
mouse pointer will show a distance (in μm) beside it. If this number is positive, it 
means that real pointer is more towards the observer (in front of the screen).

• Overview mode: An easy overview mode can be configured as follows:
· Select the same image for both the left and right slicer.
· Go to LINKING (either the menu, or the panel Linking, View & Plot) and link the 

slice position, time frame, and rotation. Unlink the zoom level and panning.
· Drag the sash to the left to make the left slicer a bit smaller.
· Select the Zoom tab at the bottom and click the view all button ( ).
Now the right slicer can be used to zoom in on the data, while the left slicer shows the 
position in the image (See Figure 10.2).

ACTIVE CHANNELS The left and right slicer will have the same channels enabled and 
disabled.

COLOR SCHEME Makes sure that the left and right slicer use the same colors 
scheme.

CUSTOM COLORS Use the same custom color scheme for both slicers.
BRIGHTNESS Synchronize the brightness.
GAMMA Synchronize the gamma setting.

TABLE 10.2. The options in the Twin Slicer’s LINKING menu (accessible in advanced 
mode). 

Option Description
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Measurement
Measurement Markers
Double click in one of the images or right click and select SET MARKER to place a marker 
at the position of the mouse pointer. As configured in the VIEW menu, the marker shows 
the coordinates and intensity values beside it. To remove the marker, click it and press 
the Delete key.

Rulers
To overlay a ruler on the image, hold the left mouse button and drag. The length of the 
line in μm is displayed beside it. Press and hold the  Shift key while creating a new 
ruler and the ruler will be parallel to one of the axis, depending on your mouse motion.

Click and drag the end points of the ruler to make adjustments. Press and hold the 
Shift key while dragging an end point to change length without changing direction. 
Click and drag the middle of the ruler to move it in its entirety, without changing length 
or direction. Press and hold the Shift key while dragging the ruler to move it perpen-
dicular to its direction. To remove the ruler, click it and press the Delete key.

Intensity Profiles
When a ruler in the left slicer is selected, the right slicer will be replaced by a plot win-
dow and vice versa. The intensity profiles for both the left and right image in the same 
plot are shown. Unselect PLOT→PLOT BOTH SLICERS from the menu to only show the plot 
for one image. The graphs for the left slicer will have solid lines, while the graphs for the 

FIGURE 10.2. The Twin Slicer in advanced mode, with all controls but 
zoom and panning linked.
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right one are dashed (See Figure 10.3). See the online SVI Wiki1 for more information on 
the data plotter. 

1.http://www.svi.nl/DataPlotter

FIGURE 10.3. Measuring the intensity profile along a line. The plot can be 
configured such that it shows the profile of both images (left solid, right 
dashed).
70 Huygens Professional User Guide for version 15.05



CHAPTER 11 The Orthogonal Slicer

The Huygens Orthogonal Slicer tool is shown in Figure 11.1. It displays the image that is 
selected from the main window. The Ortho Slicer is designed to show the same point in 
3D space from three orthogonal directions;

• axial or xy (top left);
• frontal or xz (bottom left);
• transverse or yz (bottom right).

Each view is enclosed by a colored frame whose color indicates to which slices in the 
other views it corresponds. 

FIGURE 11.1. The Huygens Orthogonal Slicer.
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If you move one of the slices, the others will follow to make sure that the center of each of 
the slices intersects in the same point in space. This behavior makes the Ortho Slicer a 
useful tool to study small objects in 3D. 

The histogram (top right) shows the number of pixels in the complete image plotted 
against the intensity value. More information on the orthoslicer can be found on the 
wiki1.

The Crosshair 
Cursor

The position of your mouse is projected as a cross-hairs pointer on all views. The value 
besides the center of the cross-hairs gives the distance of the mouse position to this pro-
jection. If this number is positive, it means that the real pointer is more towards you (in 
front of your screen). If you click with your left mouse button on a position in one of the 
views, the slide-borders (indicated with colored lines) will be centered to that specific 
position.

Visualization 
parameters

Changing the visualization parameters in the Orthogonal Slicer is similar to the Huygens 
Twin Slicer (on page 63). There are tools to;

• change time frames
• zoom in, out, fit or zoom 1:1
• change display colors
• tune the brightness and contrast
• change the projection mode.

Panning can be achieved by clicking and dragging the middle mouse button. To center 
the slice, use the menu than can be activated by placing the cursor on the view and click-
ing the right mouse buttons or by pressing 'c'.

Measurements To overlay a ruler on the image, hold the left mouse button and drag. The length of the 
line in microns is displayed beside it. Left-click and drag the end points of the ruler to 
make adjustments. Note that the other orthogonal directions show a projection of this 
ruler. Press and hold Ctrl while dragging an end point to change length without chang-
ing direction. Left-click and drag the middle of the ruler to move it in its entirety, with-
out changing length or direction. Press and hold the Ctrl key while dragging the ruler 
to move it perpendicular to its direction. To remove the ruler, left-click somewhere else 
on the image.

If a ruler is drawn, the histogram panel will be replaced by a plot that shows the intensity 
profile along it. See the SVI wiki for more information about the data plotter's capabili-
ties.2

1.http://www.svi.nl/OrthoSlicer

2.http://support.svi.nl/DataPlotter
72 Huygens Professional User Guide for version 15.05



Auto-Zoom
Auto-Zoom When you click the right mouse button, several options appear. The first can be used to 
automatically center and zoom in on the brightest spot in a 3D neighborhood around the 
mouse pointer.

Display Options The VIEW menu allows you to show or hide information and guides within the image 
overlay, including pointer coordinates, time, intensity, zoom, rotation, graphics and the 
wireframe.

The “Global value range” option in the PLOT menu uses the maximum and minimum 
value of the image(s) to determine the visible range of the plot, otherwise it uses the 
maximum and minimum values of the plot data.
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Basic Usage
CHAPTER 12 The MIP Renderer

The Maximum Intensity Projection (MIP) Renderer enables the possibility to obtain an 
orthogonal projection of 3D data from any given viewpoint.

The MIP renderer projects the image voxels 
on the screen by tracing near-parallel rays 
from a viewpoint far away through the data 
volume. Along each ray the maximum inten-
sity encountered is taken for the rendered 
image (See Figure 12.1). Notice that this 
implies that two MIP renderings from oppo-
site viewpoints show symmetrical images.

To start the MIP Renderer, right-click on a 
thumbnail and select VIEW→MIP RENDERER 
from the pop-up menu, or choose 
VISUALIZATION→MIP RENDERER from the 
main menu.

Basic Usage Orientation and Zoom
Adjust the viewpoint by moving the Tilt and Twist sliders (See Figure 12.2), or by click-
ing and dragging the mouse pointer across the scene. The magnification can be adjusted 
by using the Zoom slider or the scroll wheel. Use the center mouse button to pan the cen-
ter of the projection.

Notice that the scene is rendered with low quality while being edited, which allows for 
fast scene edition. The scene is automatically rendered with good quality when the edi-
tion is finished and the scene released. This automatic rendering can be deactivated by 
pressing the SWITCH OFF rendering button ( ). However, when either the FAST MODE 
render button ( ) or the HIGH QUALITY render button ( ) are pressed the automatic 
rendering occurs again upon releasing the MIP scene.

4

view point

projection plane

data volume9
FIGURE 12.1. A schematic overview 
of MIP rendering. The maximum 
intensities on rays parallel to the 
screen are projected.
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Threshold
The Soft threshold slider in the Channel parameters panel at the right affects the thresh-
old level. The application of a threshold is a preprocessing step that reduces the back-
ground in the image, i.e. voxels with intensity values below the threshold value become 
transparent. Contrary to a standard threshold, which is ‘all or nothing’ (values above the 
threshold are kept, values below it are deleted), the soft threshold function handles 
images in a different way. It makes a smooth transition between the original an the 
deleted value.

Saving Scenes
Choose FILE→SAVE SCENE... to save the rendered scene as a Tiff file.

FIGURE 12.2. The MIP Renderer window.
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Advanced Usage
Advanced Usage Render Parameters

Table 12.1 gives an overview of the render parameters available in the MIP renderer.

Render Options
Table 12.2 gives an overview of the render options available through the OPTIONS menu.

Templates
All scene settings, i.e. both the render options and all parameters, can be exported to a 
template file via FILE→SAVE SCENE TEMPLATE. The template files have the extension 
.hgsv and can be applied to any image that is loaded in the MIP Renderer.

TABLE 12.1. MIP render parameters.

Option Description
ANIMATION FRAME COUNT Set the number of frames that will be rendered in a movie. 

180 frames with a frame rate of 24 fps result in a movie with 
a duration of 7.5 seconds.

ANIMATION FRAME RATE Adjust the frame rate; a rate of 24 frames per second is fine 
for smooth movies.

RENDER SIZE Adjust the size of the rendered image. When the render size 
exceeds the display area, then use the right mouse button to 
pick up and move the rendered image.

RENDER QUALITY Set the default quality (FAST or HIGH QUALITY). This setting 
will be used for rendering animations.

COLOR MODE Choose between GREY, EMISSION COLORS, GLOBAL PALETTE 
(See “Adjusting the Global Color Scheme” on page 195), 
FALSE COLOR, or CUSTOM COLOR.

BOUNDING BOX Enable or disable the bounding box, or adjust the line color.
SCALE BAR Enable or disable the scale bar, adjust the scale bar length 

and the line color.
SOFT THRESHOLD MODE Adjust the smoothness of the soft threshold (See “Thresh-

old” on page 76).
TIME FRAME A selection of the time frame for time series.
CENTER SCENE Undo both the panning of the rendered image (middle 

mouse button) and of the scene canvas (right mouse but-
ton).

TABLE 12.2. Render options for the MIP Renderer.

Option Description
RENDER SIZE Adjust the size of the rendered image. When the render size 

exceeds the display area, then use the right mouse button to 
pick up and move the scene canvas.

COLOR MODE Choose between GREY, EMISSION COLORS, GLOBAL PALETTE 
(See “Adjusting the Global Color Scheme” on page 195) or 
FALSE COLOR.

SHOW SVI LOGO Hide or show the SVI logo at the bottom right.
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Simple Animations The Huygens Movie Maker (See “The Movie Maker” on page 91.) allows you to create 
sophisticated animations using the MIP, SFP, and Surface Renderer.

Without the Movie Maker the MIP Renderer has the option to make simple animations 
of the image, changing the view point in different movie frames. Set the render parame-
ters for the first frame and click MOVIE tab, SET →FIRST SCENE. Now adjust the view-
point for the final frame, and click SET→LAST SCENE. Set also the frame count, frame 
rate, and other general options such as colors. Finally press the animate button ( ), and 
select a directory to save the AVI movie or the TIFF frames to.

The exported AVI files use the MJPEG1 codec and can be loaded in most movie players, 
including Windows Movie Player and Apple Quicktime. The TIFF frames are useful to 
combine multiple animations or edit the movie in e.g. Windows Movie Maker.

1.http://en.wikipedia.org/wiki/Mjpeg
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CHAPTER 13 The SFP Renderer

The SFP Renderer generates realistic 3D scenes, based on the 3D microscopy image, 
which is taken as a distribution of fluorescent material. The computational work is done 
by the Simulated Fluorescence Process (SFP) algorithm1, simulating what happens if the 
material is excited and how the subsequently emitted light travels to the observer (See 
Figure 13.1).

The properties of this algorithm allow to render the object at different depths, unveiling 
layers under the object's surface. The SFP algorithm is not limited by boundaries or 
sharp gradients and is exclusively suited to render 3D microscopic data sets. Since the 
SFP algorithm is based on ray-tracing techniques it does not require a special graphic 
card.

To start the SFP Renderer, right-click on a thumbnail and select VIEW→SFP RENDERER 
from the pop-up menu, or choose VISUALIZATION→SFP RENDERER from the main menu.

1.http://www.svi.nl/SFP

FIGURE 13.1. In the SFP renderer excitation and subsequent emission of light of 
fluorescent materials is simulated. Each subsequent voxel in the light beam is 
affected by shadowing from its predecessors. The transparency of the object for 
the emission light controls to what extent the viewer can peer inside the object.
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Basic Usage Orientation and Zoom
Adjust the viewpoint by moving the Tilt and Twist sliders (See Figure 13.2) or by clicking 

and dragging the mouse pointer across the scene. The magnification can be adjusted by 
using the Zoom slider or the scroll wheel.

Render quality

The SFP renderer can render the image with three different levels of quality: 

• Low Quality.  This level is used when the scene is being moved or edited in any other 
way (zoomed in and out, adjusted with new parameter values, etc). This quality level 
is also used after editing the image if the Fast Mode and High Quality levels are 
switched off.

• Fast Mode. This quality level improves the scene greatly with respect to the Low 
Quality level. The Fast Mode level is used automatically when the renderer detects 
that the user stopped editing the scene (rotating, zooming, adjusting parameter val-
ues, etc) provided that  the FAST MODE render button ( ) is activated.

• High Quality. This mode can deliver even better quality than the Fast Mode although 
it can take more time to render the scene. The High Quality level is used automati-
cally when the renderer detects that the user stopped editing the scene (moving, 
zooming, adapting parameters) provided that the HIGH QUALITY render button ( ) 
is activated.

Notice that the scene is rendered with low quality while being edited to allow for fast 
scene edition. The scene is automatically rendered with good quality (Fast Mode or High 
Quality) when the edition is finished and the scene released. This automatic rendering 
can be deactivated by pressing the SWITCH OFF rendering button ( ). When either the 
FAST MODE render button ( ) or the HIGH QUALITY render button ( ) are pressed the 
automatic rendering occurs again upon releasing the SFP scene.

FIGURE 13.2. The SFP Renderer window.
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Advanced Usage
When using poorly sampled images the FAST MODE and HIGH QUALITY modes allow for 
more limited zooming than the low quality mode. In that case a subtle zoom jump might 
be noticeable when switching between the low quality and the better quality modes.

Threshold
The Soft threshold slider in the Channel parameters panel at the right affects the thresh-
old level. The application of a threshold is a preprocessing step that reduces the back-
ground in the image, i.e. voxels with intensity values below the threshold value become 
transparent. Contrary to a standard threshold, which is ‘all or nothing’ (values above the 
threshold are kept, values below it are deleted), the soft threshold function handles 
images in a different way. It makes a smooth transition between the original an the 
deleted value.

Penetration depth
The characteristic object size can be set by the Penetration depth slider in the Image 
parameters panel at the right side. This parameter affects both the excitation and the 
emission transparency. While traveling through the object, the light intensity is attenu-
ated to some degree. This enables us to define some definition for penetration depth at 
which the light intensity is decreased to some extent, for instance 10 % of its initial value. 
This penetration depth should be in line with the object size. A transparent object is 
small with respect to the penetration depth. Thus for the same physical properties of the 
light one object can be transparent while the other is opaque due to its size. To find a rea-
sonable range in transparencies the Penetration depth may be altered. The initial object 
size is computed from the microscopic sampling sizes and number of pixels the image is 
composed of. If the microscopic sampling sizes of the image are incorrect, then the Pene-
tration depth is set according to some default parameters.

Saving Scenes
Choose FILE→SAVE SCENE... to save the rendered scene as a Tiff file.

Advanced Usage SFP Fundamentals
The voxel values in the image are taken as the density of a fluorescent material. In case of 
a multi channel image, each channel is handled as a different fluorescent dye. Each dye 
has its specific excitation and emission wavelength with corresponding distinct absorp-
tion properties. The absorption properties can be controlled by the user (See the trans-
parencies in Table 13.1 on page 82). The different emission wavelengths give each dye its 
specific color.

To excite the fluorescent matter light must traverse other matter. The resulting attenua-
tion of the excitation light will cause objects, which are hidden from the light source by 
other objects, to be weakly illuminated, if at all. The attenuation of the excitation light 
will be visible as shadows on other objects. To optimally use the depth perception cues 
generated by these shadows, a flat table below the data volume is placed on which the 
cast shadows become clearly visible. In Figure 13.2 the table is rendered as a mirror.

After excitation the fluorescent matter will emit light at a longer wavelength. Since this 
emitted light has a differentwavelength it is not capable to re-excite the same fluorescent 
matter: multiple scattering does not occur. Thus only the light emitted in the direction of 
the viewer, either directly or by way of the semi reflecting table is of importance. By sim-
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ulating the propagation of the emitted light through the matter, the algorithm computes 
the final intensities of all wavelengths (the spectrum) of the light reaching the viewpoint.

The properties of the interaction between object and light (transparency), both for exci-
tation and emission, can be adapted interactively by the user to produce different scener-
ies.

Render Parameters
Table 13.1 gives an overview of all render parameters in the SFP Renderer.

TABLE 13.1. SFP render parameters

Parameter Description
Time frame A selection of the time frame for time series.
Penetration depth Adjust the total transparency of the rendered object. See “Penetra-

tion depth” on page 81.
Excitation Adjust the excitation transparency for the matter in the selected 

channel.
Emission Adjust the emission transparency for the matter in the selected 

channel.
Object brightness Set the intensity level for the excitation light source for the selected 

channel.
Soft threshold Adjust the threshold level for the selected channel. See “Threshold” 

on page 81.
Color mode Adjust the color of the selected channel.
Background color Adjust the color of the scene background.
Compute shadow Choose whether or not the object’s shadow should be included in 

the scene.
Table Choose whether or not the table underneath the object should be 

included in the scene.
Table distance Adjust the distance between the object and the table.
Table reflection Adjust the degree of reflection of the table.
Table size Adjust the size of the underlying table.
Table color Adjust the color of the table
First scene Set the viewpoint of the first scene of the movie.
Last scene Set the viewpoint of the last scene of the movie.
Set number of 
movie frames

Set the number of frames that will be included in the movie. 

Set movie frame 
rate

Set the number of frames per second of the movie.

Light direction Set the position of the light source.
Light intensity Set the intensity of the light source.
Render size Set the size (in pixels) of the SFP scene.
Render mode Set whether the scene must be rendered in fast mode, in high qual-

ity mode, rendered in a movie or not rendered. 
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Simple Animations
Render Options
Table 13.2 gives an overview of the different render options that are available through the 
OPTIONS menu.

Templates
All scene settings, i.e. both the render options and all parameters, can be exported to a 
template file via FILE→SAVE SCENE TEMPLATE. The template files have the extension 
.hgsv and can be applied to any image that is loaded in the SFP Renderer. Keep in 
mind that the sampling sizes of the data affect the transparency.

Simple Animations The Huygens Movie Maker (See “The Movie Maker” on page 91.) allows to easily create  
sophisticated animations using the MIP, SFP, and Surface Renderer.

Without the Movie Maker the SFP Renderer has the option to make simple animations 
of the image, changing the viewpoint in different frames. Set the render parameters for 
the first frame by clicking the MOVIE tab, SET →FIRST SCENE. Now adjust the view-
point for the final frame, and click SET→LAST SCENE. Set also the frame count, frame 
rate, and other general options such as colors and light properties. Finally press the ani-
mate button ( ), and select a directory to save the AVI movie to.

The exported AVI files use the MJPEG2 codec and can be loaded in most movie players, 
including Windows Movie Player and Apple Quicktime. 

TABLE 13.2. Render options for the SFP Renderer.

Option Description
SHOW SVI LOGO Show or hide the SVI logo at the bottom right of the scene.
VIRTUAL RENDER SIZE Adjust the size of the rendered image. When the render size 

exceeds the display area, then use the middle mouse button 
to drag and drop the rendered image.

COLOR MODE Choose between EMISSION COLORS or GLOBAL PALETTE 
(See “Adjusting the Global Color Scheme” on page 195.).

2. http://en.wikipedia.org/wiki/Mjpeg
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CHAPTER 14 The Surface Renderer

Huygens Surface Renderer is a powerful 3D visualization tool that enables the visualiza-
tion of iso-surfaces of volumes.

An iso-surface is a 3D surface representation of points with equal intensities in a 
3D stack; it is the 3D equivalent of a contour line. The iso-surface envelops voxels with 
intensities above a certain threshold. If those voxels are distributed in groups that are not 
spatially connected, they will be considered and labeled as independent objects.

The iso-surface is a smooth surface through all points 
between the voxel locations which have an interpolated 
value equal to the threshold value (see Figure 14.1).

Shading enhances the perception of 3D shapes and tex-
ture (See Figure 14.2). Besides iso-intensity surfaces, this 
renderer is able to generate MIP projections which are 
blended with the surfaces to be used as a reference to the 
original microscopic data (See Chapter 12 on page 75).

Because the Surface Renderer is based on fast ray tracing 
that runs efficiently on multi-core computers, there is no 
need for any special graphics card as would be necessary 
for conventional polygon based techniques.

To start the Surface Renderer, right-click on a thumbnail 
and select VIEW→SURFACE RENDERER from the pop-up 

12 0

6 6
FIGURE 14.1. A contour 
line for an interpolated 
value of 5. Because 5 is 
much closer to 6 than to 
12, the distance of the 
contour to the voxel 
with value 12 is larger 
than the distance to the 
bottom-right voxel with 
value 6.
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menu. Alternatively, choose the corresponding icon from the taskbar or select the 
VISUALIZATION→SURFACE RENDERER from the main menu. 

Basic Usage Orientation and Zoom
Within the Surface Renderer window, you can adjust the viewpoint by moving the Tilt 
and Twist sliders or by dragging the mouse pointer on the large view (See Figure 14.3). 
The magnification can be adjusted using the Zoom slider or by using the scroll wheel. 
Use the middle mouse button to pan the center of the projection.

6

view point

projection plane

light direction

9 data volume

surface normals
determine shading

FIGURE 14.2. A schematic overview of surface 
rendering. The orientation of the surface determines 
the shading.

FIGURE 14.3. The Surface Renderer window.
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Advanced Usage
Threshold
Use the Threshold slider in the Render pipes panel to apply different thresholds to the 
data channels. Voxels that are spatially connected and have intensities above this thresh-
old define closed volumes. These volumes are represented by the 3D (iso-intensity) sur-
faces containing them, each object having a different surface color.

The three render pipes, in the Object Segmentation frame, referred to as primary, second-
ary, and tertiary, allow us to define three threshold levels that can be applied to the same 
or to different data channels. The data channel can be selected using the menu button in 
the Object Segmentation panel. The color range in which the different objects inside a 
render pipe will be displayed can be adjusted with the hue selector next to it. To facilitate 
the segmentation of the objects, a watershedding can be applied. For more information 
see “Using the watershed segmentation” on page 139.

Saving Scenes
Press the HIGH QUALITY button in Actions panel to apply full scene anti aliasing to the 
rendering and choose FILE→SAVE SCENE... to save the rendered scene as a Tiff file.

Advanced Usage Adding a Maximum Intensity Projection
Besides the surface pipes there are additional rendering pipes to redirect data to the 
scene. The MIP pipe works by projecting the voxels with maximum intensity laying in 
the path of the rays traced along the viewing direction (See Chapter 12 on page 75). 
When the MIP pipe is used in combination with the surface pipes, a clearer representa-
tion can be obtained of the different objects in the image. In other words, the MIP of a 
channel can used as a spatial reference for the objects present in other channels.

Adding a Slice
The Slicer pipe is available to represent a single slice of the 3D dataset in its correspond-
ing location.

Render Parameters
Table 14.1 gives an overview of all render parameters in the Surface Renderer.

TABLE 14.1. Surface render parameters

Parameter Description
Frame Set the time frame (in case of a time series).
Threshold (surface) Adjust the threshold level for the selected pipe, i.e. the intensity for 

which the iso-intensity surfaces are defined. See “Threshold” on 
page 87

Threshold (MIP) Set the soft threshold level for the MIP pipe. See “Threshold” on 
page 76

Garbage volume Volumes that contain less voxels than defined by the garbage volume 
parameter will not be rendered. This is useful for rendering only sig-
nificant objects in noisy images.

Transparency Set the level of transparency to other pipes.
Brightness Adjust the brightness for the selected pipe.
Slice Z-position Set the position of the slice in the Slicer pipe.
Huygens Professional User Guide for version 15.05 87



Render Options
Table 14.2 gives an overview of the different render options that are available through the 
OPTIONS menu. The ANIMATION FRAME COUNT, ANIMATION FRAME RATE and RENDER 
QUALITY apply to the rendering of simple movies as explained in the next section.    

Templates
All scene settings, i.e. both the render options and the parameters, can be exported to a 
template file via FILE→SAVE SCENE TEMPLATE. The template files have the extension 
.hgsv and they can be applied to any image that is loaded in the Surface Renderer.

Simple Animations The Surface Renderer has the option to make simple animations of the image. When 
selecting the movie-tab, one can set the render parameters for the first scene and click 
the FIRST SCENE button in the Position settings panel of  the Set view settings. Now adjust 
the viewpoint for the last scene, and click the LAST SCENE button of the Set view settings. 
Also the frame count, frame rate, or other render options in the OPTIONS menu can be 
adjusted.

If you want to view or adjust the first or last scene, press the corresponding button next 
to Show. This will show you the stored scenes. You can adjust these settings and again 
store the scenes via the Set view buttons.

Finally press the Animate button in the Actions pane, and select a directory for storing 
the AVI movie or the Tiff frames.

TABLE 14.2. Render options for the Surface Renderer.

Option Description
ANIMATION FRAME COUNT Set the number of frames that will be rendered in a movie. 

180 frames with a frame rate of 24 fps result in a movie with 
a duration of 7.5 seconds.

ANIMATION FRAME RATE Adjust the frame rate; a rate of 24 frames per second is fine 
for smooth movies.

VIRTUAL RENDER SIZE Adjust the size of the rendered image. When the render size 
exceeds the display area, then use the middle mouse button 
to pick up and move the rendered image.

TRANSPARENCY DEPTH This option defines how different surfaces are seen through 
the others:
Simple: see through one surface, the surface closest to the 
viewer. Quite often this is sufficient.
Normal: see through two surfaces.
Deep: consider many more screening levels, making the 
final rendering computationally more complex.

BOUNDING BOX Enable or disable the bounding box, or adjust the line color.
SCALE BAR Enable or disable the scale bar.
SHOW SVI LOGO Hide or show the SVI logo at the bottom right.
High quality MIP Render the MIP pipe in high quality mode.
CENTER SCENE Undo both the panning of the projection center (right 

mouse button) and the rendered image itself (middle mouse 
button).
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Simple Animations
The exported AVI files use the MJPEG1 codec and can be played in most movie players, 
including Windows Movie Player and Apple Quicktime. Tiff frames are useful to com-
bine multiple animations or edit the movie in e.g. Windows Movie Maker.

For more sophisticated movie making options, and for creating animations using combi-
nations of MIP, SFP, and Surface rendered images, we like to refer you to the Huygens 
Movie Maker (See “The Movie Maker” on page 91.)

1. http://en.wikipedia.org/wiki/Mjpeg
Huygens Professional User Guide for version 15.05 89



90 Huygens Professional User Guide for version 15.05



An Overview
CHAPTER 15 The Movie Maker 

The Movie Maker is a tool that allows the user to easily create sophisticated animations 
of multi-channel 3D images using the powerful Huygens visualization tools. Animations 
from the MIP Renderer (See Chapter 12 on page 75), the SFP Renderer (See Chapter 13 
on page 79), and the Surface Renderer (See Chapter 14 on page 85) can be combined in a 
single movie.

The Movie Maker assists the user in creating the key frames that define the main scenes, 
and transitions between them. Interactive manipulation of the scenes is possible in the e 
Timeline or by using the interfaces of the renderers.

The movies can be exported to AVI files or to TIFF series that can be combined with 
other software. Movie projects can be saved for later editing or for usage with other 
3D datasets.

An introductory tutorial can be found in the HELP menu at the top right. This interactive 
tutorial guides the user step by step through the process of creating a simple movie.

An Overview Figure 15.1 shows the Movie Maker's user interface. The numbered areas are:

1. The Storyboard: this filmstrip shows the main elements of the movie, which are the 
keyframes and the transitions between them.

2. The Preview area: this mini movie player quickly creates a low-resolution version of 
the movie.

3. The Timeline: this interactive plot shows how render parameters change over time. 
Use the menu-button below this timeline to the render parameter to be visualized. 
Green nodes, representing render parameters at each keyframe, can be dragged verti-
cally.
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Creating and 
Adjusting Keyframes 

About Keyframes
A keyframe defines a control point within a transition. This can be either a start point, 
end point, or an intermediate point in time. The appearance of the 3D rendered image is 
fixed in these frames. In between keyframes, the Huygens Movie Maker calculates a 
smooth or linear transition (a technique called tweening).

Inserting New Keyframes
To add the first keyframe to the storyboard, one of the renderers should be launched 
from the Movie Maker window by pressing the corresponding button ( , , or ). 
Within the renderer, a scene can be defined using the available controls; see Chapter 12, 
Chapter 13, and Chapter 14 for more information. If the view of the first frame is satis-
factory, press the Add keyframe button ( ) to capture this configuration and to add the 
keyframe to the storyboard. All render parameters are captured and most of them can be 
smoothly animated.

A movie needs at least two keyframes from the same renderer to set the start and end 
point of a transition. If the second frame view is satisfactory, press the Add keyframe but-
ton ( ) again. The storyboard will now show two keyframes with an arrow in between. 
This arrow indicates the transition from one keyframe to another.

FIGURE 15.1. An overview of the Movie Maker user interface, 
showing the Storyboard (1), the Preview (2), and the Timeline. (3).
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Using the Storyboard
The Huygens Movie Maker 
accepts a mix of keyframes 
from different renderers, but 
transitions can only be made 
between keyframes from the 
same renderer, as shown in 
Figure 15.2.

Editing Keyframes
To edit an existing keyframe, 
double click it or select the frame and choose EDIT→EDIT KEYFRAME from the menu. 
This will load the keyframe's settings in the corresponding renderer. The renderer's con-
trols can now be used to adjust the 3D scene. To submit the changes to the Movie Maker, 
press the Add keyframe button ( ) again. Because the original keyframe is still selected, 
the Movie Maker will ask if the original frame should be replaced.

Using the 
Storyboard

Rearranging Keyframes
The storyboard allows the user to copy, delete, and rearrange keyframes. The Cut ( ), 
Copy ( ), Delete ( ), and Edit ( ) buttons are activated whenever a keyframe is 
selected. If there is no keyframe selected, the Paste button ( ) will append the copied or 
cut keyframe to the last frame in the storyboard. If one of the keyframes is selected, the 
Movie Maker will ask where the frame should be inserted. All these operations can be 
undone with the Undo button ( ).

Changing Transitions
Transitions can be changed by double clicking the arrow 
that joins two keyframes. This will pop-up a window in 
which the duration of transition (in frames or seconds) 
can be changed, as well as the transition type of the 
parameters that will be animated (See Figure 15.3). For 
most parameters, the Huygens Movie Maker uses linear 
or smooth transitions. An exception to this is the twist, 
which also requires a direction of rotation (clockwise or 
counter clockwise) and a value for the number of rota-
tions.

Playing a Preview Movie
To preview the movie, just press the play button ( ) in the 
Preview area (See Figure 15.4). The Movie Maker quickly 
creates a low-resolution movie and displays it in the pre-
view area. If loop mode ( ) is on, the movie will be 
repeated until the stop button ( ) is pressed.

To change the animation settings (aspect ratio, size, frame 
rate, etc.), press the render settings button ( ) in the Pre-
view area. The High quality setting and the AVI quality are 
not applied to the movie preview, but only to the final 
result.

FIGURE 15.2. The Movie Maker's storyboard 
showing two surface-renderered keyframes, 
followed by two MIP renderer keyframes.

FIGURE 15.3. The 
transition settings 
dialog is shown by 
double clicking a 
transition arrow in 
the storyboard.

FIGURE 15.4. The 
Preview area.
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Export to AVI or Tiff Series
Press the record button ( ) (See Figure 15.4) to 
render the final movie and to export it to AVI or 
a Tiff series. Before the save dialog appears, the 
Huygens Movie Maker will show the animation 
settings dialog (See Figure 15.5), where the AVI 
quality can be set. Note that large movies will 
take several minutes to render.

Once the movie has been exported to AVI, it can 
be opened in a movie player like Apple Quick-
Time or Windows Movie Player. To quickly 
open the last saved movie in the operating sys-
tem's default movie player, press the button 
labeled “Open AVI in external movie player” 
( ).

Working with Movie 
Projects

Saving Projects
A collection of keyframes, transitions, and animation settings is called a project. The 
image itself does not belong to the project. To save the current project, press the Save 
button ( ) or choose FILE→SAVE PROJECT in the menu. Movie Maker project files have 
the extension .hgsa (Huygens animation template).

When closing the Movie Maker window, you are asked to save the project if unsaved 
changes have been made.

Reloading and Appending Projects
If a saved project is reloaded in a Movie Maker that has the same image attached, then 
the final movie will an identical copy. It is also possible to apply saved projects to other 
images, or to the current storyboard. To load or append a project from disk, select 
FILE→OPEN PROJECT... or FILE→APPEND PROJECT... from the menu, respectively.

The Movie Maker has some example projects available under the menu PRESETS that can 
be used.

Using the Timeline Visual Feedback
The Timeline is an interactive plot which shows the frame number on the horizontal axis 
and the value of a selected render parameter on the vertical axis (See Figure 15.6). It 
gives a more detailed visual feedback on values of each of the animated parameters. A 
mouse click in the Timeline area will select the nearest frame and displays a preview of 
this frame in the Preview area. The left and right arrow keys can be used to navigate 
through the frames.

To zoom in on the timeline, click near the frame of interest and use the scroll-wheel or 
the magnifying glass buttons below the timeline.

FIGURE 15.5. The animation 
settings dialog.
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Advanced Topics
Changing Render Parameters
The keyframe nodes are displayed in green and can be dragged vertically to tune the 
value of the parameter. The (interpolated) transition frames are displayed as smaller red 
dots (See Figure 15.6). If a render parameter has been changed, the Movie Maker will 
recalculate the transitions, update the thumbnails in the storyboard, and update the still 
of this frame in the Preview area.

To select the render parameter to be shown in the graph, open the drop-down menu 
below the timeline. Because the number of parameters that can be animated is extensive, 
the menu only lists the ones that change during this movie. If “Other render parameter...” 
is selected, a dialog window will pop up that shows a list of all available parameters.

To change parameters in a frame which is not a keyframe, the frame first needs to be 
converted into a keyframe. To do this, select the frame in the timeline and choose 
EDIT→CONVERT TO KEYFRAME from the menu.

Advanced Topics Stretching Movie Length
The number of frames in a transition can be changed by double clicking the transition 
arrow. However, if a movie gets complex it is easier to use the stretch tool. This tool can 
be found in the menu TOOLS→STRETCH MOVIE.

The stretch tool shows the Frame rate, the Number of 
frames, and the Duration in seconds (See Figure 15.7). 
The two sliders can be used to change the frame rate 
and the number of frames; changing these will affect 
the duration of the movie. The stretch tool tries to 
redistribute the total number of frames over the com-
plete movie in such a way that the relative length of 
each transition does not change.

FIGURE 15.6. The Timeline area gives detailed visual feedback on the 
animated parameters.

FIGURE 15.7. The stretch 
dialog helps increasing or 
decreasing the number of 
frames in a complex 
movie.
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Synchronizing Transitions in Time and Slice Plane Transitions 
Most render parameters, like the 
Tilt, Twist, and Zoom, can be set to 
non-integer values. The Time frame 
(in case of a time series), and the 
Slicer z-position, however, are fixed 
to integer values. When the transi-
tion of such a parameter is not lin-
ear, or when the change in value 
does not match the number of 
frames, then this parameter is out of 
sync. In that case the Movie Maker 
will show a warning symbol ( ) on 
the transition arrow (See 
Figure 15.8). In the final result, 
these asynchronous transitions may 
show irregularities.

To restore the synchronization, 
right click on the transition arrow 
and choose 
SYNCHRONIZE TIME FRAMES... from 
the pop-up menu. The Movie 

Maker will set the transition type to linear and add or remove some frames from the 
transition to achieve a 1:1, 2:1, 1:2, etc. synchronization.

Creating Loopable and Bouncing Movies
In two simple steps, a movie can be made loopable, i.e. it can be played seamlessly in 
repeat mode:

1. Copy the first keyframe and paste it to the end.
2. Right-click on the final keyframe that has just been pasted, and click SKIP THIS FRAME 

in the pop-up menu.

The result is the best when all transitions are set to smooth.

To create a bouncing animation, i.e. an animation that is played in reverse when the last 
frame is reached, mark the bounce option in the animation settings dialog. Doing so will 
not insert extra keyframes on the storyboard, but the frames are appended in reverse to 
the final AVI file or Tiff series.

About Movie Quality
In the Huygens Movie Maker, two types of quality can be set:

1. The High quality check box determines if the quality of the renderers should be set to 
the highest possible setting when rendering the final movie.

2. The AVI quality scale bar determines the compression level of the AVI file. Set 
to 100 %, the quality is the best, but then the file size will be large.

These quality settings are not applied to the movie preview, but only to the final result.

FIGURE 15.8. A transition in which the time 
frame parameter is out of sync with the 
number of frames. In this example, the 
transition counts 27 frames, while the time 
frame parameter increases linearly from 0 
to 30. Note the irregular change of this 
parameter in the plot.
96 Huygens Professional User Guide for version 15.05



CHAPTER 16 The Gallery
The Gallery can be found under the menu VISUALIZATION and gives you a quick over-
view of your microscopic image. Instead of slicing through your image using a slider, the 
Gallery tool displays the individual slices of your z-stack or time series next to each other 
(See Figure 16.1). As a user, you can control which z-slices or time frames are displayed 

in the gallery. Display settings for the overview can be adjusted using the options listed 
under the CHANNELS & COLORS tab The LAYOUT tab offers the possibility to change the 
Layout and decoration of the overview. The overview can be exported as a tiff file via the 
FILE menu. Upon selecting a slice with the left mouse button, a detailed view appears in 
the window Detailed tile view. GAMMA, CONTRAST and ZOOM controls allow optimal and 
closer viewing of a selected slice in this window. For more details on the use of these con-
trols see “Using the Slicer in Advanced Mode” on page 66.

FIGURE 16.1. The Gallery tool showing the individual slices of a Z stack image.
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Stitching and Deconvolution
CHAPTER 17 The Stitcher

Stitching and 
Deconvolution

When imaging large objects at high resolution, the microscope field of view can become 
too small. This problem is typically solved by subdividing the region to be imaged into 
multiple smaller images (tiles), which after acquisition are combined to a larger over-
view. 

Improving such stitched images with deconvolution is a challenging task as extensive 
computer resources for allocating both raw and processed images are needed. The Huy-
gens Stitcher wizard offers a unique solution for this by combining high-quality stitching 
with deconvolution. This integrated approach offers the advantage of minimizing the 
resources needed for obtaining restored contrast-rich and high-resolution images of 
large objects. Furthermore, the post-acquisition work-flow is considerably simplified for 
the user. 

Vignetting and 
Shading correction

Individual building blocks (tiles) of a stitched mosaic often suffer from vignetting and 
shading because of uneven field illumination. Such distortions can be seen in individual 
tiles, but are more apparent when tiles are positioned next to each other (stitched). To 
correct for these artifacts, the Huygens Stitcher is equipped with an automatic vignett-
ing/shading correction. As an alternative, there is a “manual” vignetting and shading 
correction option for which flat-field and dark-frame image need to be loaded.

To summarize, the Huygens Stitcher is an easy-to-use wizard that allows for:

• optimal stitching of tiles.
• automatic vignetting and shading correction.
• integrated deconvolution.
• Stitching of 2D, 3D multichannel and time series images.
• Stitching of unlimited files sizes and numbers of tiles.

Starting the Stitcher The Stitcher wizard can be started in Huygens from the DECONVOLUTION menu. If Leica 
LIF or Zeiss CZI images with tiles, or a XML file with accompanying Tiff tiles are 
opened, the tile content will be automatically recognized and opened in the Stitcher wiz-
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ard. Click the MULTITILE IMAGE – OPEN button located at the top bar, and select the tiles 
that should be loaded into the Stitcher. This opens the window Select sub-images (See 
Figure 17.1). Use CTRL-click to select or de-select individual tiles, SHIFT-CLICK  to 
select a range, and CTRL+ A to selects all tiles. 

Selection of Tiles
The tiles’ initial positions are read from the metadata and shown in the Stitcher window 
(See Figure 17.2 ). To view the actual content of the tiles, click the TILES – SHOW CON-
TENTS button in the top menu of the Stitcher window. By default, all tiles of the mosaic 
are selected. Use the mouse left click plus the CTRL/SHIFT keys to select a specific region 
of tiles.

FIGURE 17.1. Selection of tiles 
contained in a dataset.

FIGURE 17.2. The Stitcher window showing the tiles’ initial positions. 
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Starting the Stitcher
Vignetting and shading correction

Continue and follow the instructions of the wizard to select whether automatic vignett-
ing correction must be applied, or if this should be manually done by loading a flat-field 
and a dark frame image. The user can choose between a circular and an ellipsoidal 
model for the vignetting. The steepness of the vignetting model at the tile edges can also 
be adjusted. An example of automatic vignetting/shading correction is shown in 
Figure 17.3.

Deconvolution of tiles

The Stitcher wizard offers the user the unique possibility to deconvolve each tile auto-
matically before stitching. Every single tile is first deconvolved before being stiched into 
the mosaic. By doing so, Huygens not only simplifies the work-flow but also minimizes 
the processing workload that would be needed for deconvolving a stitched mosaic image, 
or for stitching tiles that have increased in size because they have already been decon-
volved. To deconvolve the tiles before stitching, you just need to select a microscopic 
template and deconvolution template (See “Microscopic Template Files” on page 33., and 
See “The Final Stage” on page 40.). These templates should be created first before start-
ing the Stitcher wizard by using the Deconvolution Wizard (Chapter 5 on page 29) or the 
Batch Processor (Chapter 7 on page 49).

FIGURE 17.3. Huygens stitched tiles of widefield fluorescent Leica LIF data. 
The same data is shown in the Twin Slicer without (left panel) and with (right 
panel) Huygens automatic vignetting correction. Note that the overlapping 
regions are less apparent after vignetting correction. Image represents a 
developing mouse cortex (P30) stained for Tbr1, reelin and an unspecified  
molecule .
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What is crosstalk?
CHAPTER 18 The Crosstalk Corrector

The Crosstalk Corrector detects and corrects for (linear) crosstalk between all channels 
in multi-channel images.

What is crosstalk? In fluorescence microscopes, crosstalk (or bleedthrough) can occur when acquiring a 
multi-channel image. In that case, the emission radiation of a given emission wavelength 
is detected by the wrong detector because part of the photons go through the wrong opti-
cal path inside the microscope (e.g. because the filters efficiency is not 100%). Therefore, 
some signal is actually recorded as coming from a certain dye when it really comes from 
a different one.

To avoid this situation, microscopes usually excite each dye alternatively, making sure 
that all the detected radiation comes from a single dye type. But some experiments (like 
e.g. Fluorescence Resonance Energy Transfer - FRET) require simultaneous acquisition 
of signal from all the present dyes, with the possible risk of crosstalk. 

Crosstalk within multi-channel images dramatically affects almost any type of data anal-
ysis, including colocalization analysis.

In line with our aim to improve microscopic image quality and measurements, we have 
implemented a Crosstalk Corrector tool in Huygens Professional to correct for this 
imaging artifact.

Starting the 
Crosstalk Corrector

To start the Crosstalk Corrector in Huygens Professional, select an image and go to 
DECONVOLUTION > CROSSTALK CORRECTOR. This tool can handle multi-channel time 
serie images up to 32 channels.

The tool does not automatically estimate the crosstalk at startup. This is to avoid slow 
loading time, especially if the image contains many channels. The more channels there 
are in the image, the longer the estimation will take.
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The Crosstalk corrector shows a large 2D histogram in the left panel of the startup win-
dow, see Figure 18.1. This histogram is from the original raw data set and is useful for the 
detection and visualization of the crosstalk coefficients.

Assume, for example, that in a 2-channel 
image the first channel bleeds into the sec-
ond channel. Then at least a fraction of 
every signal (or intensity) in the first chan-
nel exists in the second channel. And so, 
for every signal in the first channel no 
intensity combination exists with low sig-
nal (smaller than a fraction of the first 
channel) in the second channel. This is 
visualized by an empty (except for some 
noise) triangular shape, from the origin 
along the axis of the first channel, see 
Figure 18.2. 

Note that the colors within the 2D histo-
gram have nothing to do with the colors 
used to represent the channels. The colors 
show the density or count of intensity 
combinations within the two channels.1

The slope of the diagonal of the triangle is 
the crosstalk coefficient of, in this case, 

1. Read more about 2D histograms at http://www.svi.nl/2Dhistogram

FIGURE 18.1. The startup window of the Crosstalk Corrector with a 
large 2D histogram of the original data (left) and a preview of the 2D 
histogram and MIP of the corrected data (right).

FIGURE 18.2. A 2D histogram, showing 
the intensity range of the first channel 
on the x-axis and the intensity of the 
second channel on the y-axis. The 
triangle shows that for every intensity 
in the first channel there is always a 
fraction of it in the second channel 
which is typical for crosstalk.
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Adjust the crosstalk coefficients
channel 0 in channel 1. For each crosstalk or bleedthrough in each channel there is a 
crosstalk coefficient. For a 2-channel image there are two crosstalk coefficients, for a 3-
channel images there are six, for a 4-channel image there are twelve.

In general, for an n-channel image there are n2- n crosstalk coefficients. These coeffi-
cients can be displayed in a matrix with element (i,j) the crosstalk coefficient of channel i 
in channel j. The elements (i,i) can be ignored, since comparing channels with itself will 
result in a crosstalk of 1.0. Note that the crosstalk coefficient matrix is not symmetric.

The crosstalk corrector can handle multi-channel images up to 32 channels, but the his-
togram can only show two channels at a time. That is why you can select two channels to 
visualize the 2D histogram, but the correction will take place on all the channels simulta-
neously. 

Next to the large 2D histogram, within the preview frame, the 2D histogram and MIP 
view of the corrected data are shown. This way you can quickly validate the crosstalk 
correction.

With the options at the bottom of the window you can adjust all of the available display 
settings: set the two channels for the histogram views, toggle between histogram view 
and matrix view, toggle between corrected and original data, change views between all 
channels (shown in grey) or only the selected channels (shown in their corresponding 
channel selector color) and to center the MIP preview. Use the mouse scroll to zoom the 
MIP preview.

With the ESTIMATE button you can estimate all the crosstalk coefficients. With the COR-
RECT button you apply the final crosstalk coefficient matrix to the image and the result 
will be shown in the main window of Huygens Professional.

Adjust the crosstalk 
coefficients

There are three ways to set the crosstalk between channels. The simplest is to press the 
ESTIMATE button and let the tool determine the crosstalk coefficients. If the estimation is 
not satisfactory the crosstalk coefficients can be adjusted manually.

The crosstalk coefficients can be manually adjusted by moving the handles within the 2D 
histogram, which are the small circles at the end of the crosstalk lines. When the handles 
are moved, the crosstalk line changes, and thus the crosstalk coefficient.

Click and drag on the middle of a crosstalk line, to move this line completely. This does 
not change the crosstalk coefficient, because the slope does not change. It is intended for 
verification only.

The crosstalk coefficient can also be adjusted directly by switching to matrix view and 
changing the element in the matrix which corresponds to the correct crosstalk coeffi-
cient. For example, if the crosstalk coefficient of channel 2 in channel 3 needs to be 
adjusted, edit element (2,3) (row, column) in the crosstalk coefficient matrix.
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Why correct for hot pixels?
CHAPTER 19 The Hot Pixel Remover

The Hot Pixel Remover can detect and correct for hot pixels automatically.

Why correct for hot 
pixels?

Hot pixels appear as bright pixels within your image. They do not originate from the 
specimen or noise, but are caused by individual sensors of the CCD camera with higher 
than normal rates of charge leakage. In fact, all pixels on a CCD detector have some 
charge leakage. This is why the amount of hot pixels will increase when you increase the 
exposure time. The charge leakage will even get worse at higher temperatures. Hot pixels 
are unwanted intensities which you can remove from the image, using the Hot Pixel 
Remover.

Removal of hot pixels is useful for three reasons:

• For deconvolution; hot pixels affect the deconvolution result, because they disturb 
the normal signal distribution in your image. Especially when those hot pixels are not 
due to strong noise, but caused by deficiencies of the camera.

• To avoid false colocalization; when hot pixels occur at the same position in each 
channel, this will affect the colocalization analysis.

• For visualization; hot pixels disturb the contrast range and could force the contrast of 
the image to be very low. This may result in that objects of interest with lower inten-
sity values become almost invisible.

Hot pixels may also be a product of deconvolution. If a very tiny object in your original 
image fits the PSF perfectly, deconvolution may result in one very bright spot in your 
image. This can disturb the contrast range and as such the visualization of the image. We 
have come across this situation a few times. So, if the image seems black after deconvolu-
tion, try to remove hot pixels first and see if this brings back the original contrast of the 
image.

Starting the Hot 
Pixel Remover

The Hot Pixel Remover can be started from the DECONVOLUTION menu in Huygens Pro-
fessional. .
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The window of the Hot Pixel Remover shows orthogonal views of the image. At the bot-
tom of the window there are several tabs with which you can change the visualization of 
the image and the hot pixels (see Figure 19.1):

• Time frame: opens a slider for changing the time frame 
• Zoom: simply zoom in or out by using the buttons or the mouse scroll.
• Channels: if you are only interested in specific channels, channels can be selected or 

deselected and the colors can be adjusted. By default, all channels are shown.
• Contrast: When the hot pixels show a large variety of intensities, it can be useful to 

increase the contrast.
• Projection: here you can switch between a single slice, Maximum Intensity Projection 

(MIP), or Sum projection.
• Hot pixel display settings: the hot pixels are visualized as an overlay over the original 

image. The image and overlay can be switched on or off  to verify whether the hot 
pixels are correct. Transparency and color of the hot pixels can be adjusted here.

Options Threshold
Threshold is used to filter hot pixels on a value calculated with an algorithm that takes 
the intensity and location of the neighboring pixels into account. A high threshold 
results in a lower count of hot pixels, and a low threshold in a higher count. At start-up 
the strength is always set to 50.

Repeating
If the hot pixels originate from an abnormal charge leakage or defect in the CCD, then 
these defects are most likely visible at the exact same xy-locations for each z-slice, time 
frame, and very likely also for each channel. If you know that the hot pixels are con-

FIGURE 19.1. The start-up window of the Hot Pixel Remover.
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Estimating and finalizing
served in a particular dimension, you can set these dimensions here. This extra informa-
tion is then used to detect hot pixels even better. False positives will most likely be 
eliminated if the information of other z-slices is taken into account. By default the in Z 
is turned on, because hot pixels are likely to be conserved in every slice of a 3D stack.

If you want to remove hot pixels which are a product of deconvolution, all the repeating 
options should be turned off. Because in that case, you are searching for a single hot pixel 
which is not conserved in any dimension.

Results
The results of the hot pixels are displayed in a plot as the hot pixel count per slice for a 
specific channel. You can switch between the channels. For time series images, the pixel 
count can be plotted per frame.

Viewing the result
You can zoom in the scene and change contrast and color settings to optimize the visual-
ization. Still, it may be difficult to find hot pixels. Then, it may be useful to right click on 
the image and use the option FIND CLOSEST HOT PIXEL, which will move the mouse to the 
closest detected hot pixel.

Estimating and 
finalizing

Estimating Threshold
The strength is set as default to 50. It is difficult to determine what the correct strength 
settings is that separates the real hot pixels from the false positives. To minimize false 
positives, you can press the ESTIMATE THRESHOLD button which will set the strength to 
an estimated position. To prevent centers of small bright objects to be included as hot 
pixels,  fine tuning with the plus and minus sign may be necessary. 

If the estimated threshold is higher than 100, the hot pixel remover makes a safe decision 
and indicates that no hot pixels are detected. 

The reason that the estimation is not done at startup is because it may be a time-consum-
ing process. Note that every time you change the repeating settings you need to re-run 
the estimation.

Remove hot pixels
Once you are satisfied with the hot pixel detection, you can correct your image. Simply 
press CORRECT and a new image will be created with the hot pixels corrected. This image 
will be shown in the main window of Huygens Professional. The hot pixels are replaced 
by the median of their neighborhood.

Comparing the 
results

After the removal of the hot pixels, the correction can be visualized using the Twin-
slicer. Figure 19.2 shows the line profiles of an example image and its corrected version. 
The solid lines are the intensity profiles of the original image (2 channels) and the 
dashed lines show those of the corrected image.The high peaks are clearly replaced by a 
value that match the continuity of the line profile. This example shows also nicely that 
the Hot Pixel Remover detects and corrects for local hot pixels, even in regions with a 
high mean intensity or gradient.
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The results of hot pixel correction can also be verified with histograms. Since the exam-
ple is a two-channel image, 2D histograms can be compared. Histograms can be viewed 
by a right-click on the image in the main window of Huygens Professional and selecting 
ANALYZE > HISTOGRAM, or by using the hist2Ch command in the tcl-shell. Type a 
hist2Ch ? within the tcl-shell to see how to use the command.

 Figure 19.3 shows 2D the histograms before and after hot pixel removal. The hot pixels 
are located at the same positions in both channels, as indicated by the diagonal scatter 
within the histogram of the original image (shown left). The diagonal scatter is clearly 
absent in the histogram of the corrected image (shown right). Note that the histogram 
does not show all hot pixels, since hot pixels may have a high intensity locally, but can 
have a relative low intensity if compared to the intensity range of the complete image

FIGURE 19.2. Comparing the results of hot pixel correction using the line plot 
feature within the Twin Slice. The dashed lines show the corrected values in this 
two channel example image. 

FIGURE 19.3. The 2D histogram of the original (left) image shows hotpixels as 
a diagonal scatter that are successfully removed in the corrected image 
(right). 
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Causes of chromatic aberration
CHAPTER 20 The Chromatic Aberration Corrector

Since Huygens version 15.05, the Chromatic Shift Corrector option has been renamed 
Chromatic Aberration Corrector as, besides removing misalignments between channels, 
it is now also capable of automatically estimating and correcting differences in scaling 
and rotation between channels.

The support for templates in this option allows chromatic correction to be applied from 
one image to other images. This is particularly interesting when the estimation is carried 
out on a multi-channel bead image. The use of templates for chromatic aberration cor-
rection is also available in the batch processor.

Causes of chromatic 
aberration

The chromatic shift, usually being the largest component of the chromatic aberration, is 
a misalignment across the channels of a multichannel image which can be corrected by 
simply shifting the channels.

There are several circumstances that can lead to chromatic shifts in the microscopic 
images:

• Chromatic aberrations in the microscope optics.
• Misaligned beam splitters (confocal microscopes).
• Misaligned excitation lasers (confocal microscopes).
• Misaligned colour filters (widefield microscopes).
• Faulty colour interpolation in colour cameras.
• Any other internal misalignments in the microscope.

Therefore, chromatic aberration can be a rather frequent - though correctable - imper-
fection in multichannel images. 
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Starting the 
Chromatic 
Aberration 
Corrector

• Launch Huygens Essential Professional.
• Load a multichannel image to be corrected for chromatic aberration.
• Select the image thumbnail and in the top menu go to DECONVOLUTION->CHRO-

MATIC ABERRATION CORRECTOR.

The Chromatic Aberration Corrector will open and show the image on an orthogonal 
slicer where the existing chromatic shifts can be seen in a 3D view (For operating the 
slicer See “The Orthogonal Slicer” on page 71.). Below the orthogonal slicer a Z slicer, a 
time slicer, and other visualization tools such as contrast, color scheme, channel selec-
tion, and zoom tools can be found. These tools are useful to enhance the view of the 
image for a better visualization of the chromatic shifts. 

A view of the Chromatic Aberration Corrector at start-up with a loaded two-channel 
bead image is shown in Figure 20.1.

Estimation of the 
chromatic 
Aberration

The following three methods can be chosen for the automatic estimation of chromatic 
aberration:

• Shift Correction (Cross correlation). This can be considered an 'all-round' method. 
The software searches for the best alignment across channels by maximizing the 
overlap.

• Shift Correction (Center of mass alignment). This method works best if the image 
contains a single object. The object should not touch the image borders, and the con-
trast between object and background should be high.

• Full Correction (Cross Correlation). This approach corrects for shifts, scaling, and 
rotation between channels. The software searches for the best alignment across chan-
nels by maximizing the overlap. Both scaling and rotation correction are performed 
with respect to the image center 

FIGURE 20.1. The Chromatic Aberration Corrector at start-up, prior to 
estimating the chromatic aberration.
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Visualization of the chromatic aberration
Chromatic shifts will be quantified by a three dimensional vector, indicating how much a 
channel is shifted with respect to the given reference channel. 

The channel to act as reference can be selected by the user via the Reference Channel 
selection box. Because this channel will have no chromatic aberration with itself, it will 
not be reported.

If an estimation method and a reference channel have been selected, the chromatic aber-
ration will be estimated and reported upon clicking on the ESTIMATE ABERRATION but-
ton.

Visualization of the 
chromatic 
aberration

The estimated chromatic aberration will be reported within the table. The aberration of 
each channel but the reference will be listed. The length unit of the three dimensional 
shift vectors is set to micrometers. Rotation will be presented in degrees, and a difference 
in scaling will be represented as a ratio value.

The user can select any channel for editing except for the one used as a reference. This 
can be done by using the EDIT CHANNEL selection box under the vector table. 

The shift vector selected for editing will be drawn on the orthogonal slicer, so that the 
estimated shift can be easily assessed. Notice that the vector components are projected 
onto each orthogonal view correspondingly. The total length of the vector is displayed 
next to each vector projection. This length is a measure of the estimated chromatic shift. 

At the same time, a plot shows the intensity profiles along the direction of the shift vector 
estimated for the reference channel and the channel selected for editing. The plot also 
shows the intensity profile of the edited channel as if it were corrected with the existing 
estimated shift (dashed line). 

Therefore, the plot serves as a comparison between the reference channel, the edited 
channel and the corrected edited channel, and allows us to see to what extent the inten-
sity of the edited channel is shifted with respect to the reference channel. At the same 
time, it shows in advance whether the estimated shift vectors will correct for the existing 
chromatic shifts properly.

The result of a chromatic aberration estimation is shown in Figure 20.2. The shift 
between the intensity profiles of the reference channel and the edited channel is visible in 
the embedded plot. Additionally, the dashed line in the plot shows the intensity profile of 
the edited channel as if it were corrected with the estimated shift. 

Ideally, the intensities of the corrected channel (dashed line) and the reference channel 
should show no remaining shift, having similar shapes and peaks roughly located at the 
same x positions. 

The Chromatic Aberration Corrector will return accurate and reliable estimations of the 
existing chromatic aberration. Still, a possibility to edit and customize the estimated 
shifts is offered so that the user can reach more precision if necessary.
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Editing the 
chromatic shift 
vectors

The user can also edit the shifts that have been estimated automatically by the Chromatic 
Aberration Corrector. The components of the selected shift vector can be modified by 
using the EDIT VECTOR tool, which allows to shorten and lengthen the estimated shift. 

While the shift vector of the edited channel is shortened or lengthened the plot updates 
itself to show how the gap between the reference channel and the edited channel is 
increased or decreased. 

In this way, the contents of the estimated shifts can be modified while checking in 
advance whether the image will be corrected appropriately.

The chromatic shift estimation of a four-channel image is shown in Figure 20.3. Chan-
nels can be edited one by one and their shifts modified with again the EDIT VECTOR tool. 

Alternatively, any customized shifts can be typed in the vector table for each channel.

Upon clicking on the CORRECT ABERRATION button the image will be corrected with the 
chromatic shifts listed in the vector table. A new corrected image will be created.

FIGURE 20.2. The Chromatic Aberration Corrector after estimating the shifts. 
A plot shows the gap between channel 2 and reference channel 0. The estimated 
shift is drawn as a vector in the orthogonal slicer scenes.
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Working with templates
Working with 
templates

The estimated aberration correction can be saved to a template by using the template 
tool of the Chromatic Aberration Corrector. 

Saved templates can be imported and applied to other images. The template values will 
be loaded and listed in the table. Furthermore, the plot will show the corresponding shift 
in the intensity profiles as if the ESTIMATE ABERRATION button had been pressed. 

Subsequently, the image can be corrected by clicking on the CORRECT ABERRATION but-
ton, which will create a new corrected image in the main window. This will also activate 
buttons with which the corrected image can be immediately opened in Huygens tools for 
visualization and analysis. Some of these tools are available as options.

It is recommended to apply templates to images that have the same emission and exci-
tation wavelengths as the image with which the template was created.

FIGURE 20.3. Using the Edit Channel tool of the Chromatic Aberration 
Corrector. The estimated vector has been manually lengthened, and as a result 
the dashed line plot is slightly moved to the left.
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Stabilization of 3D Time Series
CHAPTER 21 The Object Stabilizer

The Huygens Object Stabilizer measures and corrects for cell motion, thermal drift, 
shaking, and other types of movement (i.e. translation in x, y, and z, and axial rotation). 
Both the measurement and subsequent stabilization are done in 3D and at sub-pixel 
level. The Stabilizer not only stabilizes 2D or 3D time series, but it also allows the align-
ment of slices within a 3D stack.

To launch the stabilizer, select an image and select DECONVOLUTION→OBJECT STABILIZER 
from the main menu.

Stabilization of 3D 
Time Series

Stabilization over time works best if the 3D time series has been deconvolved first. 
Deconvolution enhances resolution and reduces noise, which helps to analyze motion.

For time series there are four stabilization methods available, which are explained in the 
next paragraphs:

• Cross correlation
• Model-based correlation
• Multi object tracking
• Center of mass alignment

If a 2D time series was read in as a 3D stack, then the Huygens Tcl command con-
vertZ2T can be used to convert z dimension to the time dimension. 

Pre-processing
The first step in the wizard is to select which stabilization method to use. After selecting 
a method a pre-processing step is shown, that offers the possibility to launch the crop-
ping tool (), and disable channels that are not relevant. The channel selector is hidden for 
single-channel images.
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The Cross Correlation Method
This can be considered an all-round method. It can correct for both x-y-z translation and 
axial rotation. Adjacent time frames are compared and the program tries to find the best 
alignment by maximizing structural overlap. A spherical region of interest can be 
defined to stabilize a particular part of the image.

After the pre-processing step, the correlation settings screen appears in which rotation 
detection can be enabled or disabled (rotation detection takes more time), and where it is 
possible to select a region of interest in the image, as shown in Figure 21.1. The NEXT 
button will start the alignment process.

When the Object Stabilizer has finished measuring the displacements, the Stabilization 
screen is shown. Continue reading “Stabilization Settings” on page 123.

The Model-Based Correlation Method
When the geometry of the imaged object did not change much during the acquisition, 
then the time series can be stabilized using a model of the object. The stabilizer creates 
the model automatically.

Pushing the NEXT button on the pre-processing screen immediately starts the alignment 
process, because this method does not require any additional user input. When the 
Object Stabilizer has finished measuring the displacements, the Stabilization screen is 
shown. Continue reading “Stabilization Settings” on page 123.

The Multi Object Tracking Method
When your image contains well-defined objects, i.e. nuclei or small particles, then the 
image may be stabilized using object tracking. Objects are tracked over time and their 
average movement is used to stabilize the time series.

FIGURE 21.1. The Correlation settings screen in the Object Stabilizer.
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Stabilization of 3D Time Series
After the pre-processing step, the detection settings 
step is shown (Figure 21.2). In this screen the detec-
tion algorithm can be configured to filter on bright-
ness only. This is a little faster and usually sufficient 
for tracking bright (or dark) spots in images with a 
high contrast between the spots and the background.

When the detection algorithm finds many false 
objects at the image borders (this may happen for very small object sizes), then the 
Object Stabilizer can be configured to ignore objects at x and y boundaries, and at the top 
and bottom of the stack.

Next, the user is asked to use the Select object tool ( ) and 
Select background tool ( ) to mark a few objects and back-
ground areas in the first time frame. Figure 21.3 shows an 
example of selected objects (green selection) and back-
ground (red selection). It is important to make sure that the 
size of the object selections roughly matches the real size of 
the objects, because this is a parameter that is used to tune 
the detection filters.

Note that the selections are three-dimensional, i.e. spheres 
instead of circles. The x-z and y-z slicers can be used to view 
and modify the position of the selections along the optical 
(z) axis.

When the NEXT button is pressed, the Object Stabilizer analyzes the selections and uses 
that information to detect objects in the first time frame. The detected objects are 
marked by blue spheres as shown in Figure 21.4. When the detection fails, then the selec-
tion tools can be used to select new objects and background, mark detected objects as 
object ( ) or as background ( ), and delete selections. When the selections are mod-
ified, pressing NEXT will recompute the detection instead of proceeding to the next 
screen.

The histogram and sliders in the optimizing object detection screen (See Figure 21.4) can 
be used to apply thresholds on the number of objects, score, width, and brightness. Objects 
that fall outside of one of these thresholds will be ignored. The score is a statistic that 
reflects the certainty of the detection algorithm, i.e. objects with a low score are probably 
noise. When the thresholds are modified, pressing NEXT will recompute the detection 
instead of proceeding to the next screen.

In the next screen the tracking parameters can be modified. A limit can be set to restrict 
the maximum distance over which an object is allowed to move in between two time 
frames. This means that the tracker will not connect two objects in subsequent time 
frames if their mutual distance is larger than this value.

The detection algorithm can be configured to automatically adapt its settings per time 
frame (to correct for bleaching, for example). The tracking algorithm can be configured 
to use the geometry and orientation of the detected objects –besides the position, bright-
ness, and filter values– for connecting the tracks (default).

The NEXT button will start the tracking process. When this is finished the edit tracks 
screen is shown (See Figure 21.5 on page 123). In this stage the user can select ( ), 

FIGURE 21.2. The Detection 
settings screen.

FIGURE 21.3. An 
example of object 
and background 
selections.
Huygens Professional User Guide for version 15.05 121



break ( ), and delete ( ) the detected tracks. The Object Stabilizer averages the 
remaining tracks to correct for the average displacement of the objects.

When the NEXT button is pressed again, the Stabilization screen is shown. Continue 
reading “Stabilization Settings” on page 123.

The Center of Mass Alignment Method
This method works best if the image contains a single large object. No objects should 
cross the image borders, and the contrast between object and background should be 
high.

Pushing the NEXT button on the pre-processing screen immediately starts the alignment 
process, because this method does not require any additional user input. When the 
Object Stabilizer has finished measuring the displacements, the Stabilization screen is 
shown. Continue reading “Stabilization Settings” on page 123.

FIGURE 21.4. The Optimizing object detection screen in the Object 
Stabilizer.
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Stabilization of 3D Time Series
Stabilization Settings
The Stabilization settings screen shows the mea-
sured displacements in x-, y-, and z-direction, and 
the rotation in four plots. If the axial displacement 
is small no correlation will be applied, unless the 
checkbox is ticked. The three sliders above the 
plots can be used to filter outliers, drift, and noise 
from the displacement curves. When the displace-
ment curves shows sudden steps, then the outlier 
filter can be used to remove those steps. The drift 
and noise filters can be used to respectively 
remove the drift and keep the random motion, or 
keep the drift and remove the random motion. 
The effect of those filters is shown in Figure 21.6.

At the bottom of the Stabilization settings screen 
there is the option to select the quality of the inter-
polation filter that is used to resample the images. 
The high quality mode is not available when cor-
recting for rotation, because it uses Fourier transforms to shift the image.

Push the NEXT button to apply the stabilization and proceed to the cropping screen.

FIGURE 21.5. The Edit tracks screen in the Object Stabilizer.

FIGURE 21.6. Effect of filters in 
the Stabilization settings 
screen. The top shows the 
measured displacement, the 
curve in the middle is noise 
filtered, and the bottom is drift 
filtered.
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Cropping the Result
Because there is some extra space needed for the translated and rotated frames, the stabi-
lized image will be larger than the original one. The Cropping screen (See Figure 21.7) 
allows the user to manually cut off the black borders, crop the image to the original size, 
or keep the full size. When selecting Original size, the reference frame needs to be 
selected.

Alignment of Slices 
in 3D Stacks

3D alignment can be applied prior to deconvolution if the stack suffers from severe mis-
alignment between adjacent slices. In those cases the Object Stabilizer may improve the 
deconvolution of 3D stacks and can be applied beforehand. In all other cases applying 
deconvolution first is preferable.

The 3D alignment method always uses the cross correlation method for comparing adja-
cent frames, and it can correct for x and y translation and rotation. The steps in the wiz-
ard are the same as for the stabilization of time series, as explained in “The Cross 
Correlation Method” on page 120. A comparison between a misaligned and aligned z-
stack is shown in Figure 21.8.

FIGURE 21.7. The stabilization result can be cropped manually to cut out 
the objects of interest. The original image borders are shown as grey 
rectangles.

FIGURE 21.8. An x-z slice of a misaligned z-stack (left), and the 
alignment result (right). The chromatic shift in stack like this one can 
be correcting using the Chromatic Shift Corrector.
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Alignment of Slices in 3D Stacks
Note that 3D alignment deforms the volume. It is advisable to check the alignment result 
carefully in using the x-z and y-z views of the Twin Slicer (See “Using the Slicer in Basic 
Mode” on page 64.).
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Introduction
CHAPTER 22 The Object Tracker

Introduction The Huygens Object Tracker wizard and the Track Analyzer an be used to study the 3D 
motion of cells and smaller particles.

By manually selecting a few objects and background regions, the Object Tracker is 
trained to differentiate between object and background volumes, and thus to detect new 
objects. In this way not only can bright spot tracking be done, but also tracking of more 
complex scenes. Because the Object Tracker is designed to detect and track objects with 
a well-defined center, it works best with spherical, disk-like (flat) or slightly elongated 
objects.

After the Object Tracker wizard has finished processing the time-lapse data the Track 
Analyzer is launched. The Track Analyzer can also be launched directly if tracks were 
stored from a previous session of the Object Tracker. The Track Analyzer helps to filter, 
edit, and analyze the results. It presents the properties of the measured tracks in informa-
tive graphs and allows to export track data to a file.

The Object Tracker 
Wizard

The Preprocessing Stage
When the Object Tracker is launched –through the main menu 
ANALYSIS→OBJECT TRACKER or the thumbnail pop-up menu– it will start the preprocess-
ing stage (Figure 22.1). The wizard checks if the sampling distances and time interval are 
reliable (reported from file or verified) and will pop-up a parameter editor (Figure 3.3 on 
page 14) if those parameters need attention.

Depending on the image dimensions (2D/3D, single/multi channel) the preprocessing 
stage will give the option to create an axial maximum intensity projection (MIP), select 
relevant channels, and/or crop the image (See “The Intelligent Cropper” on page 15.). 
These preprocessing operations help to speed up and enhance the tracking process.

Detection Settings
In this stage the parameters that control the object detection can be adjusted. The first 
screen of this stage shows the choice to use a wizard or to load a template of detection 
settings saved in a previous session.
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The next screen gives the option to filter on brightness only. This disables other image fil-
ters, and is faster and usually good enough for bright (or dark) spot tracking.

The ignore artifacts choices give the option to discard objects that are detected close to 
the image borders, as image borders can be sensitive to false positives.

Object Detection Stage
In the object detection stage the user is requested to select a few objects and background 
areas. In this stage one can also create a region of interest (ROI) such that only objects 
within this ROI are analyzed. By pressing the DEFINE A ROI, a new window will be 
opened in which an ROI can be created. When done, press the CLOSE AND EXPORT ROI 
button. The ROI will be visualized in the tracker as a new overlay image. The search for 
objects is then limited to object within the ROI.

To start the training, use the object selection 
tool ( ) to draw green outlined spheres to 
select objects. Use the background selection tool 
( ) to draw red outlined spheres to select 
regions containing mostly background voxels 
(Figure 22.2).

Like the Orthogonal Slicer (page 71), the 
Object Tracker displays the same point in space 
(the image center) from three orthogonal 
directions (xy, xz, and yz). The object and 
background selections are visible and can be 
drawn and modified in either of these projec-
tions.

FIGURE 22.1. The preprocessing stage in the Huygens Object Tracker.

FIGURE 22.2. Two object selections 
(green) and a background 
selection (red).
128 Huygens Professional User Guide for version 15.05



The Object Tracker Wizard
It is important to make sure that the diameter of the object selections is about the same 
as the diameter of the real objects, because the Object Tracker uses that information to 
tune the detection filters. The size of the background selection does not affect the detec-
tion.

When at least one object selection and one background selection is created, pressing the 
NEXT button will initialize the object detection and advance to the next step in the wiz-
ard.

Note that you can choose any slice for training, but the objects and background selection 
is only possible in one slice. During training, Linear Discriminant Analysis is used to 
find the best features to distinguish between object and background. In combination 
with the watershed segmentation method (See “Using the watershed segmentation” on 
page 139.), objects are defined. This process is done for each slice.

Optimizing Object Detection
After pressing the NEXT button in the 
object detection stage, the wizard will 
highlight the detected objects with a 
light blue overlay. A ‘plus’ symbol marks 
the center of each detected object 
(Figure 22.3). 

In this screen it is still possible to add, 
delete, or modify the selections. In case 
the selections are altered, the NEXT but-
ton will reload this screen instead of 
advancing to the next stage.

The right side of the wizard shows a his-
togram of the number of objects versus 
their score. The score is a qualitative 
measure for the probability that the 
detected object should indeed be classi-
fied as ‘object’. By default all objects with 
a positive score are taken into account, 
but this threshold can be changed in 
order to make the Object Tracker less or 
more sensitive. To change the threshold, 
tick the lower threshold box and drag the 
slider (Figure 22.4).

Besides the score, thresholds can be 
applied to the number of objects, and the 
width and brightness of the objects. The 
width and brightness can be limited by 
both a lower and upper threshold. There is by default a threshold of 100 objects on the 
number of objects. An important thing to note is that all thresholds are applied, not only 
the currently selected one.

When one of the thresholds is modified, the NEXT button will reload this screen instead 
of advancing to the next. When the detection is satisfactory, press NEXT again to advance 
to the next step.

FIGURE 22.3. Detected objects.

FIGURE 22.4. Increase the threshold on 
the score to reject more objects.
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Tracking Parameters
This is the final stage before the automated tracking starts. The parameters that can be 
modified in this screen affect the linking of the detected objects between subsequent 
time frames.

The first parameter limits the distance over which an object is allowed to move between 
time frames. This means that the tracker will not connect two objects in subsequent time 
frames if their mutual distance is larger than this value.

The second option enables or disables the use of object geometry and orientation for 
linking objects. Enabling this option makes sense if the objects of interest have distinct 
sizes.

Quick Edit Tracks
When all time frames are processed and the detected objects have been linked into 
tracks, the wizard advances to the quick edit tracks stage. In this stage broken tracks can 
be connected, and wrong tracks can be deleted or broken down into smaller pieces that 
can be re-connected.

The graph shows the position of the objects in the xy plane versus the time frame num-
ber (Figure 22.5). The projection angle can be changed using the slider below the graph. 

An angle of 0° projects on the x-axis while 90° projects on the y-axis.

To break tracks down into smaller pieces, simply select the break tool ( ) and click 
between the nodes that should be disconnected. Multiple tracks can be selected using the 
CTRL key. If the nodes of the selected tracks do not overlap in time, then those tracks can 
be joined by pressing the connect button ( ).

Pressing Next will show the last stage where you can save the tracks to a file, and/or save 
the tracker settings in a template. The tracks will be saved in a .tracks file and this file 
can be imported within the Track Analyzer. The tracker template can be used to quickly 
track similar images. The tracks can also be saved in the Track Analyzer, but the tracker 
template can only be saved at this stage.

Pressing NEXT again will close the wizard and load the tracks in the Track Analyzer.

FIGURE 22.5. The quick edit tracks stage allows to connect, break, and delete 
tracks.
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The Track Analyzer
The Track Analyzer The Track Analyzer is automatically launched after the Object Tracker has finished pro-
cessing the data, but can be started individually as well. Select the image which corre-
sponds to the .tracks file to be analyzed and go to the main menu 
ANALYSIS → TRACK ANALYZER. The .tracks file can be imported through FILE → 
OPEN TRACKS....

The Filter Tab
The Track Analyzer can be used to analyze the tracks that have been generated by the 
Object Tracker. The scene on the top left displays these tracks, which can be saved via 
FILE > SAVE TRACKS. Viewing options can be selected under VIEW in the menubar. Tracks 
can still be edited using the break tool ( ) and connect tool ( ), or the delete button. 
The window at the bottom left shows the collection of tracks and the objects for each 
track. Clicking on the track or object number highlights the concerned track in the 
image. Vice versa, the track number is highlighted when clicking on a specific track in 
the image.

The filter tool (Figure 22.6) can select a group of tracks based on common properties. 

These properties can be the number of detected objects (nodes) per track, start time, 
duration, the path length, average speed and the average angular speed. The upper and 
lower threshold sliders can be used to define a range within those properties. When the 
SELECT TRACKS button is pressed, all objects within the threshold ranges are selected. 
The INVERT button in the taskbar inverts the selection to the other tracks.

An important thing to note is that all thresholds are applied when SELECT TRACKS is 
pressed. Press the RESET ALL THRESHOLDS button to disable all thresholds.

To remove tracks with less than 4 objects, for example, select the detected object per track 
property, tick the upper threshold box, drag the upper threshold slider to a value just 
above 4, and click SELECT TRACKS. Now those tracks are selected. These tracks can be 
removed by pressing the DELETE button.

The Position Tab
This tab provides information on the position and displacement of the tracked objects. 
The histogram at the top, as shown in Figure 22.7, gives the number of objects versus the 
distance to their track origins for a specific duration. Example; if the time frame slider is 

FIGURE 22.6. The filter tab in the Track Analyzer.
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set on 3 frames, and the height of the bar at a distance of 1.2 μm is 9, then there are 9 
objects that travelled a net distance of 1.2 μm in 3 time frames.

The second and third plot in this tab are closely related. This second plot shows the aver-
age displacement for a certain duration, as given in Equation 1. In this equation t is the 
duration in frames and N is the number of objects.  is the position vector of object i 
at time frame t.

(EQ 1)

The third plot shows the mean squared displacement, or MSD, as given in Equation 2. 
Note that the x-axis of this plot shows the duration t in seconds instead of frames.

(EQ 2)

FIGURE 22.7. In case of a large number of objects that show Brownian 
motion, the shape of the histogram in the position tab will be a half-
normal distribution.
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The Track Analyzer
There is also a close relation 
between the MSD and the 
histogram in the first plot 
(Figure 22.7). In case of pure 
Brownian motion and a large 
number of objects, the histo-
gram will show a half-normal 
distribution. In this special 
case, the variance of that dis-
tribution is given by . 
The rate of change of this 
variance is known as the dif-
fusion coefficient D, which 
thus can be estimated by 
measuring the slope of the 
MSD plot (Figure 22.8).

Just click and drag in any of 
the plots to measure dis-
tances and slopes.

The Speed Tab
This tab displays information on the velocity of the tracked objects. The first plot is a his-
togram that shows the distribution of the speed of the objects, while the second plot 
shows the average speed over time.

The third plot informs about the velocity distribution of the objects. This not only gives 
information on the speed (a scalar value), but also on the direction of the velocity, as 
shown in Figure 22.9.

The Orientation Tab
The first graph under this tab shows the axial rotation of objects in time, while the sec-
ond graph show the 3D angular speed versus time (indicated as frame numers).

FIGURE 22.8. The slope of the mean squared 
displacement plot indicates a diffusion coefficient 
of 9.32 μm²/s.

MSD t 

FIGURE 22.9. Left: An xy velocity scatter plot showing a drift in the 
positive y direction. Right: An xy velocity scatter plot of objects moving 
with a constant speed of about 0.35 μm/s in random directions.
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The Flow Tab
This tab can be used to gain insight into the amount of objects that cross a certain 
boundary over time. Boundary surfaces can be defined as a 2D poly line in the xy slice 
image. These lines are extruded to planes in the axial direction. To start drawing one, 
click the DRAW BOUNDARY button ( ), and then click on the first point of the bound-
ary. A single click adds a new line segment and a double click finishes the poly line.

When a boundary has been defined, then the plot in the Flow tab shows the number of 
objects that cross this boundary at a certain time frame (Figure 22.10).

Exporting Data
The plot graphics, as well data in the plots and the track data can be exported to a file. 
The buttons below each of the plots, SAVE AS... and EXPORT DATA..., save the plot as an 
Encapsulated PostScript file (EPS) and export the data as comma separated text (CSV), 
respectively. The track data of the selected tracks can be exported to a CSV file using the 
menu FILE→EXPORT→SELECTED TRACKS AS CSV.

The EPS format can be imported by most office programs, including Microsoft Office 
and OpenOffice. The CSV format is plain text and can be parsed by most spreadsheet 
programs and other software like Matlab and Mathematica.

FIGURE 22.10. The flow histogram shows that objects are crossing the 
boundary between time frame 4 and 24.
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Starting the Object Analyzer
CHAPTER 23 Introduction to the Object Analyzer

The interactive Object Analyzer (OA) tool allows you to obtain statistics of individual 
objects by clicking on them, or analyzing all objects with a single button press.

In this context, an object is a distinct group of interesting voxels that are spatially con-
nected one to another. Interesting voxels are distinguished from the background by 
using a seed and threshold criterion. Therefore, defining objects in an image implies: 

1. Segmentation: Separating interesting voxels from the background according to a 
given criterion; 

2. Labeling: Grouping them together and assigning them a distinct name or label.

This is done interactively by the Object Analyzer. To exclude objects that are too small 
before starting the analysis, a garbage level can be used. Any object smaller than this gar-
bage volume will be discarded. After removing these small objects, all remaining objects 
are automatically labeled and sent to a continuous iso-surface renderer (See Chapter 14 
on page 85).

The Object Analyzer is an extended option, and is enabled by a special flag in the Huy-
gens license string.

This chapter is written in the form of a step-by-step, introductory tutorial to the basic 
functions of the Object Analyzer. A reference guide that describes all the user interface 
components of this option that can be found on page 151.

Starting the Object 
Analyzer

• Launch Huygens Professional .
• Load an image you want to analyze. To explore all the OA possibilities, better use a 

multi channel image.
• Select the image thumbnail, and in the top menu go to 

ANALYSIS→OBJECT ANALYZER ADVANCED.

You can find this introductory tutorial on-line on the SVI Wiki1, from where you can 
also download the test image we will use in the following steps.
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You can explore the image with the Twin Slicer (See Chapter 10 on page 63) for an initial 
impression of the data. The demo image is a deconvolved image. It is always recom-
mended to perform deconvolution before analysis. Deconvolution will reduce noise and 
blurring significantly and will thereby improve the analysis quality.

The image in Figure 23.1 is a MIP projection of the example 3D dataset. Notice that 
there are a few bright objects in the red channel against a more or less homogeneous 
background (it is actually a quite flat cell nucleus), and lots of scattered objects of differ-
ent sizes and intensities in the green channel. The red channel is in general dim with the 
exception of the inner bright objects and some increase in intensity in the peripheral 
area, making something like a border.

When the image is opened in the OA, a first view and segmentation is presented 
(Figure 23.2). The initial segmentation is based on Otsu’s segmentation.

A large bright object is visible in red and viewed from the top. The image was automati-
cally rendered with default settings. If more than one object is present, different colors 
will be assigned to each object. The specific color range can be adjusted with the hue and 
saturation sliders.

1.http://www.svi.nl/ObjectAnalyzerTutorial

FIGURE 23.1. Maximum intensity projection of the test 
image. Cell nucleus FISH-stained, recorded at the 
Nuclear organization Group, SILS, University of 
Amsterdam (head: Prof. Roel van Driel), under the 3D-
Genome research project.
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Segmenting the Objects: Setting the Threshold
Segmenting the 
Objects: Setting the 
Threshold

The segmentation method in the Object 
Analyzer uses a combined seed-and-
threshold method, see Figure 23.3. The 
seed acts as a secondary threshold level, 
so that objects that do not reach this 
intensity (in at least one voxel) are dis-
carded. More details on how the thresh-
old-seed segmentation works can be 
found in the expert online tutorial2. 

Let's try different segmentation parame-
ters and see what happens. First we 
increase the threshold value from the 
automatically calculated value to some-
thing around 360 (the mentioned 
numerical values refer to this particular test image, of course). You can drag the blue line 
in the channel histogram and shift it to higher values, or click on the blue-font label 
showing the threshold value to enter any number. The threshold lines on the histogram 
are found at the right of the window, in a pane labeled Object Segmentation. 

FIGURE 23.2. Start up screen of the Object Analyzer. The object in the 
image’s first channel is automatically segmented with initial parameters 
calculated based on the intensity distribution (Otsu’s segmentation).

2.http://www.svi.nl/ObjectAnalyzerExpertTutorial

FIGURE 23.3. Visual representation of 
the seed-and-threshold segmentation 
method.
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The magenta-colored line is the seed level. When you shift the blue line, the magenta line 
also moves, as by default the two are linked.

You can also switch to a percentage representation of threshold and seed by clicking the 
small button  at the top-right of the histogram. In this alternative slider view, you can 
also control whether the seed is linked to the threshold value or not, by enabling or dis-
abling the check box next to the Seed slider.

When we shift the threshold to higher values the rendering scene will change. First, the 
object we had defined will shrink in size and we see many smaller objects starting to 
appear. Some objects that were connected earlier shrink so much that they now get sepa-
rated, and they define new objects. To visualize the object details better, you can increase 
the zoom factor up to 1.30 to see what is shown in Figure 23.4.

The increased threshold breaks the single large object into multiple smaller objects. The 
very small objects can be easily removed by setting a garbage volume.

Setting a Garbage Volume Level
A quick way of removing small objects, is the Garbage Volume option. You can find this 
entry in the alternative slider view of the threshold, to which you can switch by clicking 
the small button ( ) at the top-right of the histogram. The garbage entry is shown 
below the seed slider. Objects with a voxel volume below the garbage level are discarded. 
This means that when you set it to 1, no object is discarded, but if you set it to for exam-
ple 100, any object with a volume smaller than 100 voxels will be removed from the 
scene and from further analysis.

FIGURE 23.4. Different segmentation conditions. Increasing the threshold 
decreases the objects size, and adds more objects to the scene.
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Segmenting the Objects: Setting the Threshold
Additionally, you can apply some post-segmentation filtering. Details on this are 
explained in the expert tutorial. In the top menu you can also find some predefined fil-
ters for discarding objects. These filters are based on the geometrical properties of indi-
vidual objects or on how objects are related to other objects.

Using the watershed segmentation
When using the seed and threshold method, it is possible that objects merge at a certain 
threshold level. To further tune segmentation, you can apply a watershed segmentation.

The watershed segmentation builds “watersheds” at local minimum values to separate 
merged objects. This can also be explained as a flooding algorithm where the inverse 
intensity profile is flooded with water. A watershed is build in order to separate the dif-
ferent water-reservoirs. The difference between threshold and watershed segmentation is 
illustrated in Figure 23.5.

The Seed setting has the same meaning for the watershed as it has for the threshold seg-
mentation method, however, the garbage volume filtering uses a slightly different 
approach. The garbage filter removes objects with a volume below the given value, but if 
this concerns an object that was separated from an other object by the watershed algo-
rithm (a neighbor) it will first be merged with this neighbor, after which the volume of 
the new merged object is again reviewed. This merging process will be repeated with 
new neighbors until it has no direct neighbors. If the volume is it still below garbage level 
and it has no neighbors anymore, it will be removed, otherwise the complete object is 
kept.

The watershed segmentation method uses the sigma setting as an extra input. This set-
ting is used to avoid over-segmentation of the data by smoothening intensities with a 
gaussian filter. Especially with very noise images, local minimum value are frequently 
present, resulting in many small objects. The Object Analyzer can handle at most 32768 
(= 215) objects.

If you want to use the watershed segmentation, we recommend to first use the simple 
seed-and-threshold segmentation. After setting the threshold correctly, the watershed 
can be activated. Due to its complexity, the watershed segmentation may take some time, 
especially in comparison with the more simple seed-and-threshold segmentation.

FIGURE 23.5. Difference between the seed-and-threshold and watershed 
segmentation methods.
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Interaction with the 
Objects

On the left side of the Object Analyzer window you can find a 
column of buttons. Many of the buttons are deactivated at this 
moment, they will be activated when it makes sense later. But 
almost all icons in the first group are always available. The first 
group of icons control the Mouse mode, i.e. the action of the 
mouse when you left-click in the scene. A more detailed descrip-
tion of these icons are described in “Mouse Modes (2)” on 
page 154 .

The buttons in the other groups (Objects, ROI and Data) execute 
operations on previously defined conditions, for example delet-
ing the objects under a selected area, or discarding every object 
that has not been selected as anchor. We will not consider them 
in this basic tutorial, as you don't need them to perform basic 
measurements. Please see the “Object Analyzer Component Ref-
erence” on page 151 for a detailed description of these toolbox 
buttons.

At the end of the buttons column there is a colored reference 
cube that will help you to orientate in space when you rotate the 
dataset, especially with large zoom factors that do not let you see 
the surrounding box frame in the rendered image. The initial 
view of this cube is the blue top face corresponding to . 
Hovering the mouse over the cube faces brings a tooltip with the 
face label (x, y and z with values 0 or 1).

The Analyze object mouse mode  is the default mode. Click on 
an object and see what happens. Notice that some parameters are 
reported on the table at the bottom of the window. Later in this 
tutorial we will learn how to analyze more parameters and more 
objects at once.

First, we need to briefly explain what a pipe is, because you need to know how to select 
which channels in the image you want to analyze.

Render Pipes When we opened the analyzer, only the first channel 
of the image is shown on the screen. However, we can 
change this by simply selecting another channel from 
the drop-down menu in PRIMARY PIPE: where it 
reads Chan 0 you just select Chan 1 (See Figure 23.6).

With this approach, you can also explore two chan-
nels at the same time?

The term pipe suggests that data flows from your 
original image to the final rendering in the Object 
Analyzer through a ‘computational duct’ in which 
some processing occurs. You have two of these pipes 
in the Object Analyzer to direct data through.

You can activate the control pane of the secondary 
pipe by clicking on the tab that reads SCND. ‘Secondary’ does not mean here ‘less import-

z 1=

FIGURE 23.6. Rendering 
pipes control panel.
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Object Statistics
ant’, it is just that we have the first pipe (Primary) and the second pipe (Secondary), also 
abbreviated as P and S. The primary and secondary pipe should not be confused with the 
numbering of the image channels. For example; you can even segment the same channel 
twice, but with different conditions in each of the two pipes.

All the different objects in a pipe are colored differently to be able to distinguish them. 
The range of colors assigned to each pipe can be controlled with a HUE SELECTOR (See 
“Hue Selector” on page 196.). If you want all objects in a pipe have the same color, you 
can collapse this range completely by moving the two triangular sliders together.

There is also a maximum intensity projection (MIP) pipe. This pipe does not interfere 
with the analysis, but can be used to set a visual reference of the (unsegmented) data.

Before continuing our exploration, let's enable channel 0 again in the primary pipe with 
a threshold of 40% (488 in absolute terms), nothing (Off) in the secondary pipe, and 
channel 0 again in the MIP, so we see something like Figure 23.7.

Object Statistics The Object Analyzer is able to measure many different parameters, but only a few are 
computed and reported under the default settings. To obtain information about a spe-
cific object, click on this object while you are in the Analyze object mouse mode. To auto-
matically process all the segmented objects in all pipes, simply press the ANALYZE ALL 
button  on the top-right of the table. (If you have a region of interest (ROI) selected 
on the screen which encloses a few objects, this button analyzes only the objects inside 
this ROI).

There are many additional useful parameters that you can choose from. Let's have a look 
at how to retrieve all this information.

FIGURE 23.7. Objects and MIP. Objects in 
a surface pipe rendered together with a 
MIP pipe for spatial reference. The data 
channel is the same one in both pipes.
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Configuring the Reported Parameters
To simplify the usability of the Object Analyzer, there is a big button next to 
Select Statistics on the top left of the table that reads EXPERIMENT PRESET at start-up. 
Click on it and you will get a selection dialog as shown in Figure 23.8.

The left column shows a series of different experiments. If you click on them, a new list 
of parameters is listed in the middle column, and a description is shown on the right col-
umn. When you hover with your mouse over the listed parameters, a tooltip explains 
each parameter. Please read the descriptions briefly to get an impression of them. Let's 
select the preset called CORRELATION INSIDE CHANNELS and inspect it in more detail. 
Please read the descriptive text.

“This parameter set will report for each object the distance and the ID of the nearest neigh-
bor in its pipe.”

For each object we are interested in, we are going to find also the closest object.

Notice that among the listed parameters (center column) of this preset, only one of the 
parameters is selected to be reported in the scene. All parameters will be calculated and 
reported in the results table, but only the selected ones will be shown on the rendering 
canvas as well when you interact with the objects. In this parameter set, the distance is a 
useful parameter to report in the scene, as it provides a visual reference of the distance 
measurement between neighboring objects.

Once you have selected this CORRELATION INSIDE CHANNELS preset, press OK to con-
tinue.

Measuring the Objects

Make sure you have the Analyze object  mouse mode selected, click on an object in the 
scene and notice the new columns that appear in the statistics table.

FIGURE 23.8. The Experiment Presets dialog. Collections of parameters can be 
selected to be reported on the table and the scene, depending on your specific 
experimental needs.
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Object Statistics
Before showing the actual object details, the first row in the table informs you about the 
segmentation conditions for this pipe. If you move your mouse over the column header, 
a description of the corresponding parameter will be reported at the very bottom of the 
window. You can always find out what each parameter abbreviation stands for by looking 
at its tooltip. The description of each parameter will be also stored in your file when you 
export the results table later.

The tooltip of the column header also shows the sum and the average value of all the cells 
in the column. It is possible to include data of two pipes, or a single given pipe only.

Click on another object to apply a measurement and add the results to the table. You will 
see that the segmentation conditions are not reported again, because they have not 
changed. A checkbox option at the top-right of the table can be used to automatically 
clear the table when the segmentation or report conditions change, so you always have 
an organized table. When you deselect this option, all the results (despite different seg-
mentation conditions) will accumulate in the table. The button located next to the 
checkbox allows you to clear the table at any time.

You may have noticed that something else happens when you interact with the rendered 
objects. In the example of Figure 23.9, the user clicked on object 11. A line joins the cen-
ter of mass (CM) of this object with the center of mass of the nearest neighbor, and this 
distance is reported at the top of the window. This is the only parameter reported on the 
canvas because it is the only that was selected from the preset selection dialog to be 
shown in the scene.

Other Measuring Parameters
The presets are organized in basic and advanced modes. 

We can distinguish two basic parameter presets: the one we have used here to explore the 
nearest neighbors, and another one to retrieve morphological parameters about objects, 
called SMALL PARTICLES GEOMETRY. This parameter preset can report object information 
like length, width, aspect ratio, and sphericity. Details on how these parameters are 
defined can be found on “Object Analyzer Geometry Measurements” on page 147.

FIGURE 23.9. Interaction with the objects. 
When the distance to the nearest neighbor is 
computed, the distance line is also displayed 
on the screen for the object aimed at.
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The advanced modes require that you define some conditions first. For example, that 
you first define a ROI. The advanced modes are not intrinsically more complex, but they 
demand from the user some knowledge on how to set these reference conditions.

For more details about any parameter preset just click the HELP button at the lower-right 
part of the preset selection dialog, and follow the on-screen tooltips during the interac-
tion with the module.

Exploring the Table

Let's try another thing: click on the ANALYZE ALL button  at the top-right of the table 
so the data of all objects are gathered. When the calculations are done (it should be quite 
fast in this example) move your mouse over the table rows and see that the cursor high-
lights the table rows (see Figure 23.10). Furthermore, the object corresponding to the 
current row will be highlighted on the canvas, and the distance to its nearest neighbor 
will be shown.

You can find an object in in the results table by clicking on the object in the rendering 
canvas while the Analyze object mode is active: the table will be shifted to show its corre-
sponding row, and it will be highlighted.

You can right-click on a column and select STATS for more detailed statistics.

To plot a histogram of the distribution of values in a column, select the column (or a sub-
set), click with the right mouse button, and select HISTOGRAM from the pop-up menu. 
Figure 23.11, for example, shows a plot of the partile sphericity distribution.

FIGURE 23.10. Exploring the table.

FIGURE 23.11. Histogram representation of 
one column values. 
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Storing your Results
Storing your Results In the top menu you can select FILE→SAVE OBJECT STATISTICS to export the table to a file 
for further analysis and/or calculations. The table can be stored as a plain text file, a csv-
file, that can be imported in e.g., Microsoft Excel, LibreOffice Calc, GNUplot, and as a 
m-file, that can be imported in Matlab. 

The current scene as it is currently visible on the rendering canvas can be saved to a TIFF 
file using FILE→SAVE SCENE. In the OPTIONS menu you can find different options that 
affect how the scene is rendered. You can set the MIP pipe to high quality for example, or 
render each analyzed object together with its numeric ID label, so that you can link them 
with the exported data visually.

In the HISTORY menu, you can save your analysis history as a template. Such a template 
can be used on the same dataset to reproduce the analysis, or on other datasets.

Further Reading This tutorial has covered the very basic features to the Huygens Object Analyzer. If you 
want to learn much more, consider following the expert on-line tutorial3 and the accom-
panying wiki pages, where you will learn many other powerful things you can do with 
this versatile analyzer.

A reference description of the Object Analyzer components can be found in Chapter 25 
on page 151.

3.http://www.svi.nl/ObjectAnalyzerExpertTutorial
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Iso-surface
CHAPTER 24 Object Analyzer Geometry 
Measurements

Iso-surface In the Object Analyzer, the threshold for the segmentation is used to define an iso-sur-
face around the object.

An iso-surface is a 3D surface representation of points with equal values in a 3D data dis-
tribution. Is the 3D equivalent of a 2D contour line (See Figure 14.1 on page 85).

Based on the iso-surface, one can measure volume and surface in high resolution, by fine 
polygonization at a sub-pixel level.

Principal Axis Segmented objects are geometrically analyzed in terms of their principal moments of 
inertia. (In this sense, the recorded light intensity registered in the image is used as den-
sity: the pixel ‘values’ are interpreted as local mass, so brighter regions weight more).

The principal axes of an object establish a natural system of reference based on its mass 
distribution. When you rotate an object around one of its principal axes, the angular 
momentum is parallel to it. This does not happen in general, and is what makes these 
axes so special.

Around these axes the principal moments of inertia of the object are defined. For one of 
these axes, the rotation inertia of the object is minimal (around this axis the object would 
rotate with the least effort). This axis usually lies along the length of the object. The other 
two axes are orthogonal to it, and orthogonal to each other.

Length and width One can easily define a box, with dimensions L, pBoxW0, pBoxW1 in the system of refer-
ence of the principal axes, that encloses the object completely. The sides of this box are in 
general not parallel to the main planes of the image, because the principal axes do not 
coincide with the image x, y, or z-axes in general. It is as if the principal box is rotated 
with respect to the image in order to properly enclose the object, which may not be 
aligned with any of the image axes.
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The length of the object is the largest distance measured along the three principal axes, it 
coincides with the largest dimension of the principal box L.

One could use the other two dimensions of the principal box as width and thickness of 
the object, but for some practical uses this may be too simplistic.

The width of the objects is actually computed with a search algorithm that acts as a vir-
tual caliper held perpendicular to the length axis. To find the largest width of an object 
one would rotate the caliper around the object and repeat this procedure while sliding 
the caliper along the length axis. However, because microscopic data, even when it is 
deconvolved, often shows orientation dependent imaging due to the lower axial resolu-
tion, structures are often elongated in the axial direction. Moreover, in most cases, the 
voxels themselves are much higher than they are wide, causing all small objects to be 
elongated.

Clearly, without correction, the anisotropy in resolution would result in an overestima-
tion of the width. To avoid this problem the rotation angles at which the caliper is held 
are divided in axial directions and lateral directions.

To measure in the axial directions several slices are taken out of the object and analyzed 
one by one. Each of these slices is parallel to the 'caliper plane', perpendicular to the 
length axis of the object. In any slice there are directions more oriented towards the opti-
cal axis (axial directions) than others. The largest axial width of each slice is obtained by 
holding the caliper in these directions and searching for the largest among them.

After all slices along the length axis have been examined, the largest axial width of the 
object is reported as WiAx.

The lateral directions in the caliper plane are the directions closer to the xy-plane. The 
caliper measures now the width of each slice in directions near-perpendicular to the 
optical axis. Taking the largest figure among these lateral directions might again intro-
duce a bias due to elongation, so now two values are computed per slice: the largest and 
the smallest width along the lateral directions.

After exploring all slices some global relevant figures are reported. The largest lateral 
width obtained while sliding the caliper plane along the length axis is reported as WiLat. 
The largest of the smallest widths is reported as WiLatC. In case of small objects and 
moderate to high ratios between the axial and lateral resolution this last value is likely to 
suffer least from the orientation dependent imaging.

The waist (the smallest of the smallest widths) in the lateral directions is reported as 
WaistLat.

What about objects with a vertical length axis? In that case the ‘caliper plane’, perpendic-
ular to the length axis, will be horizontal, parallel to the xy-plane. In a horizontal caliper 
plane all directions in it are perpendicular to the vertical z-axis. As a result there is no 
'most axial direction' in that plane. The software then orients the lateral width towards 
the x-axis and the axial direction towards the y-axis.

Sphericity The sphericity is reported in two ways in the Object Analyzer:

1. The axial sphericity is defined in general as the ratio of the volume of an ellipsoid 
with axes length L, width W and thickness T to the volume of a sphere circumscribed 
around the segmented object, defined by its length.
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Aspect Ratio
Because it is based on three axes, it gives an idea of the 3D aspect ratio of the objects.
Depending on which of the previously reported parameters we choose for W and T 
we have different practical definitions of axial sphericity.
Probably the most intuitive one is the axial sphericity of the principal box axSphPB: 
the ratio of the volume of an ellipsoid with axes L, pBoxW0, pBoxW1 to the volume of 
a sphere circumscribed around the principal box (see above) using the largest side 
(the length of the object L) as diameter (Equation 1).

(EQ 1)

2. Another definition (reported as AxSph) involves the lateral and axial widths dis-
cussed above, obtained with the virtual caliper algorithm (Equation 2).

(EQ 2)

The roughness sphericity characterizes the roughness of the iso-surface, it measures 
how close the volume-to-surface ratio is to the one of an ideal sphere. This is conven-
tionally defined as:

(EQ 3)

where Vi is the iso-volume and Ai is the iso-surface of the segmented object. Both 
sphericity values become 1 for an ideal sphere. The SurfSph is the inverse of the ‘sur-
face factor’ fs used in Goetze et al.1

Aspect Ratio Again, the aspect ratio of an object can be defined in terms of different dimensions:

• The axial aspect ratio AxRatio is the ratio of the object length to its axial width WiAx.
• Similarly, the lateral aspect ratio LatRatio is the length divided by WiLatC.

More Parameters 
and Filtering

Many additional parameters, geometrical and of other kinds, can be calculated, reported, 
and used to filter the data by the Object Analyzer. Please refer to the on-line tutorials to 
learn how to use the different parameters and Experiment presets.

Parameters are available that report:

• Correlation inside and between channels, by analyzing neighbor objects
• Location of objects with respect to reference objects (anchors).
• Location of objects inside regions of interest (for example bodies inside a cell nucleus)
• Colocalization of objects (by computing the volume and the intensity overlap of seg-

mented objects in different pipes).

Any of the calculated parameters can be used to filter out objects and further segment 
your image in elaborated ways.

1. Goetze et al., Molecular Cellular Biology 27, p. 4475-4487 (2007)

AxSphPB pBoxW0 pBoxW1 L 

L3
----------------------------------------------------- 
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1 3

6Vi 2 3
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CHAPTER 25 Object Analyzer Component Reference

This section describes the components of the Object Analyzer (OA) interface.

This section is intended as a quick reference. See “Introduction to the Object Analyzer” 
on page 135 to learn how to use the basic components in context.

FIGURE 25.1. The Object Analyzer interface. Different regions are enumerated to 
describe them in sections of this chapter.
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Main window 
components

The OA main window is shown in Figure 25.1 with most of its components in an active 
state. Different regions of the interface are enumerated to describe them conveniently 
along this chapter.

When the OA is launched, not all the buttons in the toolbox are enabled. Most buttons 
are automatically enabled when they are usable, depending on conditions set by the user. 

Main Menu (1)
FILE: Entries to save the rendered image, export or clear the object statistics, and analyze 
all time frames in a series.

OPTIONS: Rendering options and advanced statistics configuration:

• Virtual render size: sets the size of the canvas on which the Ray Tracing algorithm 
renders the image. This canvas can be larger than the OA window or even the screen 
(that's why you can pan the canvas to inspect other regions). This way you can render 
and save high-resolution TIFF images.

• Transparency depth: controls the number of surfaces considered by the renderer in 
order to show inner cavities and objects inside objects.

• Bounding box: shows or hides the reference 3D bounding box
• Scale bar: shows a scale bar on the scene. The distances are calculated based on the 

voxel sizes in the original image microscopic parameters.
• Show ID labels: render the scene showing the numerical ID label of each of the ana-

lyzed objects.
• Show SVI logo.
• High quality MIP: enables or disables the high quality rendering mode for the MIP 

pipe
• Show reference cube (See “Reference Cube (7)” on page 157).
• Show on-screen tooltips for interactive actions.
• Relaxed selection: when active, objects partially outside the selected 2D area are also 

considered.
• Center scene: moves the point of view to show the center of the dataset.
• Configure statistics report: shows all available parameters to let you select which ones 

are calculated and reported on the table. This is intended for advanced users, begin-
ners should better use the Experiment presets (See “Experiment Presets (17)” on 
page 160).

HISTORY

• Undo the last operation, or Redo it again.
• Reload original data after cropping the image or discarding objects.
• View the whole operations history up to the current point.
• Load and save analysis templates, so that the current view and parameters can be 

stored and retrieved, or a whole operations history re-executed with other data. This 
is also useful to store your analysis steps and reproduce them.

• Set analyzer as in any other open instance of the tool.

ROI: operations to define a region of interest in complex ways, and to modify and save 
the currently defined ROI.
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• Set:
· Set to extruded selected area: uses the interactively defined 2D area to set the ROI 

to the volume below it. The 2D area is projected along the line of view.
· Set using MIP threshold: use the threshold and data channel of the MIP pipe to 

set a 3D ROI
· Make coincide with objects: use the currently segmented objects to define a 3D 

ROI. Objects from the Primary, Secondary or both pipes can be used depending 
on the active pipes and the pipe mode (See “Active Pipe Mode (6)” on page 156).

· Make coincide with anchors: use the currently selected anchors to define a 3D 
ROI. This may leave holes in the interior of the ROI if the anchor is not a solid 
object.

· Make coincide with intersection: this is interesting to do object analysis with colo-
calizing volumes only. When you have two pipes active and some objects in one 
channel intersect with the other. A ROI can defined, and applied to discard 
objects and parts of objects outside the region, so that only the colocalizing inter-
secting regions remain.

· Envelop anchors: use the currently selected anchors to define a 3D ROI, so that 
also holes inside the objects are 'filled in' and in the ROI.

· Enclose anchor in a box: define a prism that is an envelop to the selected anchors.
· Make a spherical ROI of a given diameter, centered in the image. You can shift it 

later with the shift ROI mouse mode.
· Set to all volume: sets the ROI to the complete dataset volume.

• Modify:
· Fill inner cavities: a ROI defined by using a threshold may contain inner cavities 

(visible when selecting the deep Transparency Depth). This operation fills them 
in automatically.

· Fill inner and cutoff cavities: A cutoff cavity is a hole in the surface of a ROI that 
touches the image limits.

· Grow/shrink: the currently defined ROI can be enlarged or reduced in a certain 
number of VoXels, independently in the xy-plane or in the z-direction. A 3D 
(xyz) reduction is also possible: here the number of voxels in the xy-plane will be 
partially adapted to the entered voxels along z to, considering the voxel anisot-
ropy, grow/shrink the volume proportionally.

· Outer shell: re-define the ROI considering only an outer shell of given thickness.
· Invert the ROI volume.

• Storage
· Export current ROI to the main window, to have the ROI made available for other 

tools in Huygens.
· Save current ROI to file
· Load ROI from file
· Add ROI from file
· Intersect with ROI from file
· Subtract ROI from file

• Center ROI on the anchor CM: align the Center Of Mass (CM) of the currently 
defined ROI with the CM of the selected anchors.

• Clear ROI
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• Keep only objects inside the ROI, discarding anything else. The relaxed selection 
mode in the options also affects how objects partially inside the ROI are handled.

• Analyze ROI volume computes and reports information on the table about the ROI 
itself.

• Analyze all objects inside the ROI reports in the table information about objects 
inside the ROI, or partially outside it, depending on the relaxed selection option.

• Help on Regions of Interest.

ANCHORS

• Anchor objects under selection
• Select all objects as anchors.
• Set anchors by filtering. This opens a filter dialog as explained in “Table and Analysis 

Shortcuts (19)” on page 161, but allowing you to select or deselect anchors instead of 
discarding objects.

• Invert current anchor set.
• Deselect all anchors.
• Keep anchor objects, discarding anything else
• Discard all anchor objects.
• Analyze only objects select as anchors

FILTER: some useful predefined filters to remove objects based on their features, and 
access to a full control filter tool and to reload the original data.

• Quickly remove objects that are touching the borders of the image, as they are surely 
incomplete.

• Quickly remove objects based on size or sphericity
• Quickly remove non-colocalizing objects
• Quickly find pairs of objects, inside the same pipe or by combining the two pipes.
• Advanced filtering shows the same filter dialog explained in “Table and Analysis 

Shortcuts (19)” on page 161.

HELP: shows on-line help and tutorials

Mouse Modes (2)
These buttons control the Mouse mode, this defines the mouse functionality when you 
left-click on the image.  Hoovering your mouse over these buttons allows you to get a tip 
on what they are for. If they have a keyboard shortcut, this is also shown in the tooltip. 
For example, the first mouse mode is intended to analyze objects, and you can always 
activate this mode from within the rendering view by pressing the keyboard key ‘1’.

From left to right, and from top to bottom, the mouse modes are:

•  Analyze object lets you click on different defined objects and obtain the local sta-
tistics.

•  Select area lets you define a 2D region on the current view of the image. This 
allows you to analyze or discard objects below it, anchor them as references, or inter-
actively define regions of interest (ROI). We will see what all this is useful for.
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•  Discard object lets you discard irrelevant objects one by one. Just select this 
mode and click on the uninteresting objects.

•  Select object (as anchor) lets you select and deselect objects to be ‘anchors’, for 
example to act as references to measure distances from other objects with respect to 
the anchor object. When you set an object as a reference anchor it will ‘light up’ and 
change color on the screen to indicate the anchor status. It is possible to select a 
group of anchor objects, and you can operate with them through the Anchors menu.

•  Rotate scene interacts with the full image to rotate it in the space, by dragging the 
mouse pointer on the rendering view. That can also be achieved by moving the Tilt 
and Twist sliders along the rendering.

•  Pan scene interacts with the full image to move it in space laterally. This means 
that you can pan the scene in the 2D plane of your screen,

•  Pan canvas This mode allows you to explore the canvas while not re-rendering 
the scene. This only makes sense when you have a canvas larger than your rendering 
window, See OPTIONS→VIRTUAL RENDER SIZE in the top menu.

•  Shift the ROI. This is the only mouse mode that is not always enabled: you need 
to have defined a region of interest (ROI) before moving it around.

For the advanced users: some of these mouse modes have 'shortcuts'. Most of the times 
you can 'pan scene' independently of the selected mouse mode if you use your mouse 
right button instead of the left one. Similarly, you can 'pan canvas' using the middle but-
ton at any time. When a mouse mode is active and the cursor is inside the canvas, the 
tooltip in the status bar (See Figure 25.1, item 23) shows you what each mouse button 
can do.

Selection Interactive Operations (3)
The rest of the buttons in the toolbar are not mouse modes, but they execute operations 
on previously defined conditions. For example, deleting the objects inside a defined ROI. 
They are all disabled until these conditions have been set (in the example, until you 
define a ROI to operate with).

After having drawn a 2D selection (See “The Selected Area (9)” on page 157) in the 
Select area mouse mode, you can click on:

•  Keep all objects under the selected area, discarding anything else.

•  Discard all objects under the selected area

•  Set all objects under the selected area as anchors

Some objects may partially cross the border of the defined ROI. These can be considered 
to be either in- or outside the ROI. You can change this definition in the top Options 
menu: the area can consider only objects fully under the selection, or also objects par-
tially outside it (relaxed selection mode). In any case, the objects not affected by the 
selection are rendered with a lower intensity to clearly indicate which objects are 
selected.

When you have selected certain objects as anchors, you can apply further opperations:

•  Deselect all anchors.
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•  Keep the selected anchors, discarding anything else.

•  Discard the selected anchors.

More operations are available at the top ANCHORS menu. The main purpose of an anchor 
is to serve as analysis reference in some experiment presets, for example to measure dis-
tances relative to these anchor objects. But you can also use the selected anchors to delete 
some other objects, or define a 3D ROI based on the anchor object shape. When you 
have defined a ROI, you can add/subtract new ROI shapes, or perform additional opera-
tions with the ROI Interactive Operations buttons:

ROI Interactive Operations (4)

•  Reduce the current ROI to the volume under the selected 2D area (intersects the 
ROI with the selection)

•  Add the volume under the selection to the ROI volume (union of the ROI with 
the selection).

•  Remove the volume under the selection from the defined ROI (difference of the 
ROI with the selection).

•  Set all objects inside the ROI as anchors.

•  Keep objects inside the ROI, discarding anything else.

•  Discard the defined ROI, reverting to the whole image.

Data Cropping and Restore Operations (5)

•  Once a ROI is defined, you can use this button to crop the dataset and delete (set 
to zero) all voxel values outside the ROI.

•  Export the current data (as cropped by the ROI, or after deleting objects interac-
tively) to the original image.

•  If deleted data was not yet exported to overwrite the original, you can always 
reload the original dataset with this button.

•  Undo last operation.

Active Pipe Mode (6)
These radio buttons control, on which of the active data pipes (Pri-
mary, Secondary or both) and channels (Selected pipe, or All) they 
operate. Pipes are explained in “Render Pipes (15-16)” on page 159.

Examples of operations controlled by these buttons are:

• Interactively clicking on objects. When you click on the scene, only objects in the 
active pipe are considered.

• Analyze all / Analyze selection
• Set ROI to the visible objects
• Sum all column values (when hovering over a column header in the table)
• Apply the ROI to crop the dataset
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There are only a couple of practical differences between the PS and All modes:

When cropping data by applying a ROI, you can crop the channel in the Primary pipe 
(P), the channel on the Secondary pipe (S), on both (PS), or all channels in the image 
(All), even if they are not shown in any active pipe.

When summing cell values in a column of the table, you can include in the summation 
cells for the channel in the Primary pipe (P), the channel on the Secondary pipe (S), both 
(PS), or all cells (All), including those reporting about the ROI.

For all the other operations, the PS and All modes are equivalent.

Reference Cube (7)
At the end of the buttons column you can notice a colored reference cube that 
will help you to orientate in space when you rotate the dataset, specially with 
large zoom factors that do not let you see the surrounding box frame in the 
rendered image. The initial view of this cube is the blue top face corresponding 

to . Hovering the mouse over the cube faces brings a tooltip with the face label (x, 
y and z with values 0 or 1).

The Interactive Rendering Canvas (8-11)

The canvas shows the scene, the result of the ray tracing1 algorithm rendering the seg-
mented objects.

The scene is determined by the objects orientation (tilt and twist), the zoom, the bright-
ness of the pipes, what point is centered on the view and so on. All these parameters are 
taken into account by the renderer, which generates the scene and displays it in the can-
vas on the screen. Notice that depending on the render size 
(OPTIONS→VIRTUAL RENDER SIZE) the canvas can be made larger than your screen.

The On-Screen Reported Parameters and Tooltips (8)
The currently selected Experiment preset (See “Experiment Presets 
(17)” on page 160) selects the statistics to report many parameters 
to the table (See Figure 25.1, item 20, 21, and 22) A few of these parameters can be also 
reported on the screen for the current object for easy reading. The magnitude of the dis-
tance that is plotted on the screen is indicated by a triple dash ‘---’

The Selected Area (9)

The Select area  mouse mode allows you to define a region in 
the image. So for example you can: analyze objects ‘inside’ the 
ROI, anchor them as references, or use the selected volume to 
define a region of interest (ROI).

The selection is not yet a 3D ROI, but a 2D area. That is why ‘inside’ is quoted in the pre-
vious paragraph: objects are inside the selection only from the current point of view, so it 
would more appropriate to say ‘below’ the current selection. It allows quick and simple 
interaction with the objects, specially on flat images here the objects remain more or less 
in a plane. 

1.http://www.svi.nl/RayTracing

z 1=
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In the Select area mouse mode you can use the right mouse button to shift the defined 
selection around and reuse it multiple times in different locations.

Anchor Objects (10)
Objects that act as references (anchors) are shown in the rendering with 
magenta or violet colors, depending on the pipe they belong to, so that 
they are clearly distinct from the other objects.

There are different ways to set objects as anchors, interactively (See 
“Selection Interactive Operations (3)” on page 155) or by using filtering 

operations (top ANCHORS menu). You can also visit the on-line article about anchor 
objects for more details on their utility.

Aim (11)
Objects under your cursor are highlighted. Once a certain object is 
analyzed, the object will also show a red box surrounding the object.To 
analyze an object just click on the object with the Analyze object mouse 
mode, or press the ANALYZE ALL button (See Figure 25.1, item 19).

Objects in the Primary pipe are framed with a red box, and objects in 
the Secondary pipe with a green one.

A small label showing the object's number ID is also shown when pointing at it. The 
background color also indicates if it belongs to the primary (red) or the secondary 
(green) pipe. Yellow labels are shown whenever the pointer has two objects below it, 
from different pipes.

If a distance is configured to be reported on-screen (See Figure 25.1, item 8), it is also 
plotted when pointing to an object.

If you hover over an object’s row in the table and point to a cell containing a distance 
parameter, it will also be plotted on the rendering canvas. Like this you can interactively 
explore many reported distances.

Notice that, depending on the active pipe mode (See “Active Pipe Mode (6)” on 
page 156), the interaction with the scene may highlight and affect objects in one pipe 
only.

Scene Control Sliders (12)
Three sliders run along the canvas (vertically, on its right, and horizontally, on its 
bottom) to control the point of view of the scene:

•Zoom: the number is just indicative, 1 meaning that the whole dataset is shown 
in the canvas.
•Tilt: the angle of rotation (in degrees) around the canvas x-axis.
•Twist: the angle of rotation (in degrees) around the image z-axis.

By clicking on the labels you can enter numerical values manually to quickly 
switch to the desired scene.
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Hide Pane Button (13)
This button at the top right of the window collapses the control pane to make 
more room for the rendered scene. Once you have defined the segmentation 
conditions for all pipes, you don't need to interact with those controls anymore, but with 
the objects, so you can hide the pane to focus on the scene.

Time frame selector (14)
When time series are loaded in the OA, this slider 
controls which time frame is take for visualization 
and analysis.

Changes to the current frame (like discarding objects or selecting anchors) are remem-
bered when you change the time frame. But voxel editions (using the ROI to crop the 
dataset) are lost unless you export them first with Export the applied ROI to original 
( ).

You can analyze all frames in a time series, accumulating the data in the table, through 
the FILE→ANALYZE TIME SERIES menu entry.

Render Pipes (15-16)
The Huygens Object Analyzer has two surface pipes 
(named Primary and Secondary pipes) for you to put 
image data through for object analysis and another 
pipe to simultaneously visualize a MIP of one of the 
channels (See Figure 25.1, item 16).

‘Secondary’ does not mean here ‘less important’, it is 
just that you can use the first pipe (Primary) and the 
second pipe (Secondary), abbreviated P and S . We 
keep numbers to refer to image channels, which is 
something different, because in each of these pipes 
one can put any image channel, in any order. One can 
even segment the same channel twice with different 
conditions in each of the pipes if necessary!

This pane controls which data channel goes through which pipe, how its objects are seg-
mented (with a seed and a threshold2), and how the data is rendered (transparency and 
brightness). A garbage volume can also be set to remove little spurious objects: objects 
with a volume smaller than this garbage volume will be discarded and not rendered.

You can see the seed as a secondary threshold. The first threshold segments the data and 
makes independent objects, but then only objects with intensity that reaches above the 
seed level will remain, while the rest are discarded.

At start-up, the threshold and seed levels are represented by vertical blue and magenta 
lines, respectively, on top of a histogram of the channel in the pipe. An alternative repre-
sentation of these levels is also vailable. This alternative representation also show their 
values as a percentage of the channel maximum and allows you to link the seed with the 
threshold.

2.http://www.svi.nl/SeedAndThreshold
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The garbage volume control is also in the slider pane, 
not in the histogram. To switch between the histo-
gram and the sliders control panes you have to click 
on the small button ( ) at the right of the pane title.

The threshold ranges between the minimum and the 
maximum values in the channel intensities, consider-
ing all the time frames. Its percentage representation 
refers to the maximum value.

By default, the seed is linked to the threshold value, so when you vary the latter, the seed 
absolute value also changes in such a way that its relative value remains constant. In its 
linked mode, the seed is set referred to the span between the actual threshold and the 
maximum, and ranges from the threshold value itself (0%) to the image maximum 
(100%). This is because the seed, being an 'upper threshold', can never be lower that the 
threshold. It is also useful to be able to set the seed to 0% so that it is not used at all and 
you retrieve the classical threshold-only segmentation. Still you may find convenient to 
express the seed relative value in the same terms you use for the threshold (relative to the 
image intensity rage), or to be able to set the seed to a fixed value independent of the 
threshold. For that, deselect the seed checkbox so that 0% also represents the same value 
as the 0% threshold (the image minimum, or zero), and the two sliders are unlinked. The 
linking mode of the seed does not really affect the segmentation, it is just a matter of 
convenient representation of relative values: what is applied to the image as threshold 
and seed are always the absolute numeric values shown on the entry widgets and next to 
the histogram lines, that you can edit directly by clicking on them.

All the different objects in a pipe are colored differently to distinguish them. The range 
of colors assigned to each pipe can be controlled with a Hue Selector (See “Hue Selector” 
on page 196.). You can collapse this range completely if you want so all objects in a pipe 
get the same color.

Experiment Presets (17)
This button opens a preset selection dialog 
that allows to select an experiment preset, a 
collection of parameters that make sense to 

be reported together in the context of certain experimental needs (See Figure 23.8 on 
page 142).

Users are very much welcome to send their own suggestions to implement new presets. 
We will gather all the feedback in different wiki articles that will explain what parameters 
are best for certain experiments and how to interpret them. Please feel free to tell us 
about your experiences!

In this dialog you can notice three columns. On its left column a series of different 
experimental needs are listed. When you click on each of them, a different list of param-
eters is listed in the middle column, and a description is shown on the right column. 
Even more, when you hover with your mouse over the listed parameters, a tooltip will 
appear, explaining each parameter with more detail.

By selecting a particular preset all the listed parameters (apart from the basic ones) will 
be reported and calculated. Moreover, all the listed parameters will also be available for 
filtering the objects (See “Filtering Objects” on page 161). The check boxes allow a few of 
these parameters to be also reported on the screen (See Figure 25.1, item 8) for the cur-
rent object. The magnitude of the distance that is plotted on the screen is followed by a 
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triple dash ‘---’. Only one distance can be plotted at a time by clicking on an object, but 
many can be reported on the table and explored interactively there by simply moving the 
cursor over the cells.

Only one preset can be selected at a time, and all its parameters will be reported. 
Advanced and more flexible configuration of the parameters is always possible through 
OPTIONS→CONFIGURE STATISTICS REPORT in the menu. In this configuration dialog users 
can also store any set of reported parameters as a new preset.

General Object Information (18)
This little bar reports:

• left: the number of objects currently segmented in each surface pipe.
• right: the total number of objects selected as anchors.

Table and Analysis Shortcuts (19)
These widgets provide quick access to some table operations.

• Auto clean checkbox: this option makes the table to be cleaned whenever the seg-
mentation or analysis conditions change, to always have a fresh start. Deselect this 
option to keep all data and keep accumulating rows in the table.

•  Clear statistics table: manually delete the table contents

•  Filter: opens a dialog that allows you to filter objects out based on the reported 
parameters (see below).

•  Analyze all / Analyze sel.: This button runs the analysis procedure on all the cur-
rently segmented objects, for objects on the pipes selected by the Pipe mode radio-
buttons (See Figure 25.1, item 6). When a 2D area has been selected (See Figure 25.1, 
item 9) this buttons analyzes only the objects under the selection.

Filtering Objects

The Filter button  opens a pop up dialog that allows you to discard objects:

• Based on any of the reported parameters...
• Using a certain arithmetic operator...
• To compare the parameter with either a fixed value or with another reported param-

eter

The pipes that are filtered can be controlled with 
the active pipe radio-buttons.

You have to select one of the two options (fixed 
value or another parameter) and enter the value or 
select the parameter you want to compare with.
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Because the filter is based on the reported parameters, you may need to configure the 
reported parameters or select other statistics first in order to filter based on the desired 
property.

For interesting usages of this filter, see for example the neighbors article in the SVI 
Wiki3.

For time series, an additional button allows filtering all time frames.

Statistics Table (20-22)
The statistics table is the place where all the objects parameters are reported after the 
analysis. You can explore the table values in interesting ways directly on the Object Ana-
lyzer (see below), or export the contents for further analysis in other program.

When you move your mouse over the table rows, the objects they refer to are highlighted 
on the rendering canvas. When you point to a cell reporting a distance, this distance is 
also plotted on the screen.

The contents of the table can be copied to your clipboard, or stored to a file on your disk 
by using the FILE menu.

The Table Columns and Their Headers (20)
When you move your mouse over the column titles at 
the top of the table a description of each parameter 

will be shown at the very bottom of the window (See Figure 25.1, item 20). You can 
always find out what each parameter is by looking at its tooltip. The description of each 
parameter will be also stored in your file when you export the table later.

This brief parameter description, plus longer explanations are also given in the selection 
and configuration dialogs that selects or configures the reported parameters.

For columns with numeric values, basic descriptive statistics of all values in the column 
are also reported along with the parameter description. You can select whether the sum 
runs for both pipes (ALL or PS) or only for one of the pipes (P or S) depending on the 
selected pipe mode (See Figure 25.1, item 6). This provides a quick way of finding the 
total number of voxels in the object list, or those that are colocalizing, for example. Many 
interesting questions can be answered by the summations and ratios between them.

You can right click on a column to pop-up a contextual menu, from which you can 
retrieve more detailed statistics (STATS) for that column. The descriptive statistics will 
analyze pipes separately and together, and also include ROI information if present. The 
reported values are the maximum (MAX), the median (MED), the minimum (MIN), the 
number of items considered (N), the summation of the values (SUM), the average value 

3.http://www.svi.nl/ObjectAnalyzerNeighbors
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(AVG) and the standard deviation for the N items (SD-N), reported also as a percentage 
relative to the average value.

Clicking on a column title selects 
the whole column for you to copy. 
Multiple columns can be selected by 
holding the Ctrl key. To plot a his-
togram of the distribution of values 
in a column, select the column (or a 
subset) and select Histogram from 
the pop-up menu.

Selected columns also act as ‘special 
parameter selector’. The value of the 
parameter for selected columns will 
be reported on the status bar (See 
Figure 25.1, item 23) when you 
explore cell values for given objects. 
Like this, you can quickly compare different parameter values for the same object, by 
looking at the report in the status bar while you move your mouse over the table cells.

A similar thing can be also done by selecting rows, see below.

When multiple columns are selected, the STATS popup dialog will report descriptive sta-
tistics for all them.

Conditions Report (21)
When new segmentation or analysis conditions are set, they are reported when you ana-
lyze one or all objects. One row is added to describe the image and the time of the analy-
sis, and another row per active pipe is added that reports the image channel in that pipe, 
the segmentation conditions, the number of objects in that pipe, and the volume and 
geometrical center of mass of the ROI:

# Conditions:  pipe 0 chan 0: thresh 504.8, seed 540.52,   
garb. 1, objects 12. ROI: vol 1103 um^3, CM (130, 115, 
10)

The parameters about the ROI (volume and CM) are the same for both pipes, in case two 
are active. This is because there is only one ROI for all pipes and channels, and the Cen-
ter Of Mass (CM) here reported is calculated considering the ROI as a uniform, solid 
object.

There is another way to calculate the CM of the ROI, not considering it homogeneous 
but taking into account the real image intensities in envelops. These intensities, being 
different per pipe, yield to different ROI's CM per pipe. This is not reported in the condi-
tions rows, but as object rows in the table when you select Analyze all. In this case, the 
ROI itself is treated as a new object in each pipe and more detailed information is 
reported in separate rows in the table. See the wiki article about ROI4.

4.http://www.svi.nl/ObjectAnalyzerROI
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The Table Rows, How to Explore Them (22)

Each row in the table is either a Conditions report (See “Conditions Report (21)” on 
page 163) or information about one of the segmented objects.

In the second case, the object the row refers to is identified by some mandatory parame-
ters (parameters that are always reported):

• Label: an integer index that is unique, per object, inside its pipe.
• Chan: the image channel this object belongs to
• Surf: the surface pipe in the current analysis the object belongs to (P is Primary, S is 

Secondary).
• Voxels: the number of voxels in that object
• C.Mass: three columns (x, y, z) for the center of mass location of the object, in the 

image coordinate system, with voxels as units.

The second letter in the Surf. column informs whether the object you clicked was in the 
front (F) or the back (B) position. This is only relevant in the following situation: it may 
happen that two objects in different pipes overlap in space (or they apparently do from 
the current point of view) and when you click somewhere on the screen you are actually 
selecting both of them, if the pipe interaction mode is PS or ALL (See “Active Pipe Mode 
(6)” on page 156). In that case, two rows are added to the table, and this second letter lets 
you know which of the two was in front of the other, from the current point of view.

By moving the mouse over the table rows the corresponding object is highlighted on the 
canvas (See Figure 25.1, item 11). Objects in the Primary pipe are highlighted in red, and 
objects in the Secondary pipe in green.

A quick way to find the parameters of an object in a very long results table is by clicking 
on it on the rendering canvas while the Analyze object mode is active: the table will be 
shifted to show its corresponding row, which will be highlighted.

When you move over the table cells the current value is shown on the tooltip bar at the 
bottom (See Figure 25.1, item 23). This, combined with the selection of rows (see below) 
or columns (See Figure 25.1, item 20), allows a quick exploration of the table and the 
comparison of different parameter values.

In the following example, when the cursor is moved over one cell that contains the dis-
tance to the first neighbor, the following is reported in the tooltip: 38/S 1NP.CMCM: 
4.2358 um. The first part is the label of the object in the current row: label 38 on the 
Secondary pipe. Then the parameter tag 1NP.CMCM refers to the CM-to-CM distance 
between this object and the nearest object in the other pipe. The value of the distance 
itself is alsoo shown: 4.23 microns.

That tooltip region can also show other values that can be used as reference. Try this: 
while keeping the Ctrl key pressed on the keyboard, select a couple of rows by clicking 
on the row number at the very left of the table. The selected rows will turn green. If you 
now hover the mouse over a cell on any other row, you will get the value not only of that 
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cell, but also those in the corresponding cells of the selected objects (rows). This is a 
quick way to compare results for different objects that can be well seperated in the table.

If you select columns instead of rows in the table the tooltip will display the correspond-
ing parameter values for the same object. It is possible to highlight columns and rows at 
the same time but this is confusing to interpret, and thus not recommended.

The Status Bar and Tooltip (23)
The bottom part of the window is a status bar that also shows an contextual tooltip.

The left side reports the current status of the renderer and analyzer. You can see whether 
a long computation is running or if the analyzer is ready for further interaction.

Then the current size of the canvas is reported. When you first start the OA, the canvas 
size is adapted to the exact room left for the scene rendering, but it can be larger or 
smaller at wish (OPTIONS→VIRTUAL RENDER SIZE).

The ‘Dragging’ status refers to the automatic rendering of the scene while the user inter-
acts with the scene. In slower systems, the dragging is turned off automatically and the 
rendering only happens after the user released the mouse buttons or finished moving the 
segmentation sliders.

The tooltip (the region with light yellow background) shows contextual information:

• A more detailed description of the reported parameters when you hover over the 
table headers (See Figure 25.1, item 20) and a sum of the cell below them.

• The value in the cell under the cursor when you point at table rows, plus selected ref-
erence values.

• The different actions bound to the mouse buttons, when the cursor is inside the ren-
dering canvas.
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How to use the Colocalization Analyzer
CHAPTER 26 The Colocalization Analyzer

The Colocalization Analyzer provides information about the amount of spatial overlap 
between structures in different data channels, for 3D images and time series.

This overlap can be defined in various ways; Huygens supports the colocalization coeffi-
cients most commonly used in literature: (Object) Pearson, (Object) Spearman, Overlap, 
Intersection, and Manders M and K. The SVI Wiki provides extensive information on 
these coefficients1,2.

The Colocalization Analyzer works in two steps: First, it searches for colocalizing regions 
in the complete image and calculates the coefficients values. Then in the second step it 
segments these regions and treats them as objects required for further visualization, and 
for the analysis of the object-based coefficients. 

Note that the Object Analyzer module (See page 135) also provides a form of colocaliza-
tion measurement which complements the functionality of the Colocolation Analyzer.  
Whereas the Colocalization Analyzer takes the whole image into account, the Object 
Analyzer works at the object level; it first segments the image into objects and then 
determines if these objects colocalize.

The Colocalization Analyzer is an optional module, and is enabled by the C flag in the 
license string (See “License String Details” on page 202.).

How to use the 
Colocalization 
Analyzer

To start the Colocalization Analyzer in Huygens Professional, right-click an image 
thumbnail to open the contextual menu, then select ANALYZE → COLOCALIZATION ANA-
LYZER. Alternatively, select a thumbnail and select in the menu bar ANALYSIS → COLO-
CALIZATION ANALYZER. The image must be a multi-channel image (See “Multi-channel 
Images” on page 41.) as colocalization is based on the overlap of different channel inten-
sities. Wait for the analyzer to initialize and to compute the 2D histogram with the 
default settings.

1. http://www.svi.nl/ColocalizationTheory

2. http://www.svi.nl/ColocalizationCoefficients
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When the colocalization analyzer is opened you will see three main tabs (See 
Figure 26.1), of which the first is visible. In this tab the colocalization coefficients can be 
calculated. You can choose the time frame, select colocalization coefficients, set the 
background settings (See “Background Estimators” on page 172.), select a mask image 
(See “Selecting a mask image” on page 174.), select a reference image for RBNCC (See 
“RBNCC” on page 174.) and choose a colocalization map (See “The colocalization map” 
on page 169.). On startup, all these settings are set to the default values, so you can 
immediately press COMPUTE. 

First we select the data to analyze. For time series, the Frame slider selects the time coor-
dinate. In the lower part of the window we can select which data channels from our 
image we want to use. For the channels we follow the usual naming convention in colo-
calization theory: Red (R) for the first channel, Green (G) for the second channel.

 Whenever we change the Red or the Green channel selection a two-dimensional histo-
gram is calculated. This histogram provides an rough indication of the degree of overlap 
between the selected channels; for two channels with a high degree of overlap, the histo-
gram pixels concentrates along the diagonal  line. In contrast, total absence of 
overlap would produce a 2D histogram with values only on the coordinate axes. The his-
togram can give an indication of some image defects such as clipping, hot pixels, and 
dynamic range differences. For more information on the 2D histogram see the SVI 
Wiki3.

Along the x and y line of the 2D histogram, there is a separate 1D histogram for each 
color channel. Clicking the SHOW HISTOGRAM PER COLOR CHANNEL button near the top-
right corner of the histogram shows enlarged versions of these histograms. 

3. http://www.svi.nl/TwoChannelHistogram

FIGURE 26.1. The first tab of the Colocalization Analyzer showing the 
colocalization coefficients and histograms.

y x=
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The colocalization map
By moving the colored background lines in either the 2D-histogram, the enlarged 1D-
histograms, or by changing the numeric values in the input fields, These values are sub-
tracted from the voxels intensities when calculating the coefficients (if the result is nega-
tive, it is understood as a zero). Generally the colocalization coefficients depend much 
on correct estimation of the image background and resolution. For these reasons we 
strongly recommend to compute colocalization coefficients only on deconvolved images.

One sets a background value prior to the calculation to remove signal that would other-
wise lead to spurious colocalization. This is intended for minor tuning, or just in case it 
is really needed to calculate colocalization in raw images that still have all the measured 
background. See “Backgrounds vs. thresholds in colocalization” on page 171.. 

The colocalization 
map

Next we select what colocalization map we want to calculate: (Object) Pearson, (Object) 
Spearman, Overlap, Manders M or K or Intersection. You can find the selector at the bot-
tom of tab 1 next to the COMPUTE button.

Notice the difference between maps and coefficients: the colocalization coefficients 
parametrize the degree of colocalization of the full image, while a colocalization map 
parametrizes the colocalization locally. In a map, a single colocalization value is calcu-
lated per voxel creating a 3D distribution that is represented in a 3D image by iso-sur-
faces. In other words, the colocalization map shows the contribution of each voxel to the 
colocalization coefficient.

The Colocalization Analyzer computes only the map selected by the user, but it always 
computes the selected coefficients. When the COMPUTE button is pressed, the pane colo-
calization coefficients will show the selected colocalization coefficients for the selected 
time frame. If you have checked the COMPUTE ALL option next to the time frame slider, 
the coefficients will be calculated for all time frames sequentially.
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Your choice of the colocalization map is needed for the functionality in the second tab 
(See Figure 26.2). In this tab an iso-colocalization surface is generated based on the colo-
calization map. This iso-surface rendering is only possible if a colocalization map exists. 
So, at startup the iso-colocalization surface sliders are deactivated, as we have to calculate 
a colocalization map first, by pressing COMPUTE.

Together with a surface renderer a MIP renderer is available. The viewpoint of the MIP 
and surface can be selected by moving the Tilt and Twist slide. Also try changing the 
zoom.

The obtained colocalization map is represented in the renderer window by iso-colocal-
ization surfaces. These iso-surfaces represents points which all have the same colocaliza-
tion value, thus regions in which the degree of colocalization exceeds a certain value 
become objects. This “certain value” can be controlled by the threshold slider in the iso-
colocalization surface parameters. The transparency and the brightness of this surface 
pipe can be controlled with the correspondent sliders. The color range in which the 
objects are displayed can be modified using a hue selector (page 196). One can also 
switch the surface pipe off.

Some modes generate two-channel colocalization maps: colocalization of red with 
respect to green, and vice versa, e.g. in case of the Manders M1 and M2 coefficients. In 
these cases, the iso-colocalization surface parameters will offer the possibility of render-
ing any of the two channels, and thus the threshold is referred to the active one.

By clicking on the rendered objects local colocalization parameters are computed and 
reported, which will be discussed in more detail in “Iso-colocalization object analysis” 
below.

There is one Maximum Intensity Projection (MIP) pipe available to redirect the data 
channels to. The MIP rendering of one channel (maybe one different from those used for 
colocalization) or the two channels under analysis can be a good spatial reference for the 
objects from the colocalization map. When an original channel is selected, the threshold 

FIGURE 26.2. Tab two of the Colocalization Analyzer shows surfaces for regions of 
overlapping channels.
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Iso-colocalization object analysis
slider can be used to select what voxels are considered for the MIP rendering, depending 
on their intensities. Notice that here the threshold is simply used for representation. If 
both R and G channels are selected to be rendered, their correspondent backgrounds as 
selected in the histogram will be used as projection thresholds. As with the surface pipes, 
the transparency and the brightness of this MIP can also be controlled.

All the obtained information can be saved to external data (text or image) files through 
the FILE menu.

Iso-colocalization 
object analysis 

One of the features of the colocalization analyzer is iso-colocalization object analysis 
(Figure 26.3 on page 171). It allows to determine quickly the properties of the different 
colocalization regions in the data. This is realized by visualizing the colocalization map 
as iso-colocalization surfaces. In this way regions in which the degree of colocalization 
exceeds a certain value become objects. By clicking on the objects local colocalization 
parameters are computed and reported. To relate the iso-colocalization objects to the 
original data the surface objects can be blended with a MIP projection of the data (See 
“The MIP Renderer” on page 75.). The color range in which these objects are displayed 
can be modified using a hue selector (page 196).

Backgrounds vs. 
thresholds in 
colocalization

Backgrounds are for removing signal prior to the calculation. In an ideally restored image 
that would not be necessary, because all the signal present in the image gives a valid rep-
resentation of it. The background would have been removed during the image resto-
ration. 

Thresholds are used to split the colocalization maps in two regions: what are interesting 
regions, and what are not. Local colocalization values are calculated for every image 

FIGURE 26.3. Tab three of the Colocalization Analyzer if for object analysis for the 
colocalized regions of the colocalization map.
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voxel, but the zero value would be very rarely achieved. In most of the cases there are 
some non-zero colocalization everywhere, the interest probably is in regions where colo-
calization exceeds typically a value of 20 % of the maximum.

With the background settings, voxels are in- or excluded based on their voxel intensities: 
intensities higher then the background are kept, while lower intensities are disregarded 
for the calculation. Note, the intensity value of voxels do not relate to the level of colocal-
ization. In fact, it may well be that high colocalization levels occur in regions with low 
voxel intensities. 

Therefore, background settings should not be used to remove signal that can still have 
some colocalization level. Ideally work with deconvolved images and consider all the sig-
nal, then study the colocalization levels using thresholds to split regions of high colocal-
ization from regions with low colocalization, something that can not be know 
beforehand! Setting the background is used for removing really constant background 
signals. 

Thresholds do not affect colocalization, but only the way colocalization maps are repre-
sented on the screen and regions of interests (visualized as surfaces) are defined. 
Depending on the locally calculated colocalization surfaces may merge or split. What 
affects colocalization, as explained in the colocalization theory at the SVI Wiki, are the 
backgrounds. In the computation of Manders coefficients the background values act like 
in this example: to the computation of M1 only pixels in R contribute when their corre-
sponding pixel in G is above the background.

More information can be found at the SVI Wiki4.

Background 
Estimators

The Colocalization Analyzer consists of a number of background estimators. They are 
meant to help to determine the correct background setting to compute the colocalization 
coefficient. As is explained in the previous section “Backgrounds vs. thresholds in colo-
calization” the background setting affects the colocalization analysis.

The background estimators are:

• Gaussian minimum
• Costes method
• Optimized search

Gaussian minimum
The gaussian minimum is the simplest background estimation method. The background 
setting is the minimum intensity value after applying a gaussian filter on the image. 
Before the extension of the Colocalization Analyzer with the background estimations, 
this method was used as an initial setting. This method is fast, but maybe too simple. In 
case of image with not too much noise, this method is good enough.

Costes Method
The Costes method is based on the estimation explained in article “Automatic and Quan-
titative Measurement of Protein-Protein Colocalization in Live Cells” by Sylvain V. Costes, 

4. http://www.svi.nl/ColocalizationAnalyzer
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Background Options
Dirk Daelemans, Edward H. Cho, Zachary Dobbin, George Pavlakis and Stephan Lock-
ett, Biophysical Journal, volume 86, June 2004 (3993-4003).

They explain an automatic background searching algorithm within a 2D histogram over 
the linear regression line. This regression line is calculated with the least squares line fit 
algorithm. Each point on the regression line is a combination of background values for 
the red and green channel. Starting with the highest intensity value for red, the back-
grounds are decreased, in such a way that the points lie on the regression line, i.e. points 

 for a decreasing r with a the slope and b the intercept of the regression line. 
This process stops when a point is reached for which the Pearson’s coefficient of the area 
below the background settings is zero (or closest to zero).

Because this method searches the regression line from high to low, it may take some time 
to reach the desired point.

Optimized search

This method is an extension of the Costes method, but where the assumption that the 
ideal background combination lies on the regression line is dropped. This method uses 
an iterative process to search the whole 2D histogram to find the point where the Pear-
son coefficient of the area below the background settings is zero.

This method is more precise, but could also take more time to reach the desired point. 
This iterative process however uses a smart searching algorithm, for which is known to 
quickly convert to a solution.

For both the Costes and the Optimized search it is assumed that the noise in the image is 
poisson distributed, because the Pearson coefficient of two poisson distributions is zero.

Background Options Besides the background estimators, there are some additional options to set the back-
ground settings, especially for different time frames.

• Stop: This button is disabled by default, but when an estimation method is started, 
the costes or the optimized, the process can be stopped by pressing this button. This 
will not cancel the process and it will return the background settings, which is found 
before you pressed Stop.

• Delete: This will delete all the background settings for all time frames at once and sets 
them at the minimum values of the time frame.

• Clone: In case the background is correctly set for a time frame, this will copy the exact 
background settings to the other time frames.

• Reset: This will reset any manually changed background of the current time frame, 
back to the estimated background setting of the selected method.

• Recalc: To redo the estimation process, which could be useful for the costes and the 
optimized method.

r ar b+ 
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Selecting a mask 
image

A mask image can be selected 
to calculate the colocaliza-
tion in a region of interest 
(ROI). The mask option can 
be enabled by selecting the 
Mask tab and pressing on the 
red button on the right. It will 
change to green to denote it is 
enabled. When the mask option is enabled, it is required to select an image that meets 
the dimensions of the original source image. When you hover over and click on the 
image name, a different image can be selected. The mask image should already be 
opened in the main window of Huygens Professional.

The mask image may only contain 1 channel. Whether the mask image meets the criteria 
is reported at Info. You can hover over the hightlighted image parameters to read the 
tooltip in the statusbar to see what is wrong.

Once all the criteria are met, simply press the COMPUTE button to only calculate the colo-
calization in the area denoted in the mask image. The mask image used for the analysis is 
also reported in the table.

RBNCC The colocalization analyzer is extended with Replicate-Based Noise Corrected Correla-
tion (RBNCC). Noise causes difficulties around colocalization analysis, since noise also 
introduces colocalization. This can be handled by using a background threshold, which 
is explained in the previous subsections, but when the noise is quite severe a threshold 
may not be sufficient. 

With the RBNCC algorithm one can correct for noise that contributes to the underesti-
mation of the colocalization coefficients, Pearson and Spearman coefficients. The 
RBNCC method has been developed by J. Adler, S.N. Pagakis and I. Parmryd from 
Uppsala University; Journal of Microscopy 230, 121-133; 2008. More information can be 
found at the SVI Wiki5.

Colocalization coefficients are calculated and directly corrected with RBNCC when this 
option is activated. To use the RBNCC method a license with the RBNCC option is 
required.

When RBNCC is activated in the license, then within the RBNCC tab a button shows red 
when the RBNCC is disabled and green when it is enabled. If the button shows grey, the 
license is insufficient to work with RBNCC.

With RBNCC enabled, a ref-
erence image can be selected 
by hovering over and clicking 
on the visible image name, see 
Figure 26.5 . The reference 
image should already be 
opened in the main window 
of Huygens Professional and 
should have the same dimensions as the original. Whether the reference image meets the 

FIGURE 26.4. The mask option enabled with 
information about the mask image parameters.

5. http://www.svi.nl/RBNCC

FIGURE 26.5. The RBNCC option is enabled and a 
reference image can be selected.
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RBNCC
criteria is shown at Info and hovering over any highlighted parameters shows a tooltip in 
the statusbar what is wrong. When the reference image is selected, simply press COM-
PUTE and the coefficients will be corrected automatically.

The correction factors applied to the coefficient are shown in the RBNCC frame, where 
the abbreviations stand for a specific coefficient:

• S: Spearman coefficient
• P: Pearson coefficient
• OS: Object Spearman coefficient
• OP: Object Pearson coefficient
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Why performance tuning
CHAPTER 27 The Performance Tune Wizard

Why performance 
tuning

Huygens uses multi-threading to speedup the image processing algorithms. Normally, 
Huygens uses the maximum amount of cores as specified by the license (type of server 
option), and available in a system as the default number of threads. This means that, 
under normal circumstances, all the allowed number of cores will be used simultane-
ously. During processing, Huygens competes for CPU time with all other programs in 
the system. Since the threads of Huygens perform the image processing in close collabo-
ration, there will be a severe penalty if one or more of the threads can't run on the CPU 
at a given time because other software (e.g., an office suite, web browser, virus scanner) is 
already running on CPU. In such a case, it is more beneficial to let Huygens not use all 
cores so that interference with other software is reduced. This is just one of the reasons 
why it might be more beneficial for Huygens performance not use all the cores. There are 
several others arguments for this, but they lie beyond the scope of this manual.

The Performance tune wizard will execute several deconvolution runs in order to deter-
mine the optimal number of threads of your system that should be used by Huygens.

Workflow
The performance tune wizard consists of several stages:

• Welcome screen
• Setup and tune
• Results

Welcome screen A brief overview of the Performance Tune Wizard is given. Note that the results of the 
Performance Tune Wizard will be send to SVI, unless you disable this on this screen. We 
use this information to better understand how our software runs on different kinds of 
machines, which helps us to determine where we might need to optimize the software 
even more. Moreover, it will help us to provide better information to our customers on 
the optimal system requirements for Huygens.
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Setup and tune In this stage, the configuration for the tuning can be given (See Figure 27.1).

Deconvolution types
Depending on your license it is possible to run a widefield and or confocal deconvolu-
tion. The results of the two types of deconvolution runs with regard to the optimal num-
ber of threads are equal most of the times, so it is safe to select both the types even if you 
typically run only one the types. In order to speedup the performance tune wizard you 
could deselect the widefield deconvolution since it is significantly slower then the confo-
cal deconvolution.

Number of deconvolution iterations
The deconvolution runs are executed several times in order to increase the accuracy of 
the result. This is not the same as the iteration count for the deconvolution itself.

Optimize for usage
If the deconvolution is run several times this option determines how the results of those 
different runs are used. When used with the 'best' option the fastest run is used, and 
when used with the 'typical' option the average of the runs is used. Use 'best' when you 
would normally not use the system during a normal deconvolution run, and use 'typical' 
when the system remains in use when performing a deconvolution run. The result of 
using 'best' makes it more likely that a larger number of threads is used, which increases 
the chance of performance interference if other software is running simultaneously.

FIGURE 27.1. Configuration window 
for adjusting the tuning settings.
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Performance Results
Performance Results

In the results stage a graph of the processing time versus thread count is shown (See 
Figure 27.2). This specific graph indicates that the processing time decreases signifi-
cantly when more cores are used.  You can also see that the processing time decreases 
until 18 threads are used. After that the processing time slightly increases and remains 
roughly the same. In this example, the system is hyper-threaded and has 20 physical 
cores. We can see that the hyper-threads actually decrease the performance and that, if 
we only use 18 of the 20 physical cores the interference with other software is reduced. 
Hence, the wizard suggests that we should use 18 threads. You can override this setting if 
you think that the wizard made a measurement error, and if you prefer to configure -for 
example - 20 cores.

The wizard also estimates the expected performance increase (measured in throughput), 
when compared with the currently configured amount of threads. In this case the system 
was already configured for 20 threads and we only see a performance increase of 13%. 
But when compared with the default setting of 40 threads, we can see a significant per-
formance increase of more then 50%.

Furthermore, the wizard determines if your license is able to use all the cores in the sys-
tem and will detect if you can increase the performance by using a larger server option in 
the license. You can contact sales@svi.nl for more information. 

Lastly, the results of the wizard need to be saved or discarded with the SAVE or EXIT but-
ton, respectively. It is also possible to restart the Performance Tune Wizard if you suspect 
that other software interfered too much during the tuning phase.

FIGURE 27.2. Graph in which the 
processing time is displayed against 
the thread count of a hyper-
threaded system with twenty 
physical cores.
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Image Size
CHAPTER 28 Establishing Image Parameters

The deconvolution algorithm needs to know some of the parameters describing the 
image acquisition. These are not too many, but careful determination may significantly 
enhance the deconvolution results.

Image Size The amount of computing time involved in deconvolving images is more than propor-
tional to the image size. It is therefore sensible to limit the data size as much as possible. 
Regarding widefield images we recommend to not record planes below and above the 
object which only contain blur. Huygens Professional does not need these planes to 
restore the object. Since the blur in these planes might be affected by hard to correct 
bleaching they might even reduce the quality of the deconvolution result. In any case, 
never crop the objects of interest. As a rule of thumb, leave about one extra μm above and 
below the objects.

Brick-Wise Processing
Deconvolving images requires much computer memory than the image size, because all 
computations are done in 32 bit floating point format, and because several extra (hid-
den) images are needed to store intermediate results. To reduce the memory require-
ments Huygens Professional will split the images into bricks, deconvolve the bricks 
sequentially, and fit the bricks together in a seamless fashion. Brick-wise processing is an 
automatic feature of Huygens Professional. To find out the best number of bricks, let the 
software run in automatic mode for splitting. It will consider many options and go for 
the most optimal one.

More information can be found on the SVI Wiki1.

Signal to Noise Ratio The Signal to Noise Ratio (referred to as SNR or S/N) is in the Huygens Software used as 
a regularization parameter, i.e. as a parameter that controls the sharpness of the resto-
ration result. The higher this value, the sharper the restored image will be. Therefore it 

1.http://www.svi.nl/BrickSplitting
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should not be considered as a parameter describing the original image, but more as a 
tunable parameter that controls the deconvolved result.

Using a too large SNR value might be risky when restoring noisy originals, because the 
noise could just being enhanced. A noise-free widefield image usually has SNR values 
higher than 50. A noisy confocal image can have values lower than 20.

A good starting SNR value can be estimated simply by visual inspection from the quality 
of the image. Figure 28.1 shows some examples of recordings where different noise levels 

were added to an original (restored) image. 

Estimating the SNR in noisy images is fairly easy. It is based on the idea of establishing 
the voxel intensity value s corresponding to a single photon hit by looking for such an 
event in a dark areas of the image. Knowing the intensity value M of the brightest voxel 
in the image, one can now calculate how many photons are involved in it. The SNR is 
now defined as:

(EQ 1)

If a significant blacklevel is present, it should be subtracted from M and s. See “Black 
Level” on page 183 and the SVI Wiki2 for more details.

In low noise images this is much more difficult, as single photon events are no longer 
easily observed. Fortunately, in such cases the establishment of the precise SNR is not 
very important for the restoration method, and a rough estimation based on the appear-
ance of the image is usually enough (See Figure 28.1).

2.http://www.svi.nl/SNR

Original SNR=30

SNR=15 SNR=5

FIGURE 28.1. Examples of different SNR values. Same 
image, different noise levels.

SNR M
s----=
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Black Level
Black Level The blacklevel (also called base line or electronic shift) is the output of the photo-multi-
plier if no light is coming through.

A positive black level (See Figure 28.2) will do no harm to the deconvolution since it is 
automatically accounted for in the background estimation stage. A large black level 
value, however, will reduce the effective dynamic range of the microscope. Besides that, a 
large black level will prevent the bleaching decay analyzer to do its job correctly, and the 
bleaching correction may turn out to be poor or even impossible. To prevent this Huy-
gens Professional has a tool to adjust the base line of an image, and the Batch Processor 
templates show the option to remove the black level as a preprocessing step.

It is also possible that the black level is negative. In the image histogram this will show as 
a spike on the left. This causes clipping (See “Clipping” on page 190.) in the lower inten-
sity limit, and it is impossible to correct: clipped images should be reacquired.

More information can be found on the SVI support Wiki3.

Sampling Density The sampling density is the number of recorded samples per unit area volume (3D) or 
area (2D). It is a microscopic parameter that describes the conditions of the image acqui-
sition, established by the way the microscope is configured (usually by the zoom factor). 
The ideal sampling density depends on the system optics and is determined by the 
Nyquist rate. It is recommended to sample as close to the Nyquist rate as possible. Note 
that the actual sampling distances from the acquisition must be used in the deconvolu-
tion.

The SVI Wiki has an on-line tool4 that computes the Nyquist rate for any widefield, con-
focal, spinning disc, and 4-Pi microscope.

Sampling according to the Nyquist rate makes sure that all information generated by the 
optics of the microscope is captured in digital form. It can be shown that if the sampling 
distance is smaller than the so-called critical sampling distance, no new information 
about the object is captured. Apart from practical problems like bleaching, acquisition 
time and data size there is no objection at all against using a smaller sampling distance 
than the critical distance, on the contrary.

3.http://www.svi.nl/BlackLevel

0 72. 7 145 218

0

1. 94e+05

3. 89e+05

5. 83e+05

0 72. 7 145 218

2. 36e+05

4. 73e+05

7. 09e+05

0

FIGURE 28.2. Left: The histogram of an image without black level. Right: The 
histogram of a similar image with a significant black level.

4.http://www.svi.nl/NyquistCalculator
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Figure 28.3 shows the dependency of this critical sampling distance on the numerical 

aperture for a wavelength of 500 nm. To apply this plot of to another wavelength, simply 
scale the vertical axis by that wavelength. For example, if a widefield microscope with 
NA 1.3 is used, there can be noticed from the plot that the critical lateral Nyquist sam-
pling distance at 500 nm emission is 95 nm. For an emission wavelength of 570 nm, this 
becomes .

In the confocal case it is the excitation wavelength which determines the Nyquist sample 
distance. In theory the pinhole plays no role, but larger pinholes strongly attenuate fine 
structures at the resolution limit. Therefore, as a rule of thumb, with a common pinhole 
diameter of 1 Airy disk the lateral critical sampling distance may be increased by 50 % 
with negligible loss of information. In cases were the pinhole is much larger, the lateral 
imaging properties much resemble those of a widefield system and the sampling distance 
can be set accordingly. We do not recommend to increase the axial sampling distance 
appreciably beyond the critical distance.

In a multi photon excitation microscope, it is the excitation wavelength divided by the 
photon count which determines the sampling.

More information can be found on the SVI Wiki5.

Computing the 
Backprojected 
Pinhole Radius and 
Distance

Throughout Huygens Professional pinhole sizes of confocal systems are specified as the 
backprojected radius in nm. Backprojected means the size of the pinhole as it appears in 
the specimen plane, i.e. the physical pinhole radius  divided by the total magnification 
of the detection system. This total magnification is the product of the (variable) objective 
magnification  multiplied by a fixed internal magnification :

5.http://www.svi.nl/NyquistRate
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FIGURE 28.3. Critical sampling distance vs. NA. The curves 
above show the critical sampling distance in axial and lateral 
directions for wide-field and confocal microscopes. The 
emission wavelength in both cases is 500 nm.
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Computing the Backprojected Pinhole Radius and Distance
 (EQ 2)

The SVI Wiki has a calculator6 to automatically compute the backprojected pinhole 
radius for specific microscope models. Note that the Bio-Rad MRC500, 600, and 
1024 microscopes have a very high magnification in the detection system (See “Check-
ing the Bio-Rad System Magnification” on page 186.).

The equations that can be found in the next pages are intended to orientate the user in 
finding out the backprojected value for different types of microscopes, but the idea is 
always the same: given a diameter d of the real pinhole, we might need to multiply it by a 
factor for unit conversion (to obtain the radius in nm), and divide the result by some 
other factor that takes account of the magnification of the microscope. These include 
both the objective and the intrinsic system magnification. In some microscopes with 
pinholes that are not circular, a geometrical correction will also be needed.

The Airy Disk as Unit for The Backprojected Pinhole

Some confocal microscopes report their pinhole size with the diameter of the Airy disk7 
as unit. shows how to compute the backprojected pinhole radius:

(EQ 3)

with NA the numerical aperture of the lens,  the number of Airy disks, and  the 
excitation wavelength. In principle using  is not correct because the Airy diffraction 
pattern is formed by the emitted light. However, we suspect microscope manufacturers 
prefer to use the excitation wavelength because it is better defined and does not depend 
on settings of devices like adjustable band filters.

Note that this relation bypasses the need to know internal system and lens magnifica-
tions.

Square Pinholes and the Shape Factor
The shape correction from a square to a circular pin-
hole is based on equalizing the area for both pinholes. 
Because the area  (See Figure 28.4), the 
shape factor c for a square pinhole becomes 

. For circular pinholes  to just 
convert the diameter to a radius.

If the size of a square pinhole is given in Airy disk 
units, then the backprojected radius is a combination 
of Equation 3 and the shape factor c for a square pinhole. Taking into account that 
Equation 3 already converts a diameter into a radius, the relation becomes:

(EQ 4)

6.http://www.svi.nl/BackprojectedPinholeCalculator

7.http://www.svi.nl/AiryDisk
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Converting from an Integer Parameter
Unfortunately, quite a few microscopes do not report the physical pinhole size or the 
Airy disk size. Instead, often an integer size parameter  in the range  (8 bit) is 
specified. If  maps to a physical size in linear fashion, then Equation 5 can be used to 
translate that parameter into a backprojected pinhole radius.

(EQ 5)

Here, c is the shape factor and  and  are the minimal and maximal pinhole size 

in μm. The factor  converts from μm to nm.

The backprojected Pinhole Spacing for Spinning Disks
As is the case for the backprojected pinhole diameter, the distances between the pinholes 
in spinning disks must be divided by the system magnification. For the frequently used 
Yokogawa disks8, for example, the physical spacing is about 253 μm. This can be checked 
by imaging a stopped disk. Using a 100× lens for example, the backprojected distance is 
about 2.53 μm. If an extra zoom lens is placed between the disk and the sample, its mag-
nification must be also considered.

A Supplied Calibration Curve 
If a calibration curve was supplied with the microscope best use that curve to convert the 
displayed setting to a physical size and from there convert to the backprojected radius.

An Example: the Olympus FV1000
As reported by Olympus engineers, the FV1000 confocal microscope has a square pin-
hole and an internal magnification of 3.82×. The pinhole size reported in the Olympus 
software is the side length of this square pinhole. Therefore, , and 

. Using a 100× objective lens and a reported pinhole size d of 150 μm the 
backprojected pinhole radius  in nm is:

 (EQ 6)

The on-line calculator9 knows the system magnifications and pinhole shapes for most 
popular microscopes.

Checking the Bio-Rad System Magnification

The Bio-Rad MRC 500, 600, and 1024 microscopes have a very high magnification in 
the detection system. The fixed system magnification is, according to Pawley10, 

8.http://www.svi.nl/YokogawaDisk

9.http://www.svi.nl/BackprojectedPinholeCalculator

10. Pawley, J. B., Handbook of Biological Confocal Microscopy, 2nd edition, 1995. Plenum Press, New 
York and London. ISBN 0-306-448262. Page 30.
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Computing the Backprojected Pinhole Radius and Distance
, with  between 1.0 and 1.56 (factor 1.25 for the fluorescence attachment 
multiplied by factor 1.25 for the DIC attachment). The factor of 53 includes the 
8× eyepiece just below the scan head, but does not include that variability in magnifica-
tion due to the variations in tube-length that are result from the aligning the system.

The high system magnification allows the viewing of the diffraction pattern (Airy disk) 
at the pinhole plane directly by eye. To enable the correctness verification of the values 
for the system magnification used in the on-line calculator, the way the system magnifi-
cation was derived is now explained.

In a Bio-Rad MRC600 with a NA 1.3 60× objective, the Airy disk has a diameter of 
around 2 to 2.5 mm at the pinhole plane. The diameter of the first Airy zero ring is 
7.6 lateral optical units11 (o.u.), using Equation 7 to express a distance r in dimensionless 
o.u.:

(EQ 7)

In the system described here, an o.u. is 0.3 ± 0.033 mm. At the specimen plane (backpro-
jected) a lateral o.u. is in this case around 61 nm. The total magnification is in that case 
4918×, the system magnification ×. This value corresponds well with 
the largest possible system magnification for the MRC600 ( ).

11.http://www.svi.nl/OpticalUnits
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Data Acquisition Pitfalls
CHAPTER 29 Improving Image Quality

In this chapter discusses basic suggestions on how to acquire better microscope images. 
These are based on common problems that we find frequently in data provided by users. 
The recommendations go on the direction of obtaining the highest quality images from 
the microscope, from the point of view of acquiring as much information as clean as 
possible. This alone is worth the effort, but it will also be very valuable for the deconvo-
lution afterwards.

Some basic guidelines to improve the deconvolution results are also listed. More infor-
mation can be found in the SVI Wiki1.

Data Acquisition 
Pitfalls

Refractive Index Mismatch
A mismatch between the refractive index of the lens immersion medium and specimen 
embedding medium can cause several serious problems:

• Geometrical distortion: Frequently referred to as the fish tank effect2. The axial sam-
pling distance that is recorded in the image file is the step size by which the objective 
lens moves along the z-axis. The focal point inside the sample, however, shifts due to 
the fish tank effect by a different step size. Therefore objects will appear elongated or 
shortened in the image data.
Huygens Professional will automatically adapt the PSF to this situation, but it will not 
modify the image geometry. After deconvolution the geometric distortion can be cor-
rected by multiplying the z-sampling distance by the medium refractive index 
divided by the immersion refractive index.

• Spherical aberration: this phenomenon causes the oblique rays to be focused in a 
different location than the central rays3. The distance in this focal shift is dependent 
on the depth of the focus in the specimen. If the mismatch is large, e.g. when going 
from oil immersion into a watery medium, the PSF will become asymmetric at depths 

1.http://www.svi.nl/

2.http://www.svi.nl/FishtankEffect

3.http://www.svi.nl/SphericalAbberation
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of already a few microns. This is especially harmful for the deconvolution of wide-
field images.
A workaround for this problem is to keep the z-range of the data (the number of 
slices) as small as possible. The solution is to use a water immersion lens instead.

• Total internal reflection: When the numerical aperture of the objective lens is larger 
than the medium refractive index, total internal reflection4 will occur. This is causing 
excitation light at high angles to be bounced back into the lens and therefore limiting 
the effective NA.
If spherical aberration is unavoidable, the image can still be improved during resto-
ration using an adaptive point spread function (See “Refractive Index Mismatch” on 
page 189.).

Clipping
The intensity of the light emitted by the microscopic sample is converted to electrical 
signals that pass an adjustable amplifier. These electrical signals must be converted to 
numbers processed by the computer. This conversion is done by the CCD camera. Most 
scientific CCD cameras have a 12 bit converter limiting the output numbers to the range 

. Negative input signals are usually converted to 0 while positive input values 
exceeding the dynamic range5 are all converted to 4095. This phenomenon is called clip-
ping: information in the clipped samples is lost.

In practice: be suspicious if the data contains intensity values at the extremes of the 
numerical range. These ranges are  for 8 bit data,  for 12 bit data, and 

 for 16 bit data.

Read more on the SVI Wiki6.

Undersampling
One of the rules of measurement that is often overlooked is sampling according to the 
Nyquist rate (See “Sampling Density” on page 183). Especially the sampling distance 
along the optical axis is frequently too large; too few xy slices are imaged. This leaves as 
result a 3D stack in which there is hardly any relation between the adjacent slices.

It is important to know how the sampling conditions should be established in order to 
recover an image from the sampled values. How the objects should be sampled depends 
on the microscope type (widefield, confocal, etc.) and on the microscopic parameters 
used, like the numerical aperture and wavelength.

The SVI Wiki has an on-line tool7 that computes the ideal (Nyquist) sampling distances 
for any widefield, confocal, spinning disc, and 4-Pi microscope.

Do Not Undersample to Limit Photodamage
Sometimes undersampling is done to limit photodamage to live cells. However, if pho-
todamage plays a role it is actually better to limit the number of photons per sample than 

4.http://www.svi.nl/TotalInternalReflection

5.http://www.svi.nl/DynamicRange

6.http://www.svi.nl/ClippedImages

7.http://www.svi.nl/NyquistCalculator
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Data Acquisition Pitfalls
to limit the number of samples. Having less photons per sample means that the overall 
photon dose can remain largely constant; as a result bleaching does not need to get 
worse. Although this results in an apparently noisier image, there is actually more infor-
mation in the data because sampling density is higher. Deconvolution with Huygens Pro-
fessional removes the noise and may enhance the image quality dramatically. Of course 
there are limits, but a fair trade-off can be often found.

Concluding, it is better to record 10 separate noisy slices 100 nm apart than two slices 
1000 nm apart and averaged 5 times in order to reduce noise.

Bleaching
Bleaching is a practically unavoidable phenomenon in fluorescence microscopy. Because 
the image planes are acquired sequentially, bleaching will vary along the z direction. 
Assuming it is not strong it will not affect deconvolution results on confocal or two pho-
ton images. But in widefield deconvolution bleaching is more of a problem. Fortunately, 
the bleaching in widefield images can usually be corrected quite easily. Huygens Profes-
sional will do so automatically. However, if the bleaching is strong the correction might 
not be perfect, resulting in lower quality deconvolution results.

Illumination Instability
Some widefield systems are equipped with unstable arc lamps which can cause amongst 
others jitter. These are irregular deviations from the average intensity in time. Huygens 
Professional will correct this instability, but when the instability is severe it cannot do so 
sufficiently.

Mechanical Instability
Mechanical instability can take many shapes, for example:

• Vibrations sometimes seen in confocal images. They may seriously hamper deconvo-
lution.

• The z-stage moves irregular or with sudden jumps. This deforms the data along the 
z-axis and is fatal for widefield and confocal deconvolution.

• The specimen moves. If in widefield data the object can clearly be seen moving when 
slicing along over a few μm in z. This will cause problems for the deconvolution. Best 
cause of action, apart from speeding up acquisition, is limiting the z-range of the data 
as much as possible. Confocal data of moving specimen causes less problems.

Thermal Effects
Thermal effects are known to affect calibration of the z-stage, especially if piezo actua-
tors without feedback control are used. In particular harmful for widefield data. In time 
series the effect can be seen as a drift of the z-position, or even a periodic movement 
induced by e.g. an air-conditioning system switching on and off. The z-drift corrector is 
able to correct this in most situations though. 

Internal Reflection
At high NA the angle of incidence of the most oblique rays can be close to 70 degrees. 
When a ray has to cross the cover-glass to medium interface at such an angle total reflec-
tion may occur. To be precise, total reflection occurs when the NA of the lens is higher 
than the refractive index of the embedding medium. This will reduce the effective NA of 
the lens.
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Deconvolution 
Improvements

Acquire an Experimental PSF

A point spread function or PSF is the image of a single point object8. The degree of 
spreading (blurring) in the image of this point object is a measure for the quality of an 
optical system. The imaging in a fluorescent microscope is completely described by its 
PSF. Although in many cases a theoretically calculated PSF very well matches the real 
one, ideal theoretical calculations can not predict actual misalignments or other prob-
lems inside the optical path. Therefore it is always recommendable to measure an exper-
imental PSF and, if it is very different from the ideal one, use it for deconvolution instead 
of the theoretical one.

The experimental PSF can be measured by acquiring the image of a small bead. When 
the size of the bead is known, then the PSF Distiller can distill the real shape of the PSF 
from the recording (See Chapter 6 “The PSF Distiller” on page 43).

Spherical Aberration Correction
When there is a refractive index mismatch, then the Huygens software automatically 
correct for spherical aberration9 by adapting the theoretical PSF to the sample depth.

In case the image suffers from severe spherical aberration, it might be better to use a the-
oretical PSF with this depth-dependent correction than an experimental one.

Improve the Deconvolution Parameters
Some deconvolution parameters, for example the SNR and the background level, can be 
fine-tuned to get the best out of the restoration process. See the SVI Wiki10 for detailed 
steps in configuring the restoration process.

8.http://www.svi.nl/PointSpreadFunction

9.http://www.svi.nl/SphericalAberration

10.http://www.svi.nl/DeconvolutionProcedure
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The Point Spread Function
CHAPTER 30 Appendix

The Point Spread 
Function

One of the basic concepts in image deconvolution is the point spread function (PSF). The 
PSF of the microscope is the image which results from imaging a point object in the 
microscope. Because of wave diffraction1 a point object is imaged (spread out) into a 
fuzzy spot: the point spread function. In fluorescence imaging the PSF completely deter-
mines the image formation. In other words: all microscopic imaging properties are packed 
into this 3D function. In Huygens Professional, a PSF can be obtained in two different 
ways:

1. Generating a theoretical PSF: When a measured PSF is not available, Huygens Profes-
sional automatically uses a theoretical PSF. The PSF is computed from the micro-
scopic parameters attached to the data. Because a theoretical PSF can be generated 
without any user intervention Huygens Professional does the calculation in the back-
ground without any notice.
Images affected by spherical aberration (See “Refractive Index Mismatch” on 
page 189) are better restored using a theoretical depth-dependent PSF.

2. Measuring a PSF: By using the PSF Distiller a measured PSF can be derived from 
images of small fluorescent beads (See “The PSF Distiller” on page 43.). Measured 
PSF's improve deconvolution results and may also serve as a quality test for the 
microscope

Quality Factor Deconvolution as it is done in Huygens Professional is based on the idea of finding the 
best estimate of the object that is imaged by the microscope. To assess the quality of an 
estimate, Huygens Professional simulates the microscopic imaging of each estimate (the 
estimated is convolved with the PSF) and compares the simulation with the measured 
image. From the difference a quality factor is computed. The difference is also used to 
compute a correction factor to modify the estimate in such a way that the corrected esti-
mate will yield a better quality factor. The quality factor as reported by the software is a 
measure relative to the first estimate and therefore a number greater than or equal to 1. If 
the increase in quality drops below the quality threshold the iterations are stopped.

1.http://www.svi.nl/ImageFormation
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File Series There are many ways in which Tiff files or other file series are named. These files can 
have multiple counters (referring to slices, time frames, or channels), and these counters 
can have arbitrary prefixes and ordering.

Numbered Tiff Series
If a series is simply numbered like: slice001.tif, slice002.tif, ..., 
slice0nn.tif, then Huygens Professional will read the series into a single 3D  
image. Because Tiff files usually carry no additional microscopic information, check the 
parameters carefully.

Leica Numbering
Huygens Professional natively supports both reading and writing Tiff series with Leica 
style numbering, if there is more than one channel, slice, or time frame. A single channel 
2D time series would be numbered according to the scheme:

im_tNN.tif

Here, NN is replaced by the time index for each frame. A more complex, multi-channel 
3D time series has this pattern:

im_tNN_zNNN_cNN.tif

In this series, the second channel of the fourth slice of the third time frame has the file-
name:

im_t02_z003_c01.tif

The File Series Tool
Although Huygens Professional uses Leica 
style numbering for writing files, the soft-
ware attempts to detect any type of file 
series for reading. Whenever a file is 
opened that appears to be part of a file 
series, Huygens Professional shows the File 
Series Tool dialog (Figure 30.1). This tool 
enables the user to select a subset of a file 
series, and select a dimension for each the 
indices in the file name, so that each image 
is assigned to the correct z-plane, time 
frame, and channel. Only select the first file 
of a series. If you select more, Huygens will 
attempt to see every selected file as a start of 
a new series. Consequently, many windows 
of the File Series Tool will be opened.

The file pattern is shown in the first row in the dialog. The counters in the file name are 
replaced by menu buttons for selecting the appropriate dimension for each counter. The 
options are:

• Slice: The range of this counter becomes the z-dimension.
• Time Frame: The range of this counter becomes the time dimension.
• Channel: The range of this counter becomes the channel dimension.
• Ignore: the variable is ignored. This is useful to omit e.g. the value of time stamps.

FIGURE 30.1. The Huygens File Series 
Tool automatically scans a directory 
for a file series.
194 Huygens Professional User Guide for version 15.05



Adjusting the Global Color Scheme
• The value of the counter in the selected file: the value of this counter has to match 
the value in the selected file.

Note that the selection has to be unique, i.e. it is impossible to have ignored variables 
without having a Slice, Time Frame, or Channel counter.

In the second, third, and fourth row, the range for each of the counters can be defined. A 
range from 0 to 9 with step size 2 will load the files 0, 2, 4, 6, and 8. Note that the time (in 
seconds) and z-sampling intervals (in nm) are not adapted to the step sizes.

Press the LOAD SELECTION button to load all files in the series into a single image. Before 
the dialog is closed, the tool will check if all files in the selection are really present in the 
directory.

Adjusting the Global 
Color Scheme

Huygens Professional uses a global scheme for coloring the different channels in multi-
channel images. These colors can be adjusted through the Preferences window via  (See 
Figure 30.2).

There are two color scheme available which are the RGB and CBF schemes. The RGB 
scheme (Red Green Blue scheme) is the color scheme that starts with the red, green and 
blue colors for the first 3 channels. The CBF scheme (Color Blind Friendly scheme) are 
contrasting colors that are unambiguous both to colorblinds and non-colorblinds.2

2. Published by Okabe and Ito, “How to make figures and presentations that are friendly to Color-
blind people”, J*FLY, 2002

FIGURE 30.2. The global color scheme can be modified through the 
Preferences window.
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Hue Selector The hue selector is a component that allows adjustment of the color range in which 
objects are displayed (See “The Surface Renderer” on page 85 and “The Colocalization 
Analyzer” on page 167). Objects belonging to different channels can be represented in 
different hue ranges to make them clearly distinct. The gradual differences inside the 
selected range make independent objects distinguishable. Also a range can be collapsed 
to have all objects in a channel displayed with exactly the same color. In Huygens the hue 
selector does appear in two flavors.

Hue Range
This selector allows the adjustment of a hue range. The objects on 
which this selector acts will get a color that lies within this range. The 

assignment of colors is based on the position of an object or on another parameter.

Hue Range and Saturation
This selector allows the adjustment of a single hue value and a satura-
tion. The upper triangle defines the color, while the lower triangle sets 

the saturation for this color; left is white, right is fully saturated.

Image Statistics Right-click on a thumbnail image and select SHOW PARAMETERS from the pop-up menu. 
This window shows, besides the parameter settings, statistical information of the partic-
ular image. Amongst them are the mean, sum, standard deviation, norm, and position of 
the center of mass.

Setting the Coverslip 
Position

If there is a mismatch between the refractive index for which the microscope's objective 
is designed and the actual refractive index of the embedding medium, the shape of the 
point spread function (PSF) will be distorted due to spherical aberration (See “Refractive 
Index Mismatch” on page 189). As deeper layers in the specimen are imaged, moving 
away from the coverslip, this distortion will progressively worsen. To compute the level 
of spherical aberration at a specific depth within the specimen, it is necessary to know 
the distance from the coverslip. Because in many cases the coverslip position does not 
coincide with the first plane in the data, this position can be set in the microscopic 
parameter editor. To our knowledge none of the existing microscopic image files record 
the coverslip position in the meta data. Next to direct numerical input, the coverslip 
position and imaging direction can be set using a visual editor that can be started using 
the LAUNCH EDITOR button located in the parameter editor window (Figure 30.3).

Inverted Microscope
In addition to the coverslip position, the visual editor shows the imaging direction rela-
tive to the data as read from the microscopic file. In an inverted microscope, with the 
objective physically below the specimen it is likely that the first xy-plane in the data, cor-
responding with the lowest location in the xz maximum intensity projection (MIP) on 
the screen, corresponds with the xy-plane scanned closest to the objective. However, 
since scan directions and data planes might have been reordered, this match is not guar-
anteed. Fortunately, it is often easy to spot the flat side of the object where it adheres to 
the glass, so the orientation can be verified.
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Upright Microscope
In an upright microscope, and a z-scan starting away from the coverslip, the first plane is 
also likely to be physically the lowest plane. In that case, the imaging direction should be 
set to downwards and the coverslip position in the top part of the xz MIP projection. 
However, if the scan started close to the coverslip while storing these first planes first in 
the data set, the MIP projection will show the data upside down. Consequently, the cov-
erslip position will be in the lower part of the MIP, and the imaging direction is upward. 

Slide Position
When the specimen is mounted on the coverslip, the distance from the object to the slide 
is probably in the range from 50 to100 μm, outside of the image. In this case, or in the 
case there is no slide, select Far away in the top-right selector.

When the specimen is close to or 
mounted on the slide, select Close to 
object (upper right corner). Drag the 
coverslip to its proper location. When 
this location is at some distance from 
the data it might be necessary to zoom 
out. The image can be dragged by hold-
ing down the right mouse button. In 
terms of imaging quality, when there is 
a refractive index mismatch between 
embedding medium and immersion 
medium, this is not an ideal situation 
since the light from and to the objective 
must travel hundreds of wavelengths 
through the embedding medium, pos-
sibly resulting in strong spherical aber-
ration induced bloating of the PSF.

Excitation Beam 
Overfill Factor

In confocal microscopes, the entry pupil of the microscope objective is illuminated by a 
laser beam. Usually, laser beams have a Gaussian intensity profile3. As a result, the illu-
mination intensity is not constant over the pupil but will decrease towards the edges. 

FIGURE 30.3. The coverslip 
position editor showing an xy 
MIP of the data along they y-
direction. The coverslip 
position can be adjusted by 
dragging the blue line. The 
imaging direction, here 
upwards, is indicated by the 
position of the objective 
relative to the data as shown. 
The z-position shown top-left 
in the image indicates the 
distance in μm of the 
coverslip to the first data 
plane.

FIGURE 30.4. The Coverslip editor with 
the slide position set to Close to object.
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Lower edge intensities will lower the effective NA and therefore negatively affect resolu-
tion. In most confocal microscopes this is remedied by using a beam width which is sig-
nificantly larger than the entry pupil, at the cost of loss of excitation power. The ratio 
between the beam width and the pupil diameter is the excitation beam overfill factor 
(See Figure 30.5) and is typically in the range from 2 to 4.

The overfill factor can be set as a microscopic parameter in Huygens Professional, and is 
taken into account when computing the point spread function.

Brightfield Images Brightfield imaging is not a linear imaging process. In a linear imaging process the image 
formation can be described as the linear convolution of the object distribution and the 
point spread function, hence the name deconvolution for the reverse process. So in prin-
ciple one cannot apply deconvolution based on linear imaging to non linear imaging 
modes like brightfield and reflection. One could state that the image formation in these 
cases is linear because it is governed by linear superposition of amplitudes. However, 
microscopes do not measure light amplitudes but rather intensities, i.e. the absolute 
squared values of the amplitudes. Taking the absolute square destroys all phase informa-
tion one would need to effectively apply deconvolution. Fortunately, in the brightfield 
case the detected light is to a significant degree incoherent. Because in that case there are 
few phase relations the image formation is largely governed by the addition of intensities, 
especially if one is dealing with a high contrast image.

In practice one goes about deconvolving brightfield images by inverting them (using ) 
and processing them further as incoherent fluorescence widefield images. The Tikhonov 
Miller algorithm was proven to work excellently for brightfield data. This algorithm is 
available in the Huygens Professional only. With the MLE algorithm one should watch 
out sharply for interference like patterns (periodic rings and fringes around objects) in 

3. http://en.wikipedia.org/wiki/Gaussian_beam
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FIGURE 30.5. Lens entry pupil (red), beam profile with overfill 
factor 1 (blue), 2 (green), and 4(dark red). At overfill factor 1, 
the beam intensity is 14 % of the maximum, at overfill 
factor 2 the edge intensity is 61 % of the maximum.
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the measured image. As a rule these become pronounced in low contrast images. After 
the deconvolution run a reverse to the original contrast setting is possible.

2D Histogram In image processing a 2D histogram shows the relationship of intensities between two 
images. The 2D histogram is mostly used to compare 2 channels, where the x-axis repre-
sent the intensities of the first channel and the y-axis the intensities of the second chan-
nel.

As a comparison, a 1D histogram is nothing more than counting how many voxels with a 
particular intensity occur in the image. The intensity range of the image is divided in 
bins. A voxel then belongs to the bin if its intensity is included within the range the bin 
represents.

The 2D histogram is the same as the 1D histogram with the difference that it counts the 
occurence of combinations of intensities. To compute a 2D histogram the images need to 
be equal in size. See the example in Figure 30.6; at position (30,20) the first channel has 
an intensity of 200 and the second image has an intensity of 10. Then this will add one to 
the count in the 2D histogram at position (200,10).

The difficulty with a 2D histogram is how to show the actual count per intensity combi-
nation. For a 1D histogram the height of the bars represent the count, but this height for 
a 2D histogram requires a third dimension which is difficult to visualize. Instead, to 
visualize the count of the combinations, colors are used. In the histogram in Figure 30.6 
colors range from green to red. Note that these colors have nothing to do with the colors 
used to represent the channels. Within the 2D histogram, green represents low counts 
while red represent high counts.

2D histograms show interesting image properties and are therefore very useful:

• Offset
• Intensity factor
• Colocalization
• Clipping
• Crosstalk
• Hot pixels

FIGURE 30.6. Example how a 2D histogram is computed, showing the first and second 
channel and their corresponding 2D histogram. At each position within the channels, 
the corresponding intensities of both channels are combined to form a coordinate 
within the 2D histogram. The count at this coordinate of the 2D histogram is then 
increased by one.
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More information and examples are in the SVI wiki4.

4. http://www.svi.nl/TwoChannelHistogram.
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CHAPTER 31 Support and Contact Information

Contact Information Addresses and Phone Numbers

We are directly reachable by phone during office hours (CET) or by e-mail 24/7.

Distributors

An up-to-date list of distributors can be found on our web site1.

Support SVI Support Wiki

The SVI Wiki2 is a rapidly expanding public knowledge resource on 3D microscopy and 
deconvolution. Based on the WikiWikiWeb principle, it is open to contributions from 
every visitor. In addition it serves as a support medium for SVI customers and relations 
to discuss different aspects of the Huygens software.

This is a list of useful starting points in the SVI Wiki to learn more about the Huygens 
software and microscopical imaging in general:

• Information on the parameters describing the imaging conditions (sampling, numer-
ical aperture, pinholes, etc.):
http://www.svi.nl/MicroscopicParameters

Mailing Address Scientific Volume Imaging B.V.
Laapersveld 63
1213 VB Hilversum
The Netherlands

Phone +31 35 6421626
Fax +31 35 6837971
E-mail info@svi.nl

URL http://www.svi.nl/

1.http://www.svi.nl/distributors/

2.http://www.svi.nl/FrontPage
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• Information on the restoration parameters (signal to noise ratio, background, quality 
criteria, etc.) used by the deconvolution algorithms:
http://www.svi.nl/RestorationParameters

• A step by step example on how to tune these parameters to achieve the desired resto-
ration results:
http://www.svi.nl/DeconvolutionProcedure

• Important issues regarding image acquisition and restoration (sampling, clipping, 
etc.):
http://www.svi.nl/ImportantFactors

• Typical acquisition pitfalls (spherical aberration, undersampling, bleaching, etc.):
http://www.svi.nl/AcquisitionPitfalls

• Information on recording beads to measure a PSF:
http://www.svi.nl/RecordingBeads

• Tutorials and detailed information on using the different aspects of the Huygens soft-
ware (restoration, visualization, analysis, programming, etc.):
http://www.svi.nl/Tutorials

• Uploading images to SVI:
http://www.svi.nl/SendImagesToSvi

License String 
Details

Detailed information about the installed license strings can be displayed via 
HELP→LICENSE. Select the license string of interest and click EXPLAIN LICENSE.

A Huygens license string consists of a set of substrings separated by dashes (-). These 
substrings describe e.g. the product, version number, options, etc. The checksum at the 
end of the string should match with all other substrings. A complete string looks like 
this:

HuPro-15.05-wcnp-d-tvAC-emnps-eom2015Dec31-
e7b7c623393d708e-{user@domain.com}-4fce0dbe86e8ca4344dd

Table 31.1 lists the building blocks from which this string is composed.

TABLE 31.1. The building blocks of the Huygens license string.

Substring Description
Product The product to which the license string applies. This can be 

HuEss, HuPro, HuScript, HuCore, and HuTitan.
Version The version number of the product.
Microscope types This substring consists of one or more characters representing the 

microscope types for which the deconvolution is enabled. These 
are ‘w’ (widefield), ‘c’ (confocal), ‘n’ (Spinning disk), ‘p’ (multi-
photon), ‘s’ (STED),  ‘S’ (STED 3X) and ‘4’ (4-Pi experimental 
microscopes).

Server flag Determines the number of cores that are enabled for multi-thread-
ing. A hyper-threaded core is counted as a single core. It can be 
‘d’ (desktop; 2 cores), ‘s’ (small server; 4 cores), ‘m’ (medium 
server; 8 cores), ‘l  (larger server; 16 cores), and ‘x’ (extreme 
server; 512 cores).

Option flags This is a set of characters that list the enabled optional modules. 
An overview of these modules is given in Table 31.2.
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License String Details
Locking policy A set of characters that indicate to which properties the license is 
locked. These can be ‘d’ (expiry date), ‘e’ (e-mail address), ‘m’ (sys-
tem ID), ‘n’ (number of cores), ‘p’ (processor type), and ‘s’ (pro-
cessor details).

Expiry date The date on which the license or maintenance ends. When this 
substring starts with ‘eom’, then only the maintenance expires; the 
license remains valid.

System ID A 16 character hexadecimal string containing hardware identifica-
tion numbers.

E-mail address The customer e-mail address.
Checksum A 20 character hexadecimal checksum on the previous substrings.

TABLE 31.2. Identifiers for the optional modules.

Character Module
A Advanced Object Analyzer
b Small file reader bundle
B Complete file reader bundle
C Colocalization Analyzer
f PSF Distiller
G Stitcher
L Leica LAS AF - Huygens data exchange
M Movie Maker
N Enable new, pre-released features
p byte limit for image indexer (Titan)
s Object Stabilizer
t Time Series
v Surface Renderer visualization
x Chromatic Aberration Corrector
c RBNCC option for colocalization
T Object Tracker
u Crosstalk  Corrector

TABLE 31.1. The building blocks of the Huygens license string.

Substring Description
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	2. The AVI quality scale bar determines the compression level of the AVI file. Set to 100 %, the quality is the best, but then the file size will be large.
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	FIGURE 19.2. Comparing the results of hot pixel correction using the line plot feature within the Twin Slice. The dashed lines show the corrected values in this two channel example image.
	FIGURE 19.3. The 2D histogram of the original (left) image shows hotpixels as a diagonal scatter that are successfully removed in the corrected image (right).
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	FIGURE 20.2. The Chromatic Aberration Corrector after estimating the shifts. A plot shows the gap between channel 2 and reference channel 0. The estimated shift is drawn as a vector in the orthogonal slicer scenes.
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	FIGURE 20.3. Using the Edit Channel tool of the Chromatic Aberration Corrector. The estimated vector has been manually lengthened, and as a result the dashed line plot is slightly moved to the left.
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	Stabilization Settings
	FIGURE 21.6. Effect of filters in the Stabilization settings screen. The top shows the measured displacement, the curve in the middle is noise filtered, and the bottom is drift filtered.

	Cropping the Result
	FIGURE 21.7. The stabilization result can be cropped manually to cut out the objects of interest. The original image borders are shown as grey rectangles.


	Alignment of Slices in 3D Stacks
	FIGURE 21.8. An x-z slice of a misaligned z-stack (left), and the alignment result (right). The chromatic shift in stack like this one can be correcting using the Chromatic Shift Corrector.
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	Introduction
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	FIGURE 22.3. Detected objects.
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	Tracking Parameters
	Quick Edit Tracks
	FIGURE 22.5. The quick edit tracks stage allows to connect, break, and delete tracks.


	The Track Analyzer
	The Filter Tab
	FIGURE 22.6. The filter tab in the Track Analyzer.

	The Position Tab
	FIGURE 22.7. In case of a large number of objects that show Brownian motion, the shape of the histogram in the position tab will be a half- normal distribution.
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	FIGURE 22.8. The slope of the mean squared displacement plot indicates a diffusion coefficient of 9.32 µm²/s.


	The Speed Tab
	FIGURE 22.9. Left: An xy velocity scatter plot showing a drift in the positive y direction. Right: An xy velocity scatter plot of objects moving with a constant speed of about 0.35 µm/s in random directions.
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	The Flow Tab
	FIGURE 22.10. The flow histogram shows that objects are crossing the boundary between time frame 4 and 24.
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	1. Segmentation: Separating interesting voxels from the background according to a given criterion;
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	FIGURE 23.1. Maximum intensity projection of the test image. Cell nucleus FISH-stained, recorded at the Nuclear organization Group, SILS, University of Amsterdam (head: Prof. Roel van Driel), under the 3D- Genome research project.
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	FIGURE 23.11. Histogram representation of one column values.
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	FIGURE 28.3. Critical sampling distance vs. NA. The curves above show the critical sampling distance in axial and lateral directions for wide-field and confocal microscopes. The emission wavelength in both cases is 500 nm.
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